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About This Book
WARNING! Text set off in this manner indicates that failure to follow directions could result in bodily
harm or loss of life.

CAUTION: Text set off in this manner indicates that failure to follow directions could result in damage
to equipment or loss of information.

NOTE: Text set off in this manner provides important supplemental information.
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1 Product Features

Microtower Chassis
Standard Configuration Features

The HP Compaq Microtower features may vary depending on the model. For a complete listing of the
hardware and software installed in the computer, run the diagnostic utility (included on some computer
models only). Instructions for using the utility are provided in the Troubleshooting Guide.

Figure 1-1  Microtower Configuration
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Front Panel Components
Drive configuration may vary by model.

Table 1-1  Front Panel Components

1 5.25-inch Optical Drives1 6 Optical Drive Eject Buttons

2 Optical Drive Activity Lights 7 3.5-inch Media Card Reader (optional)2

3 Hard Drive Activity Light 8 Dual-State Power Button

4 Microphone/Headphone Connector 9 Power On Light

5 USB (Universal Serial Bus) 2.0 Ports 10 Headphone Connector

NOTE: When a device is plugged into the Microphone/Headphone Connector, a dialog box will pop up asking if you
want to use the connector for a microphone line Line-In device or a headphone. You can reconfigure the connector at
any time by double-clicking the Realtek HD Audio Manager icon in the Windows taskbar.

NOTE: The Power On Light is normally green when the power is on. If it is flashing red, there is a problem with the
computer and it is displaying a diagnostic code. Refer to the Troubleshooting Guide to interpret the code.

1 Some models have bezel blanks covering one or both of the 5.25-inch drive bays.
2 Some models have a bezel blank covering the 3.5-inch drive bay.
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Media Card Reader Components
The media card reader is an optional device available on some models only. Refer to the following
illustration and table to identify the media card reader components.

Figure 1-2  Media Card Reader Components

Table 1-2  Media Card Reader Components

No. Slot Media   

1 xD ● xD-Picture Card (xD)   

2 MicroSD ● MicroSD (T-Flash) ● MicroSDHC  

3 Media Card Reader
Activity Light

   

4 SD/MMC+/miniSD ● Secure Digital (SD)

● Secure Digital High
Capacity (SDHC)

● MiniSD

● MiniSDHC

● MultiMediaCard
(MMC)

● Reduced Size
MultiMediaCard (RS
MMC)

● MultiMediaCard 4.0
(MMC Plus)

● Reduced Size
MultiMediaCard 4.0
(MMC Mobile)

● MMC Micro (adapter
required)

5 USB ● USB (Universal Serial
Bus) Port

  

6 CompactFlash I/II ● CompactFlash Card
Type 1

● CompactFlash Card
Type 2

● MicroDrive

7 MS PRO/MS PRO DUO ● Memory Stick (MS)

● MagicGate Memory
Stick (MG)

● MagicGate Memory
Duo

● Memory Stick Select

● Memory Stick Duo
(MS Duo)

● Memory Stick PRO
(MS PRO)

● Memory Stick PRO
Duo (MS PRO Duo)

● Memory Stick PRO-
HG Duo

● Memory Stick Micro
(M2) (adapter
required)

8 1394 ● 1394 Port (available
on select models only)
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Rear Panel Components

Table 1-3  Rear Panel Components

1  Power Cord Connector 6 Line-Out Connector for powered audio
devices (green)

2 Line-In Audio Connector (blue) 7 PS/2 Keyboard Connector (purple)

3 PS/2 Mouse Connector (green) 8 VGA Monitor Connector

4 Serial Connector 9 DisplayPort Monitor Connector

5 RJ-45 Network Connector 10 Universal Serial Bus (USB)

NOTE: Arrangement and number of connectors may vary by model.

An optional second serial port and an optional parallel port are available from HP.

When a device is plugged into the blue Line-In Audio Connector, a dialog box will pop up asking if you want to use
the connector for a line-in device or a microphone. You can reconfigure the connector at any time by double-clicking
the Realtek HD Audio Manager icon in the Windows taskbar.

The monitor connectors on the system board are inactive when a graphics card is installed in the computer.

If a graphics card is installed into the PCI or PCI Express x1 slot, the connectors on the graphics card and the system
board may be used at the same time. Some settings may need to be changed in Computer Setup to use both
connectors. For information about setting the boot VGA controller, refer to the Computer Setup (F10) Utility Guide.
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Serial Number Location
Each computer has a unique serial number and product ID number that are located on the top cover of
the computer. Keep these numbers available for use when contacting customer service for assistance.

Figure 1-3  Serial Number and Product ID Location
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Small Form Factor
Standard Configuration Features

The HP Compaq Small Form Factor features may vary depending on the model. For a complete listing
of the hardware and software installed in the computer, run the diagnostic utility (included on some
computer models only). Instructions for using the utility are provided in the Troubleshooting Guide.

NOTE: The Small Form Factor computer can also be used in a tower orientation. For more information,
see Using the Small Form Factor Computer in a Tower Orientationon page 174 in this guide.

Figure 1-4  Small Form Factor Configuration
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Front Panel Components
Drive configuration may vary by model.

Figure 1-5  Front Panel Components

Table 1-4  Front Panel Components

1 5.25-inch Optical Drive1 6 USB (Universal Serial Bus) Ports

2 Optical Drive Activity Light 7 Microphone/Headphone Connector

3 Optical Drive Eject Button 8 3.5-inch Media Card Reader (optional)2

4 Dual-State Power Button 9 Hard Drive Activity Light

5 Power On Light 10 Headphone Connector

NOTE: When a device is plugged into the Microphone/Headphone Connector, a dialog box will pop up asking if you
want to use the connector for a microphone line Line-In device or a headphone. You can reconfigure the connector
at any time by double-clicking the Realtek HD Audio Manager icon in the Windows taskbar.

NOTE: The Power On Light is normally green when the power is on. If it is flashing red, there is a problem with the
computer and it is displaying a diagnostic code. Refer to the Troubleshooting Guide to interpret the code.

1 Some models are configured with a 5.25-inch bezel blank covering this bay.
2 Some models are configured with a 3.5-inch bezel blank covering this bay.
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Media Card Reader Components
The media card reader is an optional device available on some models only. Refer to the following
illustration and table to identify the media card reader components.

Figure 1-6  Media Card Reader Components

Table 1-5  Media Card Reader Components

No. Slot Media   

1 xD ● xD-Picture Card (xD)   

2 MicroSD ● MicroSD (T-Flash) ● MicroSDHC  

3 Media Card Reader
Activity Light

   

4 SD/MMC+/miniSD ● Secure Digital (SD)

● Secure Digital High
Capacity (SDHC)

● MiniSD

● MiniSDHC

● MultiMediaCard
(MMC)

● Reduced Size
MultiMediaCard (RS
MMC)

● MultiMediaCard 4.0
(MMC Plus)

● Reduced Size
MultiMediaCard 4.0
(MMC Mobile)

● MMC Micro (adapter
required)

5 USB ● USB (Universal Serial
Bus) Port

  

6 CompactFlash I/II ● CompactFlash Card
Type 1

● CompactFlash Card
Type 2

● MicroDrive

7 MS PRO/MS PRO DUO ● Memory Stick (MS)

● MagicGate Memory
Stick (MG)

● MagicGate Memory
Duo

● Memory Stick Select

● Memory Stick Duo
(MS Duo)

● Memory Stick PRO
(MS PRO)

● Memory Stick PRO
Duo (MS PRO Duo)

● Memory Stick PRO-
HG Duo

● Memory Stick Micro
(M2) (adapter
required)

8 1394 ● 1394 Port (available
on select models only)
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Rear Panel Components
Figure 1-7  Rear Panel Components

Table 1-6  Rear Panel Components

1 RJ-45 Network Connector 6 DisplayPort Monitor Connector

2 Serial Connector 7 VGA Monitor Connector

3 PS/2 Mouse Connector (green) 8 PS/2 Keyboard Connector (purple)

4 Power Cord Connector 9 Line-Out Connector for powered audio
devices (green)

5 Universal Serial Bus (USB) 10 Line-In Audio Connector (blue)

NOTE: Arrangement and number of connectors may vary by model.

An optional second serial port and an optional parallel port are available from HP.

When a device is plugged into the blue Line-In Audio Connector, a dialog box will pop up asking if you want to use
the connector for a line-in device or a microphone. You can reconfigure the connector at any time by double-clicking
the Realtek HD Audio Manager icon in the Windows taskbar.

The monitor connectors on the system board are inactive when a graphics card is installed in the computer.

If a graphics card is installed into the PCI or PCI Express x1 slot, the connectors on the graphics card and the system
board may be used at the same time. Some settings may need to be changed in Computer Setup to use both
connectors. For information about setting the boot VGA controller, refer to the Computer Setup (F10) Utility Guide.
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Serial Number Location
Each computer has a unique serial number and product ID number in the location shown below. Keep
these numbers available for use when contacting customer service for assistance.

Figure 1-8  Serial Number and Product ID Location
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2 Installing and Customizing the Software

If your computer was not shipped with a Microsoft operating system, some portions of this documentation
do not apply. Additional information is available in online help after you install the operating system.

NOTE: If the computer was shipped with Windows Vista or Windows 7 loaded, you will be prompted
to register the computer with HP Total Care before installing the operating system. You will see a brief
movie followed by an online registration form. Fill out the form, click the Begin button, and follow the
instructions on the screen.

CAUTION: Do not add optional hardware or third-party devices to the computer until the operating
system is successfully installed. Doing so may cause errors and prevent the operating system from
installing properly.

NOTE: Be sure there is a 10.2-cm (4-inch) clearance at the back of the unit and above the monitor to
permit the required airflow.

Installing the Operating System
The first time you turn on the computer, the operating system is installed automatically. This process
takes about 5 to 10 minutes, depending on which operating system is being installed. Carefully read
and follow the instructions on the screen to complete the installation.

CAUTION: Once the automatic installation has begun, DO NOT TURN OFF THE COMPUTER UNTIL
THE PROCESS IS COMPLETE. Turning off the computer during the installation process may damage
the software that runs the computer or prevent its proper installation.

NOTE: If the computer shipped with more than one operating system language on the hard drive, the
installation process could take up to 60 minutes.

If your computer was not shipped with a Microsoft operating system, some portions of this documentation
do not apply. Additional information is available in online help after you install the operating system.

Installing the Operating System 11



Downloading Microsoft Windows Updates
1. To set up your Internet connection, click Start > Internet Explorer and follow the instructions on

the screen.

2. Once an Internet connection has been established, click the Start button.

3. Select the All Programs menu.

4. Click on the Windows Update link.

In Windows Vista and Windows 7, the Windows Update screen appears. Click view available
updates and make sure all critical updates are selected. Click the Install button and follow the
instructions on the screen.

In Windows XP, you will be directed to the Microsoft Windows Update Web site. If you see one
or more pop-up windows that ask you to install a program from http://www.microsoft.com, click
Yes to install the program. Follow the instructions on the Microsoft Web site to scan for updates
and install critical updates and service packs.

It is recommended that you install all of the critical updates and service packs.

5. After the updates have been installed, Windows will prompt you to reboot the machine. Be sure to
save any files or documents that you may have open before rebooting. Then select Yes to reboot
the machine.

Installing or Upgrading Device Drivers (Windows systems)
When installing optional hardware devices after the operating system installation is complete, you must
also install the drivers for each of the devices.

If prompted for the i386 directory, replace the path specification with C:\i386, or use the Browse button
in the dialog box to locate the i386 folder. This action points the operating system to the appropriate
drivers.

Obtain the latest support software, including support software for the operating system from
http://www.hp.com/support. Select your country and language, select Download drivers and software
(and firmware), enter the model number of the computer, and press Enter.

Accessing Disk Image (ISO) Files
There are disk image files (ISO files) included on your PC that contain the installation software for
additional software. These CD image files are located in the folder C:\SWSetup\ISOs. Each .iso file can
be burned to CD media to create an installation CD. It is recommended that these disks be created and
the software installed in order to get the most from your PC. The software and image file names are:

● Corel WinDVD SD and BD – installation software for WinDVD – used to play DVD movies

● HP Insight Diagnostics OR Vision Diagnostics – software to perform diagnostic activities on your
PC
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Protecting the Software
To protect the software from loss or damage, keep a backup copy of all system software, applications,
and related files stored on the hard drive. Refer to the operating system or backup utility documentation
for instructions on making backup copies of your data files.

Protecting the Software 13



3 Computer Setup (F10) Utility

Computer Setup (F10) Utilities
Use Computer Setup (F10) Utility to do the following:

● Change factory default settings.

● Set the system date and time.

● Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

● Modify the boot order of bootable devices such as hard drives, optical drives, or USB flash media
devices.

● Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic tests run
during a Full Boot. You can set the system to:

❑ always Quick Boot (default);

❑ periodically Full Boot (from every 1 to 30 days); or

❑ always Full Boot.

● Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test
(POST) messages. Post Messages Disabled suppresses most POST messages, such as memory
count, product name, and other non-error text messages. If a POST error occurs, the error is
displayed regardless of the mode selected. To manually switch to Post Messages Enabled during
POST, press any key (except F1 through F12).

● Establish an Ownership Tag, the text of which is displayed each time the system is turned on or
restarted.

● Enter the Asset Tag or property identification number assigned by the company to this computer.

● Enable the power-on password prompt during system restarts (warm boots) as well as during
power-on.

● Establish a setup password that controls access to the Computer Setup (F10) Utility and the
settings described in this section.

● Secure integrated I/O functionality, including the serial, USB, or parallel ports, audio, or embedded
NIC, so that they cannot be used until they are unsecured.

● Enable or disable removable media boot ability.

● Solve system configuration errors detected but not automatically fixed during the Power-On Self-
Test (POST).
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● Replicate the system setup by saving system configuration information on USB flash media device
or other storage media emulating a diskette and restoring it on one or more computers.

● Execute self-tests on a specified ATA hard drive (when supported by drive).

● Enable or disable DriveLock security (when supported by drive).

Using Computer Setup (F10) Utilities
Computer Setup can be accessed only by turning the computer on or restarting the system. To access
the Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer.

2. As soon as the computer is turned on, press F10 when the monitor light turns green to enter
Computer Setup. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
press F10 when the monitor light turns green to access the utility.

3. Select your language from the list and press Enter.

4. A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security,
Power, and Advanced.

5. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and down)
keys to select the option you want, then press Enter. To return to the Computer Setup Utilities
menu, press Esc.

6. To apply and save changes, select File > Save Changes and Exit.

● If you have made changes that you do not want applied, select Ignore Changes and Exit.

● To reset to factory settings or previously saved default settings (some models), select Apply
Defaults and Exit. This option will restore the original factory system defaults.

CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup (F10)
changes because the CMOS could become corrupted. It is safe to turn off the computer only after exiting
the F10 Setup screen.

Table 3-1  Computer Setup (F10) Utility

Heading Table

File Table 3-2 Computer Setup—File on page 16

Storage Table 3-3 Computer Setup—Storage on page 17

Security Table 3-4 Computer Setup—Security on page 19

Power Table 3-5 Computer Setup—Power on page 23

Advanced Table 3-6 Computer Setup—Advanced (for advanced users)
on page 24
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Computer Setup—File
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-2  Computer Setup—File

Option Description

System Information Lists:

● Product name

● SKU number (some models)

● Processor type/speed/stepping

● Cache size (L1/L2)

● Installed memory size/speed, number of channels (single or dual) (if applicable)

● Integrated MAC address for embedded, enabled NIC (if applicable)

● System BIOS (includes family name and version)

● Chassis serial number

● Asset tracking number

● ME firmware version

● Management mode

About Displays copyright notice.

Set Time and Date Allows you to set system time and date.

Flash System ROM Allows you to update the system ROM with a BIOS image file located on a USB flash media device
or CD-ROM.

Replicated Setup Save to Removable Media

Saves system configuration, including CMOS, to a USB flash media device or a diskette-like device
(a storage device set to emulate a diskette drive).

Restore from Removable Media

Restores system configuration from a USB flash media device or a diskette-like device.

Default Setup Save Current Settings as Default

Saves the current system configuration settings as the default.

Restore Factory Settings as Default

Restores the factory system configuration settings as the default.

Apply Defaults and
Exit

Applies the currently selected default settings and clears any established passwords.

Ignore Changes
and Exit

Exits Computer Setup without applying or saving any changes.

Save Changes and Exit Saves changes to system configuration or default settings and exits Computer Setup.
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Computer Setup—Storage
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-3  Computer Setup—Storage

Option Description

Device Configuration Lists all installed BIOS-controlled storage devices.

When a device is selected, detailed information and options are displayed. The following options
may be presented:

Drive Emulation

Allows you to select a drive emulation type for a certain storage device. (For example, a Zip drive
can be made bootable by selecting diskette emulation.)

Emulation Type

ATAPI Zip drive:

● None (treated as Other).

● Diskette (treated as diskette drive).

CD-ROM: No emulation options available.

ATAPI LS-120:

● None (treated as Other).

● Diskette (treated as diskette drive).

Hard Disk:

● None (prevents BIOS data accesses and disables it as a boot device).

● Hard Disk (treated as hard disk).

Translation Mode (ATA disks only)

Lets you select the translation mode to be used for the device. This enables the BIOS to access
disks partitioned and formatted on other systems and may be necessary for users of older versions
of UNIX (e.g., SCO UNIX version 3.2). Options are Automatic, Bit-Shift, LBA Assisted, User, and
Off.

CAUTION: Ordinarily, the translation mode selected automatically by the BIOS should not be
changed. If the selected translation mode is not compatible with the translation mode that was active
when the disk was partitioned and formatted, the data on the disk will be inaccessible.

Translation Parameters (ATA disks only)

NOTE: This feature appears only when User translation mode is selected.

Allows you to specify the parameters (logical cylinders, heads, and sectors per track) used by the
BIOS to translate disk I/O requests (from the operating system or an application) into terms the hard
drive can accept. Logical cylinders may not exceed 1024. The number of heads may not exceed
256. The number of sectors per track may not exceed 63. These fields are only visible and
changeable when the drive translation mode is set to User.

SATA Default Values

Allows you to specify the default values for the Translation Mode for ATA devices.
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Option Description

Storage Options Removable Media Boot

Enables/disables ability to boot the system from removable media.

eSATA Port

Allows you to enable eSATA support. This causes one of the SATA connectors to become eSATA
capable.

Max eSATA Speed

Allows you to choose 1.5 Gbps or 3.0 Gbps as the maximum eSATA speed. By default, the speed
is limited to 1.5 Gbps for maximum reliability.

CAUTION: Consult your eSATA drive and cable manufacturer before enabling 3.0 Gbps speed.
Some drive and cable combinations may not run reliably at 3.0 Gbps.

SATA Emulation

Allows you to choose how the SATA controller and devices are accessed by the operating system.
There are two supported options: IDE and AHCI.

IDE - This is the most backwards-compatible setting of these options. Operating systems usually do
not require additional driver support in IDE mode.

AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take advantage
of more advanced features of the SATA controller.

NOTE: The AHCI device driver must be installed prior to attempting to boot from an AHCI volume.
If you attempt to boot from an AHCI volume without the required device driver installed, the system
will crash (blue screen).

For more information on AHCI, go to http://www.hp.com/support. Select your country and language,
select See support and troubleshooting information, enter the model number of the computer,
and press Enter. In the Resources category, click Manuals (guides, supplements, addendums,
etc). Under Quick jump to manuals by category, click White papers.

DPS Self-Test Allows you to execute self-tests on ATA hard drives capable of performing the Drive Protection
System (DPS) self-tests.

NOTE: This selection will only appear when at least one drive capable of performing the DPS self-
tests is attached to the system.

Boot Order Allows you to:

● Specify the order in which attached devices (such as a USB flash media device, hard drive,
optical drive, or network interface card) are checked for a bootable operating system image.
Each device on the list may be individually excluded from or included for consideration as a
bootable operating system source.

● Specify the order of attached hard drives. The first hard drive in the order will have priority in
the boot sequence and will be recognized as drive C (if any devices are attached).

NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating system
has started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the
computer and press F9 when the monitor light turns green. After POST is completed, a list of bootable
devices is displayed. Use the arrow keys to select the preferred bootable device and press Enter.
The computer then boots from the selected non-default device for this one time.

Table 3-3  Computer Setup—Storage (continued)
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Computer Setup—Security
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-4  Computer Setup—Security

Option Description

Setup Password Allows you to set and enable a setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the
ROM, and make changes to certain plug and play settings under Windows.

See the Desktop Management Guide for more information.

Power-On Password Allows you to set and enable a power-on password. The power-on password prompt appears after
a power cycle. If the user does not enter the correct power-on password, the unit will not boot.

NOTE: This password does not appear on warm boots , such as Ctrl+Alt+Delete or Restart from
Windows, unless enabled in Password Options (see below).

See the Desktop Management Guide for more information.

Password Options

(This selection appears
only if a power-on
password or setup
password is set.)

Allows you to:

● Lock legacy resources (appears if a setup password is set)

● Enable/disable network server mode (appears if a power-on password is set)

● Specify whether the password is required for warm boot (Ctrl+Alt+Delete) (appears if a power-
on password is set)

● Enable/Disable Setup Browse Mode (appears if a setup password is set) (allows viewing, but
not changing, the F10 Setup Options without entering setup password)

● Enable/disable Stringent Password (appears if a power-on password is set), which when
enabled bypasses the onboard password jumper to disable the power-on password.

See the Desktop Management Guide for more information.

Device Security Allows you to set Device Available/Device Hidden for:

● Serial ports

● Parallel port

● System audio

● Network controllers (some models)

● Embedded security device (some models)

● SATA0

● SATA1

● SATA2

● SATA3
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Option Description

USB Security Allows you to set Device Available/Device Hidden for:

● Front USB Ports

◦ USB Port 1

◦ USB Port 2

◦ USB Port 3

◦ USB Port 4

◦ USB Port 5

◦ USB Port 6

● Rear USB Ports

◦ USB Port 7

◦ USB Port 8

◦ USB Port 9

◦ USB Port 10

◦ USB Port 11

◦ USB Port 12

Slot Security Allows you to disable PCIe and PCI slots along with cards plugged into them.

Network Service Boot Enables/disables the computer’s ability to boot from an operating system installed on a network
server. (Feature available on NIC models only; the network controller must be either a PCI expansion
card or embedded on the system board.)

System IDs Allows you to set:

● Asset tag (18-byte identifier), a property identification number assigned by the company to the
computer.

● Ownership tag (80-byte identifier) displayed during POST.

● Chassis serial number or Universal Unique Identifier (UUID) number. The UUID can only be
updated if the current chassis serial number is invalid. (These ID numbers are normally set in
the factory and are used to uniquely identify the system.)

● Keyboard locale setting (for example, English or German) for System ID entry.

DriveLock Security Allows you to assign or modify a master or user password for hard drives. When this feature is
enabled, the user is prompted to provide one of the DriveLock passwords during POST. If neither
is successfully entered, the hard drive will remain inaccessible until one of the passwords is
successfully provided during a subsequent cold-boot sequence.

NOTE: This selection will only appear when at least one drive that supports the DriveLock feature
is attached to the system. You may need to power-cycle the system and re-enter F10 Setup in order
to manage DriveLock passwords.

See the Desktop Management Guide for more information.

Table 3-4  Computer Setup—Security (continued)
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Option Description

System Security (some
models: these options
are hardware
dependent)

Data Execution Prevention (some models) (enable/disable) - Helps prevent operating system
security breaches.

PAVP (Some models) (disabled/min) - PAVP enables the Protected Audio Video Path in the Chipset.
This may allow viewing of some protected high definition content that would otherwise be prohibited
from playback.

Virtualization Technology (some models) (enable/disable) - Controls the virtualization features of the
processor. Changing this setting requires turning the computer off and then back on.

Virtualization Technology Directed I/O (some models) (enable/disable) - Controls virtualization DMA
remapping features of the chipset. Changing this setting requires turning the computer off and then
back on.

Trusted Execution Technology (some models) (enable/disable) - Controls the underlying processor
and chipset features needed to support a virtual appliance. Changing this setting requires turning
the computer off and then back on. To enable this feature you must enable the following features:

● Embedded Security Device Support

● Virtualization Technology

● Virtualization Technology Directed I/O

Embedded Security Device Support (some models) (enable/disable) - Permits activation and
deactivation of the Embedded Security Device. Changing this setting requires turning the computer
off and then back on.

NOTE: To configure the Embedded Security Device, a Setup password must be set.

● Reset to Factory Settings (some models) (Do not reset/Reset) - Resetting to factory defaults
will erase all security keys. Changing this setting requires turning the computer off and then
back on.

CAUTION: The embedded security device is a critical component of many security schemes.
Erasing the security keys will prevent access to data protected by the Embedded Security
Device. Choosing Reset to Factory Settings may result in significant data loss.

● Power-on authentication support (some models) (enable/disable) - Controls the power-on
password authentication scheme that utilizes the Embedded Security Device. Changing this
setting requires turning the computer off and then back on.

● Reset authentication credentials (some models) (Do not reset/Reset) - Selecting Reset disables
the power-on authentication support and clears the authentication information from the
Embedded Security Device. Changing this setting requires turning the computer off and then
back on.

OS management of Embedded Security Device (some models) (enable/disable) - This option allows
the user to limit operating system control of the Embedded Security Device. Changing this setting
requires turning the computer off and then back on. This option allows the user to limit OS control
of the Embedded Security Device.

● Reset of Embedded Security Device through OS (some models) (enable/disable) - This option
allows the user to limit the operating system ability to request a Reset to Factory Settings of
the Embedded Security Device. Changing this setting requires turning the computer off and
then back on.

NOTE: To enable this option, a Setup password must be set.

Table 3-4  Computer Setup—Security (continued)
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Option Description

Master Boot Record
Security

Allows you to disable/enable Master Boot Record Security.

● Save Master Boot Record – This option will appear if Master Boot Record Security is enabled.
It allows you to save a copy of the Master Boot Record into non-volatile storage.

● Restore Master Boot Record – This option will appear on the next boot once the Master Boot
Record has been saved. It allows you to restore the saved copy back to the hard drive’s Master
Boot Record.

Setup Security Level Provides a method to allow end-users limited access to change specified setup options, without
having to know the Setup Password.

This feature allows the administrator the flexibility to protect changes to essential setup options,
while allowing the user to view system settings and configure nonessential options. The administrator
specifies access rights to individual setup options on a case-by-case basis via the Setup Security
Level menu. By default, all setup options are assigned Setup Password, indicating the user must
enter the correct Setup Password during POST to make changes to any of the options. The
administrator may set individual items to None, indicating the user can make changes to the specified
options when setup has been accessed with invalid passwords. The choice, None, is replaced by
Power-On Password if a Power-On Password is enabled.

NOTE: Setup Browse Mode must be set to Enable in order for the user to enter Setup without
knowing the setup password.

Table 3-4  Computer Setup—Security (continued)
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Computer Setup—Power
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-5  Computer Setup—Power

Option Description

OS Power
Management

● Runtime Power Management— Enable/Disable. Allows certain operating systems to reduce
processor voltage and frequency when the current software load does not require the full
capabilities of the processor.

● Idle Power Savings—Extended/Normal. Allows certain operating systems to decrease the
processors power consumption when the processor is idle.

● ACPI S3 Hard Disk Reset—Enabling this causes the BIOS to ensure hard disks are ready to
accept commands after resuming from S3 before returning control to the operating system.

● ACPI S3 PS2 Mouse Wakeup—Enables or disables waking from S3 due to PS2 mouse activity.

● USB Wake on Device Insertion (some models)—Allows system to wake from Standby on USB
device insertion.

● Unique Sleep State Blink Rates—Enable/Disable. This feature is designed to provide a visual
indication of what sleep state the system is in. Each sleep state has a unique blink pattern.

◦ S0 = Solid green LED.

◦ S3 = 3 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds (green LED) —
repeated cycles of 3 blinks and a pause.

◦ S4 = 4 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds (green LED) —
repeated cycles of 4 blinks and a pause.

◦ S5 = LED is off.

NOTE: If this feature is disabled, S4 and S5 both have the LED off. S1 (no longer supported)
and S3 use 1 blink per second.

Hardware Power
Management

SATA power management enables or disables SATA bus and/or device power management.

Thermal Fan idle mode—This bar graph controls the minimum permitted fan speed.

NOTE: This setting only changes the minimum fan speed. The fans are still automatically
controlled.
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Computer Setup—Advanced
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-6  Computer Setup—Advanced (for advanced users)

Option Description

Power-On Options Allows you to set:

● POST mode (QuickBoot, Clear Memory, FullBoot, or FullBoot Every x Days).

◦ QuickBoot = Do not clear memory or perform a memory test.

◦ FullBoot = Memory test (count) on cold boot. Clears memory on all boots.
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Option Description

◦ Clear Memory = No memory count on cold boot. Clears memory on all boots.

◦ FullBoot Every x Days = Memory count on 1st cold boot on or after the xth day. No more
memory counts until 1st cold boot on or after x days. Clears memory on all boots.

● POST messages (enable/disable).

● F9 prompt (hidden/displayed). Enabling this feature will display the text F9 = Boot Menu during
POST. Disabling this feature prevents the text from being displayed. However, pressing F9 will
still access the Shortcut Boot [Order] Menu screen. See Storage > Boot Order for more
information.

● F10 prompt (hidden/displayed). Enabling this feature will display the text F10 = Setup during
POST. Disabling this feature prevents the text from being displayed. However, pressing F10
will still access the Setup screen.

● F11 prompt (hidden/displayed). Setting this feature to displayed will display the text F11 =
Recovery during POST. Hiding the feature prevents the text from being displayed. However,
pressing F11 will still attempt to boot to the recovery partition. See Factory Recovery Boot
Support for more information.

● F12 prompt (hidden/displayed). Enabling this feature will display the text F12 = Network during
POST. Disabling this feature prevents the text from being displayed. However, pressing F12
will still force the system to attempt booting from the network.

● Factory Recovery Boot Support (enable/disable). Enabling this feature will cause an additional
prompt, F11 = Recovery, to be displayed during POST on systems with a recovery partition
on the boot hard drive. Pressing F11 causes the system to boot to the recovery partition.
The F11 = Recovery prompt can be hidden with the F11 prompt (hidden/displayed) option (see
above).

● Option ROM prompt (enable/disable). Enabling this feature will cause the system to display a
message before loading option ROMs. (This feature is supported on some models only.)

● WOL After Power Loss (enable/disable). Enabling this option will cause the system to power-
up momentarily after a power loss in order to enable the Wake On LAN (WOL) feature.

● Remote wakeup boot source (remote server/local hard drive).

● After Power Loss (off/on/previous state): Setting this option to:

◦ Off—causes the computer to remain powered off when power is restored.

◦ On—causes the computer to power on automatically as soon as power is restored.

◦ Previous state—causes the computer to power on automatically as soon as power is
restored, if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be able
to use the suspend/sleep feature or the Remote Management features.

● POST Delay (None, 5, 10 15, or 20 seconds). Enabling this feature will add a user-specified
delay to the POST process. This delay is sometimes needed for hard disks on some PCI cards
that spin up very slowly, so slowly that they are not ready to boot by the time POST is finished.
The POST delay also gives you more time to select F10 to enter Computer (F10) Setup.

● Limit CPUID Maximum Value to 3. Restricts the number of CPUID functions reported by the
microprocessor. Enable this feature if booting to Windows NT.

● Bypass F1 Prompt. This feature allows the system to boot without pressing F1 at the prompt
when the configuration changes.

Execute Memory Test
(some models)

Restarts the computer and executes the POST memory test.

Table 3-6  Computer Setup—Advanced (for advanced users) (continued)
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Option Description

BIOS Power-On Allows you to set the computer to turn on automatically at a time you specify.

Onboard Devices Allows you to set resources for or disable onboard system devices (serial port or parallel port).

PCI Devices ● Lists currently installed PCI devices and their IRQ settings.

● Allows you to reconfigure IRQ settings for these devices or to disable them entirely. These
settings have no effect under an ACPI-based operating system.

PCI VGA Configuration Displayed only if there are multiple PCI video adapters in the system. Allows you to specify which
VGA controller will be the “boot” or primary VGA controller.

NOTE: In order to see this entry, you must enable Integrated Video (Advanced > Device
Options) and Save Changes and Exit.

Bus Options On some models, allows you to enable or disable:

● PCI SERR# Generation.

● PCI VGA palette snooping, which sets the VGA palette snooping bit in PCI configuration space;
only needed when more than one graphics controller is installed.

Device Options Allows you to set:

● Printer mode (Bi-Directional, EPP + ECP, Output Only).

● Num Lock state at power-on (off/on).

● S5 Wake on LAN (enable/disable).

◦ To disable Wake on LAN during the off state (S5), use the arrow (left and right) keys to
select the Advanced > Device Options menu and set the S5 Wake on LAN feature to
Disable. This obtains the lowest power consumption available on the computer during
S5. It does not affect the ability of the computer to Wake on LAN from suspend or
hibernation, but will prevent it from waking from S5 via the network. It does not affect
operation of the network connection while the computer is on.

◦ If a network connection is not required, completely disable the network controller (NIC) by
using the arrow (left and right) keys to select the Security > Device Security menu. Set
the Network Controller option to Device Hidden. This prevents the network controller

Table 3-6  Computer Setup—Advanced (for advanced users) (continued)
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Option Description

from being used by the operating system and reduces the power used by the computer
in S5.

● Processor cache (enable/disable).

● Integrated Video (enable/disable). Allows you to use integrated video and PCI or PCIEx1 Up
Solution video at the same time.

NOTE: After Integrated Video is enabled and changes saved, a new menu item appears
under Advanced to allow you to select the primary VGA controller video device.

Inserting a PCI Express x16 video card automatically disables Integrated Video. When a PCI
Express x16 video card is installed, Integrated Video cannot be enabled.

● Multi-Processor (enable/disable). This option may be used to disable multi-processor support
under the OS.

● Internal speaker (some models) (does not affect external speakers).

● NIC PXE Option ROM Download (enable/disable). The BIOS contains an embedded NIC option
ROM to allow the unit to boot through the network to a PXE server. This is typically used to
download a corporate image to a hard drive. The NIC option ROM takes up memory space
below 1MB commonly referred to as DOS Compatibility Hole (DCH) space. This space is
limited. This F10 option will allow users to disable the downloading of this embedded NIC option
ROM thus giving more DCH space for additional PCI cards which may need option ROM space.
The default will be to have the NIC option-ROM-enabled.

Management Devices The Management Devices menu will only be displayed in the Advanced menu when the BIOS detects
multiple management options.

This option is for installed NIC cards that support ASF or DASH. Use the Management Devices menu
to select if the BIOS management operations will be through the embedded solution or one of the
installed NIC cards.

Management
Operations

Allows you to set:

● MEBx Setup Prompt (enable/disable). Enabling this feature displays the CTRL+P prompt
during POST. Disabling this feature prevents the prompt from being displayed. However,
pressing Ctrl+P still accesses the utility used to configure manageability settings.

The CTRL+P function activates the MEBx Setup menu. If the Setup Password is configured,
the user will be prompted to correctly enter it before being allowed to enter the MEBx Setup. It
the password is entered incorrectly three times, the MEBx Setup will not be activated.

● SOL Character Echo (enable/disable). Some remote consoles print remotely-entered
characters which can cause the characters to appear twice (once when entered remotely and
once when echoed back from local client video). This option allows the administrator to have
the SOL terminal emulator suppress echoing remotely-entered characters to the local video
display.

● SOL Terminal Emulation Mode (enable/disable). Selects between VT100 and ANSI SOL
terminal emulation. SOL terminal emulation mode is only activated during remote AMT
redirection operations. The emulation options allow administrators to select which mode works
best with their console.

● SOL Keyboard (enable/disable). Disable or enable client keyboard during SOL sessions. Some
remote remediation may involve having the local client boot a remote image provided by an
administrator. This option determines if the BIOS will keep the local keyboard enabled or
disabled for possible local client interaction. If the local keyboard is disabled, all keyboard input
is only accepted from the remote source.

Table 3-6  Computer Setup—Advanced (for advanced users) (continued)
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Recovering the Configuration Settings
This method of recovery requires that you first perform the Save to Removable Media command with
the Computer Setup (F10) Utility before Restore is needed. (See Save to Removable Media
on page 16 in the Computer Setup—File table.)

NOTE: It is recommended that you save any modified computer configuration settings to a a USB
flash media device or a diskette-like device (a storage device set to emulate a diskette drive) and save
the device for possible future use.

To restore the configuration, insert a USB flash media device or other storage media emulating a diskette
with the saved configuration and perform the Restore from Removable Media command with the
Computer Setup (F10) Utility. (See Restore from Removable Media on page 16 in the Computer Setup
—File table.)

Drive Protection System (DPS)
The Drive Protection System (DPS) is a diagnostic tool built into the hard drives installed in some
computers. DPS is designed to help diagnose problems that might result in unwarranted hard drive
replacement.

When these systems are built, each installed hard drive is tested using DPS, and a permanent record
of key information is written onto the drive. Each time DPS is run, test results are written to the hard
drive. Your service provider can use this information to help diagnose conditions that caused you to run
the DPS software.

Running DPS will not affect any programs or data stored on the hard drive. The test resides in the hard
drive firmware and can be executed even if the computer will not boot to an operating system. The time
required to execute the test depends on the manufacturer and size of the hard drive; in most cases, the
test will take approximately two minutes per gigabyte.

Use DPS when you suspect a hard drive problem. If the computer reports a SMART Hard Drive Detect
Imminent Failure message, there is no need to run DPS; instead, back up the information on the hard
drive and contact a service provider for a replacement hard drive.

Accessing DPS Through Computer Setup
When the computer does not power on properly you should use Computer Setup to access the DPS
program. To access DPS, perform the following steps:

1. Turn on or restart the computer.

2. When the F10 Setup message appears in the lower-right corner of the screen, press the F10 key.

NOTE: If you do not press the F10 key while the message is displayed, you must turn the
computer off, then on again, to access the utility.

A choice of five headings appears in the Computer Setup Utilities menu: File, Storage,
Security, Power, and Advanced.

3. Select Storage > DPS Self-Test.

The screen will display the list of DPS-capable hard drives that are installed on the computer.
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NOTE: If no DPS-capable hard drives are installed, the DPS Self-Test option will not appear on
the screen.

4. Select the hard drive to be tested and follow the screen prompts to complete the testing process.

When the test has been completed, one of three messages will be displayed:

● Test Succeeded. Completion Code 0.

● Test Aborted. Completion Code 1 or 2.

● Test Failed. Drive Replacement Recommended. Completion Code 3 through 14.

If the test failed, the completion code should be recorded and reported to your service provider for help
in diagnosing the computer problem.
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4 Computer Diagnostic Features

Hewlett-Packard Vision Diagnostics
NOTE: HP Vision Diagnostics is included on CD with some computer models only.

The Hewlett-Packard Vision Field Diagnostics utility allows you to view information about the hardware
configuration of the computer and perform hardware diagnostic tests on the subsystems of the computer.
The utility simplifies the process of effectively identifying, diagnosing, and isolating hardware issues.

The Survey tab is displayed when you invoke HP Vision Diagnostics. This tab shows the current
configuration of the computer. From the Survey tab, there is access to several categories of information
about the computer. Other tabs provide additional information, including diagnostic test options and test
results. The information in each screen of the utility can be saved as an html file and stored on a diskette
or USB flash drive.

Use HP Vision Field Diagnostics to determine if all the devices installed on the computer are recognized
by the system and functioning properly. Running tests is optional but recommended after installing or
connecting a new device.

You should run tests, save the test results, and print them so that you have printed reports available
before placing a call to the Customer Support Center.

NOTE: Third party devices may not be detected by HP Vision Field Diagnostics.

Accessing HP Vision Diagnostics
To access HP Vision Field Diagnostics, you must burn the utility onto a CD or copy it onto a USB flash
drive then boot to the CD or USB flash drive. It can also be downloaded from http://www.hp.com and
either burned to CD or installed to a USB flash drive. See Downloading the Latest Version of HP Vision
Diagnostics on page 34 for more information.

NOTE: HP Vision Field Diagnostics is included with some computer models only.

If you have already downloaded HP Vision Diagnostics to either a CD or USB Flash drive, then begin
the following procedure at step 2.

1. In Windows Explorer, go to c:\SWSetup\ISOs and burn the file Vision Diagnostics.ISO to a CD
or copy it to a USB flash drive.

2. While the computer is on, insert the CD in the Optical Drive or USB flash drive in a USB port on
the computer.

3. Shut down the operating system and turn off the computer.

4. Turn on the computer. The system will boot into HP Vision Diagnostics.
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NOTE: If the system does not boot to the CD in the optical drive or to the USB flash drive, you
may need to change the boot order in the Computer Setup (F10) utility. Refer to the Computer
Setup (F10) Utility Guide for more information.

5. At the boot menu, select either the HP Vision Diagnostics utility to test the various hardware
components in the computer or the HP Memory Test utility to test memory only.

NOTE: The HP Memory Test is a comprehensive memory diagnostic utility that is run as a stand-
alone application, outside of HP Vision Diagnostics.

6. If running HP Vision Diagnostics, select the appropriate language and click Continue.

7. In the End User License Agreement page, select Agree if you agree with the terms. The HP Vision
Diagnostics utility launches with the Survey tab displayed.

Survey Tab
The Survey tab displays important system configuration information.

In the View level field, you can select the Summary view to see limited configuration data or select
the Advanced view to see all the data in the selected category. By default, the View Level is set to
Overview which displays general information about all of the component categories.

In the Category field, you can select the following categories of information to display:

All—Gives a listing of all categories of information about the computer.

Architecture—Provides system BIOS and PCI device information.

Asset Control—Shows product name, system serial number, asset tag and universal unique ID
information.

Audio—Displays information about the audio controllers present in the system, including PCI audio
cards.

Communication—Shows information about the computer parallel (LPT) and serial (COM) port settings,
plus USB and network controller information.

Graphics—Shows information about the graphics controller of the computer.

Input Devices—Shows information about the keyboard, mouse, and other input devices connected to
the computer.

Memory—Shows information about all memory in the computer. This includes memory slots on the
system board and any memory modules installed.

Processors—Shows information about the processor(s) installed in the computer, including clock
speeds and cache sizes.

Storage—Shows information about storage media connected to the computer. This list includes all hard
drives, diskette drives, and optical drives.

System—Shows information about the computer model, internal fans, chassis, and BIOS.

Test Tab
The Test tab allows you to choose various parts of the system to test. You can also choose the type of
test and testing mode.
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There are three types of tests to choose from:

● Quick Test—Provides a predetermined script where a sample of each hardware component is
exercised. You may further modify which of the Quick tests are executed by selecting or deselecting
individual tests in the hardware component check list.

● Complete Test—Provides a predetermined script where each hardware component is fully tested.
You may further modify which of the Complete tests are executed by selecting or deselecting
individual tests in the hardware component check list.

● Custom Test—Provides the most flexibility in controlling the testing of a system. The Custom Test
mode allows you to specifically select which devices, tests, and test parameters are run.

By default, the three test modes do not display prompts and require no interaction. If errors are found,
they are displayed when testing is complete.

However, for each test type, you may also optionally add interactive tests by clicking the Include
interactive tests box under Test mode. Selecting interactive tests provides the maximum control over
the testing process. The diagnostic software will prompt you for input during tests.

NOTE: Memory can not be tested from within the HP Vision Diagnostics application. To test the
memory in your computer, you must exit HP Vision Diagnostics, boot to either the CD or USB flash drive
and select HP Memory Test from the boot menu.

To begin testing:

1. Select the Test tab.

2. 2. Select the type of tests you want to run: Quick, Complete, or Custom.

3. Include optional interactive tests by selecting Include interactive tests.

4. Choose how you want the test to be executed, either Number of Loops or Total Test Time. When
choosing to run the test over a specified number of loops, enter the number of loops to perform. If
you want the diagnostic test for a specified time period, enter the amount of time in minutes.

5. Click the Start Test button to start the testing. The Status tab, which allows you to monitor the
progress of the tests, is automatically displayed during the testing process. When the tests are
complete, the Status tab shows whether the devices passed or failed.

6. If errors are found, go to the Errors tab to display detailed information and recommended actions.

Status Tab
The Status tab displays the status of the selected tests. The main progress bar displays the percent
complete of the current set of tests. While testing is in progress, a Cancel Testing button is displayed
for use if you want to cancel the test.

The Status tab also shows:

● The devices being tested

● The test status (running, waiting, passed, or failed) of each device being tested

● The overall test progress of all devices being tested

● The test progress for each device being tested

● The elapsed test times for each device being tested

32 Chapter 4   Computer Diagnostic Features



History Tab
The History tab contains information on past test executions.

The History Log displays all tests that have been executed, the number of times of execution, the number
of times failed, the date each test was executed, and the time it took to complete each test. The Clear
History button will clear the contents of the History Log.

The contents of the History Log may be saved as a HTML file to either floppy or USB flash drive by
clicking the Save button.

Errors Tab
The Errors tab displays detailed information about any errors found, as well as any recommended
actions.

The Error Log displays the tests for devices that have failed during the diagnostic testing and includes
the following columns of information.

● The Device section displays the device tested.

● The Test section displays the type of test run.

● The Times Failed is the number of times the device has failed a test.

● The Defect Code provides a numerical code for the failure. The error codes are defined in the Help
tab.

● The Description section describes the error that the diagnostic test found.

● The Reason section describes the likely cause of the error.

● The Recommended Repair will give a recommended action that should be performed to resolve
the failed hardware.

● The Warranty ID is a unique error code associated with the specific error on your computer. When
contacting the HP Support Center for assistance with a hardware failure, please be prepared to
provide the Warranty ID.

The Clear Errors button will clear the contents of the Error Log.

The contents of the Error Log may be saved as a HTML file to either floppy or USB flash drive by clicking
the Save button.

Help Tab
The Help tab contains a Vision Help section, and a Test Components section. This tab includes search
and index features. You may also review the HP End User License Agreement (EULA), as well as the
HP Vision Field Diagnostic application version information on this tab.

The Vision Help section contains information on the major functions of Hewlett-Packard Vision Field
Diagnostics.

The Test Components section provides a description of each test, as well as the parameters that may
be adjusted when running in Custom test mode.

The Defect codes section contains information on the numerical error code that may appear in the
Errors tab.
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The Memory test tab section provides information on the HP Memory Test application that may be
launched from the boot menu.

The HP Support section provides information on obtaining technical support from HP.

Saving and Printing Information in HP Vision Diagnostics
You can save the information displayed in the HP Vision Diagnostics Survey, History and Errors tabs
to a diskette or a USB flash drive. You can not save to the hard drive. The system will automatically
create an html file that has the same appearance as the information displayed on the screen.

1. Insert a diskette or USB flash drive if running HP Vision Diagnostics from CD.

2. Click Save in the bottom on any of the Survey, History or Errors tabs. All three log files will be
saved regardless of from which tab the Save button was clicked.

3. Select the drive onto which you will save the log files and click the Save button. Three html files
will be saved to the inserted diskette or USB flash drive.

NOTE: Do not remove the diskette or USB flash drive until you see a message indicating that the
html files have been written to the media.

4. Print the desired information from the storage device used to save it.

NOTE: To exit HP Vision Diagnostics, click the Exit Diagnostics button at the bottom of the screen.
Be sure to remove the USB flash drive or CD from the optical drive.

Downloading the Latest Version of HP Vision Diagnostics
1. Go to http://www.hp.com.

2. Click the Software & Drivers link.

3. Select Download drivers and software (and firmware).

4. Enter your product name in the text box and press the Enter key.

5. Select your specific computer model.

6. Select your OS.

7. Click the Diagnostic link.

8. Click the Hewlett-Packard Vision Field Diagnostics link.

9. Click the Download button.

NOTE: The download includes instructions on how to create the bootable CD or the bootable USB
flash drive.

Protecting the Software
To protect software from loss or damage, you should keep a backup copy of all system software,
applications, and related files stored on the hard drive. See the operating system or backup utility
documentation for instructions on making backup copies of data files.
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5 Desktop Management

HP Client Management Solutions provides standards-based solutions for managing and controlling
desktops, workstations, and notebook PCs in a networked environment. HP pioneered desktop
manageability in 1995 with the introduction of the industry’s first fully manageable desktop personal
computers. HP is a patent holder of manageability technology. Since then, HP has led an industry-wide
effort to develop the standards and infrastructure required to effectively deploy, configure, and manage
desktops, workstations, and notebook PCs. HP develops its own management software and works
closely with leading management software solution providers in the industry to ensure compatibility
between HP Client Management Solutions and these products. HP Client Management Solutions are
an important aspect of our broad commitment to providing you with solutions that assist you in lowering
the total cost of owning and maintaining the PCs throughout their lifecycle.

The key capabilities and features of desktop management are:

● Initial configuration and deployment

● Remote system installation

● Software updating and management

● ROM flash

● Hardware option configuration

● Asset tracking and security

● Fault notification and recovery

NOTE: Support for specific features described in this guide may vary by model or software version.

Initial Configuration and Deployment
The computer comes with a preinstalled system software image. After a brief software “unbundling”
process, the computer is ready to use.

You may prefer to replace the preinstalled software image with a customized set of system and
application software. There are several methods for deploying a customized software image. They
include:

● Installing additional software applications after unbundling the preinstalled software image.

● Using software deployment tools, such as HP Client Automation Standard Edition or HP Client
Automation Enterprise Edition (based on Radia technology) to replace the preinstalled software
with a customized software image.

● Using a disk cloning process to copy the contents from one hard drive to another.
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The best deployment method depends on your information technology environment and processes.

ROM-based setup and ACPI hardware provide further assistance with recovery of system software,
configuration management and troubleshooting, and power management.

HP Client Automation Agent
The management agent used by both HP Client Automation Standard and Enterprise Editions is pre-
loaded on the computer. When installed, it enables communication with the HP management console.

To install the HP Client Automation Agent:

1. Click Start.

2. Click All Programs.

3. Click HP Manageability.

4. Click the HP Management Agent Readme applicable to the language you desire.

5. Review and follow the instructions contained in the Readme file to install the HP Client Automation
Agent.

HP Client Automation Agent is a key infrastructure component for enabling all of the HP Client
Automation solutions. To learn about the other infrastructure components necessary for implementing
the HP configuration management solutions, please visit http://h20229.www2.hp.com/solutions/ascm/
index.html.

HP Client Manager
HP Client Manager (HPCM) is a free solution developed by Symantec for all supported HP business
desktop, notebook, workstation and HP Blade PCs. HPCM integrates HP specific tools such as System
Software Manager, HP Instant Support Professional Edition, and HP Client Management Interface to
enable a centralized model for the managing, tracking, and monitoring of all supported HP hardware.

HP Client Manager 7.0 features a brand new Portal Page which serves as a one-stop-shop where the
administrator can accomplish the following management tasks:

● Inventory

● Alerts

● BIOS Management

● Driver Updates

● Perform HP Instant Support Health Scan and Diagnostics

● Perform Embedded Security tasks

● View the overall HP Health Alert Trend over the last 3-6 months

● View the overall compliance of supported computers with HP Instant Support Health Scan and
Diagnostics

● View the Summary of HP Computers – a breakdown of the various supported desktops, notebooks,
workstations and HP Blade PCs

● View Alerts: Asset, Threshold, Hardware Health
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● Reports

● Administrative tasks to update HP specific tools

HPCM can be downloaded from http://www.symantec.com/business/theme.jsp?themeid=altiris by
clicking on HP Client Manager under Strategic Partner Products. A free permanent license can also
be obtained from the download page.

HPCM “How to” videos are also published on http://www.symantec.com/connect. Search for HP Client
Manager 7.0 to view step by step videos for various tasks within HPCM.

Remote System Installation
Remote System Installation allows you to start and set up the system using the software and
configuration information located on a network server by initiating the Preboot Execution Environment
(PXE). The Remote System Installation feature is usually used as a system setup and configuration tool
and can be used for the following tasks:

● Formatting a hard drive

● Deploying a software image on one or more new PCs

● Remotely updating the system BIOS in flash ROM (Remote ROM Flash on page 45)

NOTE: There are facilities to flash the system BIOS from within the Microsoft Windows operating
system.

● Configuring the system BIOS settings

To initiate Remote System Installation, press F12 when the F12 = Network Service Boot message
appears in the lower-right corner of the HP logo screen when the computer is booting up. Follow the
instructions on the screen to continue the process. The default boot order is a BIOS configuration setting
that can be changed to always attempt to PXE boot.

Software Updating and Management
HP provides several tools for managing and updating software on desktops, workstations, and
notebooks:

● HP Client Management Interface

● HP SoftPaq Download Manager

● HP System Software Manager

● HP ProtectTools Security Manager

● HP Client Automation Starter, Standard, and Enterprise Editions

● HP Client Manager from Symantec

● Altiris Client Management Suite

● HP Client Catalog for Microsoft System Center & SMS Products

● Intel vPro-branded PCs with Active Management Technology

● Verdiem Surveyor
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● HP Proactive Change Notification

● HP Subscriber's Choice

HP Client Management Interface
Regardless of the system management tools your IT department uses, managing both your hardware
and software assets is important to keeping your IT costs low and your business agile. The IT
administrator can access the HP Client Management Interface by writing simple scripts and integrating
those scripts to the management solution of their choice.

With the HP Client Management Interface (HP CMI), new HP business computers seamlessly integrate
into your managed IT environment. HP CMI provides an interface that simplifies the integration of HP
business computers with popular industry system management tools (including Microsoft Systems
Management Server, IBM Tivoli Software, and HP Operations) and custom in-house developed
management applications. Using HP CMI, systems management tools and applications can request in-
depth client inventory, receive health status information, and manage system BIOS settings by
communicating directly with the client computer, reducing the need for agent or connector software to
achieve integration.

HP Client Management Interface is based on industry standards that include Microsoft Windows
Management Interface (MS WMI), Web-Based Enterprise Management (WBEM), System Management
BIOS (SMBIOS), and Advanced Configuration and Power Interface (ACPI). HP CMI is a foundation
technology utilized in HP Client Management Solutions. With HP CMI, HP gives you flexibility in choosing
how you manage your HP client computers.

HP Client Management Interface used in conjunction with system management software can:

● Request in-depth client inventory information—Capture detailed information about the processors,
hard drives, memory, BIOS, drivers, including sensor information (such as fan speed, voltage, and
temperature).

● Receive health status information—Subscribe for a wide range of client hardware alerts (such as
over-temperature, fan stall, and hardware configuration changes) to be sent to the system
management console, application, or to the local client computer. Alerts are sent real-time when
triggered by hardware events.

● Manage system BIOS settings—Perform F10 functions including setting and changing the BIOS
passwords and computer boot order remotely from your system management console on any or
all of your client systems without having to visit each machine.

For more information on HP Client Management Interface, refer to http://www.hp.com/go/hpcmi/.

HP SoftPaq Download Manager
HP SoftPaq Download Manager is a free, easy-to-use interface for locating and downloading software
updates for the HP client PC models in your environment. By specifying your models, operating system,
and language, you can quickly locate, sort, and select the softpaqs you need. To download HP SoftPaq
Download Manager, visit http://www.hp.com/go/sdm.

HP System Software Manager
HP System Software Manager (SSM) is a free utility that automates remote deployment of device drivers
and BIOS updates for your networked HP business PCs. When SSM runs, it silently (without user
interaction) determines the revision levels of drivers and BIOS installed on each networked client system
and compares this inventory against system software SoftPaqs that have been tested and stored in a
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central file store. SSM then automatically updates any down-revision system software on the networked
PCs to the later levels available in the file store. Since SSM only allows distribution of SoftPaq updates
to the correct client system models, administrators can confidently and efficiently use SSM to keep
system software updated.

System Software Manager integrates with enterprise software distribution tools such as HP Client
Automation solutions, HP Client Manager from Symantec, and Microsoft Systems Management Server
(SMS). Using SSM, you can distribute customer-created or third-party updates that have been packaged
in the SSM-format.

SSM may be downloaded at no charge by visiting http://www.hp.com/go/ssm.

NOTE: SSM does not currently support remote ROM flash on systems that have Windows BitLocker
Drive Encryption enabled and are using TPM measurements to protect the BitLocker keys because
flashing the BIOS would invalidate the trust signature that BitLocker created for the platform. Disable
BitLocker via Group Policy in order to flash the system BIOS.

You can enable BitLocker support without TPM measurements of BIOS to avoid invalidating the
BitLocker keys. HP recommends you keep a secure backup of the BitLocker credentials in case of
recovery emergencies.

HP ProtectTools Security Manager
HP ProtectTools security software provides security features that help protect against unauthorized
access to the computer, networks, and critical data. Enhanced security functionality is provided by the
following software modules, and is accessible through HP ProtectTools Security Manager:

HP ProtectTools Security Manager is the single console through which all other modules are accessed.

● Credential Manager for HP ProtectTools

● Drive Encryption for HP ProtectTools

● Privacy Manager for HP ProtectTools

● File Sanitizer for HP ProtectTools

● Java Card Security for HP ProtectTools

● Embedded Security for HP ProtectTools

● Device Access Manager for HP ProtectTools

● LoJack Pro for HP ProtectTools

HP ProtectTools provides two versions that can be utilized: HP ProtectTools Security Manager and HP
ProtectTools Administrative Console. Both Administrator and user versions are available in the Start
> All Programs menu.

The software modules available for your computer may vary depending on your model. For example,
Embedded Security for HP ProtectTools is available only for computers on which the Trusted Platform
Module (TPM) embedded security chip is installed.

HP ProtectTools software modules may be preinstalled, preloaded, or available for download from the
HP Web site. For select HP Pro Desktops, HP ProtectTools is available as an after market option.
Visit http://www.hp.com/products/security for more information.
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HP Client Automation Starter and Standard Editions
HP Client Automation is a hardware and software management solution for Windows Vista, Windows
XP and HP Thin Client environments that is easy to use and quick to deploy, while providing a strong
foundation for future requirements. It is offered in two editions:

● The Starter Edition is a free product for managing HP desktops, notebooks and workstations,
providing hardware and software inventory, remote control, HP alert monitoring, HP BIOS and
driver updates, integration with HP Protect Tools and add-on support for Intel AMT. The Starter
Edition also supports deployment and management of HP Thin Clients.

● The Standard Edition, available for purchase, includes all functionality provided in Starter Edition
and adds Windows deployment and migration, patch management capabilities, software
distribution and software usage metering.

HP Client Automation Starter and Standard Editions provide a migration path to HP Client Automation
Enterprise Edition (based on Radia technology) for automated management of large, heterogeneous
and continuously changing IT environments.

For more information about the HP Client Automation solutions, visit http://www.hp.com/go/client.

HP Client Automation Enterprise Edition
HP Client Automation Enterprise Edition is a policy-based solution that enables administrators to
inventory, deploy, patch, and continuously manage software and content across heterogeneous client
platforms. With the HP Client Automation Enterprise Edition, the IT professional can:

● Automate the entire lifecycle management process from discovery, deployment, and ongoing
management through migration and retirement

● Automatically deploy and continuously manage an entire software stack (operating systems,
applications, patches, settings, and content) to a desired state

● Manage software on virtually any device, including desktops, workstations, and notebooks, in a
heterogeneous or standalone infrastructure

● Manage software on most operating systems

With continuous configuration management, HP customers report dramatic savings in IT costs,
accelerated time-to-market for software and content, and increased user productivity and satisfaction.

For more information about the HP Client Automation solutions, visit http://www.hp.com/go/client.

HP Client Manager from Symantec
HP Client Manager from Symantec, developed with Altiris, is available free for all supported HP business
desktop, notebook, and workstation models. SSM is integrated into HP Client Manager, and enables
central tracking, monitoring, and management of the hardware aspects of HP client systems.

Use HP Client Manager from Symantec to:

● Get valuable hardware information such as CPU, memory, video, and security settings

● Monitor system health to fix problems before they occur

● Automatically acquire and install drivers and BIOS updates without visiting each PC
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● Remotely configure BIOS and security settings

● Automate processes to quickly resolve hardware problems

Tight integration with HP Instant Support tools reduces hardware troubleshooting time.

● Diagnostics—remotely run & view reports on HP desktop, notebook, and workstation models

● System Health Scan—check for known hardware issues in your installed base of HP client systems

● Active Chat—connect to HP customer support to resolve issues

● HP Knowledgebase—link to expert information

● Automated SoftPaq collection and delivery process for fast resolution of hardware problems

● Identify, inventory, and initialize systems with HP ProtectTools embedded security chip

● Option for health alerts to display locally on the client system

● Report basic inventory information for non-HP clients

● Setup and configure TPM security chip

● Centrally schedule client backup and recovery

● Add on support for managing Intel AMT

For more information on HP Client Manager from Symantec, visit http://www.hp.com/go/
clientmanager.

Altiris Client Management Suite
Altiris Client Management Suite is an easy-to-use solution for full life-cycle software management of
desktops, notebooks, and workstations. Client Management Suite includes the following Altiris products:

● Inventory Solution

● Deployment Solution

● Software Delivery Solution

● Patch Management Solution

● Application Metering Solution

● Application Management Solution

● Carbon Copy Solution

For more information on Altiris Client Management Suite, visit http://www.symantec.com/business/
client-management-suite.

HP Client Catalog for Microsoft System Center & SMS Products
The HP Client Catalog enables IT professionals using Microsoft products to automate the deployment
of HP software updates (Softpaqs) to HP business PCs. The catalog file contains detailed platform
information on HP business desktops, notebooks and workstations. It can be used in conjunction with
the custom inventory and update features of Microsoft products to provide automated driver and patch
updates to managed HP client computers.
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Microsoft products supported by the HP Client Catalog include:

● System Center Configuration Manager 2007

● System Center Essentials 2007

● Systems Management Server (SMS) 2003 R2

For more information on HP Client Catalog for SMS, visit http://h20331.www2.hp.com/Hpsub/cache/
486247-0-0-225-121.html?jumpid=reg_R1002_USEN.

Remote Management Technology
Models include either vPro technology or standard technology. Both allow for better discovery, healing,
and protection of networked computing assets. Both technologies allow PCs to be managed whether
the system is on, off, or the operating system is hung.

The three forms of remote manageability available on business desktops are Alert Standard Format
(ASF), Intel Active Management Technology (AMT), and Desktop and mobile Architecture for Systems
Hardware (DASH).

Remote management technology features include:

● Network discovery

● Hardware inventory information

● Platform health monitoring

● Power management—power on/off, cycle power

● Remote diagnosis and repair

◦ Text console redirection—allows console control of remote PC during its boot phase

◦ Media redirection—allows system booting from a remote boot drive, disk, or ISO image (the
two variants of this are IDE-Redirect (IDE-R) on AMT platforms and USB Media Redirection)

● Hardware-based isolation and recovery—limit or cut off PC network access, if virus-like activity is
detected

● Platform event tracking and auditing

● Integrated web server management portal for remote access and configuration

● Remote management technologies are integrated with HP’s management console partners

NOTE: All features above are not available on all platforms.

Configuring the Intel Management Engine
NOTE: For an overview of Intel vPro technology, visit http://www.intel.com/vpro.

For HP-specific information on Intel vPro technology, see the white papers at http://www.hp.com/
support. Select your country and language, select See support and troubleshooting information,
enter the model number of the computer, and press Enter. In the Resources category, click Manuals
(guides, supplements, addendums, etc.). Under Quick jump to manuals by category, click White
papers.
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Available management technologies include the following:

● AMT (includes DASH 1.0)

● ASF

● DASH 1.1 (using a Broadcom NIC)

ASF and AMT may not be configured at the same time, but both are supported.

To configure Intel vPro systems for AMT or ASF:

1. Turn on or restart the computer. If you are in Microsoft Windows, click Start > Shut Down >
Restart.

2. As soon as the computer is turned on, press the hot key, Ctrl+P, before the computer boots to the
operating system.

NOTE: If you do not press Ctrl+P at the appropriate time, you must restart the computer and
again press Ctrl+P before the computer boots to the operating system to access the utility.

This hot-key enters the Intel Management Engine BIOS Execution (MEBx) setup utility. This utility allows
the user to configure various aspects of the management technology. Some of the configuration options
are listed below:

● Main Menu

◦ Intel ® ME Configuration

◦ Intel ® AMT Configuration

◦ Change Intel ® ME Password

◦ Exit

● Intel ® ME Platform Configuration

◦ Intel ® ME State Control (enable/disable)

◦ Intel ® ME Firmware Local Update (enable/disable)

◦ Intel ® ME Features Control

◦ Intel ® ME Power Control

● Intel ® AMT Configuration

◦ Host Name

◦ TCP/IP

◦ Provision Model (Enterprise, SMB)

◦ Setup and Configuration

◦ Un-Provision

◦ SOL/IDE-R (enable/disable)
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◦ Password Policy

◦ Secure Firmware Update (enable/disable)

◦ Set PRTC

◦ Idle Timeout

● Change Intel ® ME Password (HP highly recommends that this password be changed. The default
password is admin.)

In order to remotely manage AMT systems, the administrator must use a remote console that supports
AMT. Enterprise management consoles are available from suppliers such as HP, Altiris and Microsoft
SMS. In SMB mode, the client provides a Web browser interface. To access this feature, open a browser
from any other system on the network and enter http://host_name:16992 where host_name is
the name assigned to the system. Alternatively, the IP address may be used in place of the host name.

To configure systems with a Broadcom DASH capable NIC:

Check for the latest documentation on the http://www.hp.com site under Support &
Troubleshooting, then select your specific model, then select Manuals, then White papers referring
to DASH or the Broadcom NIC.

Verdiem Surveyor
Verdiem Surveyor is a software solution that helps manage PC energy costs. Surveyor measures and
reports how much energy each PC consumes. It also provides control over PC power settings enabling
administrators to easily implement energy saving strategies across their networks. An HP SoftPaq
containing the Surveyor agent may be downloaded from the HP Support site and installed on supported
commercial desktop models. Surveyor licenses for managing PCs may be purchased through your HP
representative.

HP Proactive Change Notification
The Proactive Change Notification program uses the Subscriber's Choice Web site in order to
proactively and automatically:

● Send you Proactive Change Notification (PCN) e-mail informing you of hardware and software
changes to most commercial computers and servers, up to 60 days in advance

● Send you e-mail containing Customer Bulletins, Customer Advisories, Customer Notes, Security
Bulletins, and Driver alerts for most commercial computers and servers

You create your own profile to ensure that you only receive the information relevant to a specific IT
environment. To learn more about the Proactive Change Notification program and create a custom
profile, visit http://h30046.www3.hp.com/subhub.php?jumpid=go/pcn.

Subscriber’s Choice
Subscriber’s Choice is a client-based service from HP.

Based on your profile, HP will supply you with personalized product tips, feature articles, and/or driver
and support alerts/notifications.

Subscriber’s Choice Driver and Support Alerts/Notifications will deliver e-mails notifying you that the
information you subscribed to in your profile is available for review and retrieval. To learn more about
Subscriber’s Choice and create a custom profile, visit http://h30046.www3.hp.com/subhub.php.
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Retired Solutions
Two software packages, Altiris Local Recovery, and Dantz Retrospect, will no longer be shipping on HP
business desktops, notebooks, or workstations.

ROM Flash
The computer's BIOS is stored in a programmable flash ROM (read only memory). By establishing a
setup password in the Computer Setup (F10) Utility, you can protect the ROM from being unintentionally
updated or overwritten. This is important to ensure the operating integrity of the computer. Should you
need or want to upgrade the BIOS, you may download the latest BIOS images from the HP driver and
support page, http://www.hp.com/support/files.

CAUTION: For maximum ROM protection, be sure to establish a setup password. The setup password
prevents unauthorized ROM upgrades. System Software Manager allows the system administrator to
set the setup password on one or more PCs simultaneously. For more information, visit
http://www.hp.com/go/ssm.

Remote ROM Flash
Remote ROM Flash allows the system administrator to safely upgrade the BIOS on remote HP
computers directly from the centralized network management console. Enabling the system
administrator to perform this task remotely on multiple computers results in a consistent deployment of,
and greater control over, HP PC BIOS images over the network. It also results in greater productivity
and lower total cost of ownership.

NOTE: SSM does not currently support remote ROM flash on systems that have Windows BitLocker
Drive Encryption enabled and are using TPM measurements to protect the BitLocker keys because
flashing the BIOS would invalidate the trust signature that BitLocker created for the platform. Disable
BitLocker via Group Policy in order to flash the system BIOS.

The computer must be powered on, or turned on through Remote Wakeup, to take advantage of Remote
ROM Flash.

For more information on Remote ROM Flash, refer to the HP Client Manager Software or System
Software Manager at http://www.hp.com/go/ssm/.

HPQFlash
The HPQFlash utility is used to locally update or restore the system BIOS of individual PCs from a
Windows operating system.

For more information on HPQFlash, visit http://www.hp.com/support/files and enter the model number
of the computer when prompted.
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Boot Block Emergency Recovery Mode
Boot Block Emergency Recovery Mode permits system recovery in the unlikely event of a ROM flash
failure. For example, if a power failure were to occur during a BIOS upgrade, the ROM flash would be
incomplete. This would render the system BIOS unusable. The Boot Block is a flash-protected section
of the ROM that contains code that checks for a valid system BIOS image when the system is turned
on.

● If the system BIOS image is valid, the system starts normally.

● If the system BIOS image is not valid, a failsafe Boot Block BIOS provides enough support to search
removable media for BIOS image files. If an appropriate BIOS image file is found, it is automatically
flashed into the ROM.

When an invalid system BIOS image is detected, the system power LED will blink red 8 times, one blink
every second. Simultaneously, the speaker will beep 8 times. If the portion of the system ROM containing
the video option ROM image is not corrupt, Boot Block Emergency Recovery Mode will be displayed
on the screen.

To recover the system after it enters Boot Block Emergency Recovery Mode, complete the following
steps:

1. Turn off the power.

2. Insert a CD or USB flash device containing the desired BIOS image file in the root directory.

NOTE: The media must be formatted using the FAT12, FAT16, or FAT32 file system.

3. Turn on the computer.

If no appropriate BIOS image is found, you will be prompted to insert media containing a BIOS
image file.

If the system successfully reprograms the ROM, the system will automatically power off.

4. Remove the removable media used to upgrade the BIOS.

5. Turn the power on to restart the computer.

NOTE: BitLocker prevents Windows Vista from booting when a CD containing the BIOS image file is
in an optical drive. If BitLocker is enabled, remove this CD before attempting to boot to Windows Vista.
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Replicating the Setup
The following procedures give an administrator the ability to easily copy one setup configuration to other
computers of the same model. This allows for faster, more consistent configuration of multiple
computers.

NOTE: Both procedures require a diskette drive or a supported USB flash drive.

NOTE: System Software Manager (SSM) can be used to replicate computer setup information from
within the Windows operating system. For more information see the SSM User’s Guide at
http://www.hp.com/go/ssm.

Copying to Single Computer
CAUTION: A setup configuration is model-specific. File system corruption may result if source and
target computers are not the same model. For example, do not copy the setup configuration from a
dc7xxx PC to a dx7xxx PC.

1. Select a setup configuration to copy. Turn off the computer. If you are in Windows, click Start >
Shut Down > Shut Down.

2. If you are using a USB flash media device, insert it now.

3. Turn on the computer.

4. As soon as the computer is turned on, press F10 before the computer boots to the operating system
to enter Computer Setup. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
press F10 before the computer boots to the operating system to access the utility.

5. If you are using a diskette, insert it now.

6. Click File > Replicated Setup > Save to Removable Media. Follow the instructions on the screen
to create the configuration diskette or USB flash media device.

7. Turn off the computer to be configured and insert the configuration diskette or USB flash media
device.

8. Turn on the computer to be configured.

9. As soon as the computer is turned on, press F10 before the computer boots to the operating system
to enter Computer Setup. Press Enter to bypass the title screen, if necessary.

10. Click File > Replicated Setup > Restore from Removable Media, and follow the instructions on
the screen.

11. Restart the computer when the configuration is complete.

Copying to Multiple Computers
CAUTION: A setup configuration is model-specific. File system corruption may result if source and
target computers are not the same model. For example, do not copy the setup configuration from a
dc7xxx PC to a dx7xxx PC.

This method takes a little longer to prepare the configuration diskette or USB flash media device, but
copying the configuration to target computers is significantly faster.
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NOTE: A bootable diskette is required for this procedure or to create a bootable USB flash media
device. If Windows XP is not available to use to create a bootable diskette, use the method for copying
to a single computer instead (see Copying to Single Computeron page 47).

1. Create a bootable diskette or USB flash media device. See Supported USB Flash Media Device
on page 48 or Unsupported USB Flash Media Device on page 50.

CAUTION: Not all computers can be booted from a USB flash media device. If the default boot
order in the Computer Setup (F10) Utility lists the USB device before the hard drive, the computer
can be booted from a USB flash media device. Otherwise, a bootable diskette must be used.

2. Select a setup configuration to copy. Turn off the computer. If you are in Windows, click Start >
Shut Down > Shut Down.

3. If you are using a USB flash media device, insert it now.

4. Turn on the computer.

5. As soon as the computer is turned on, press F10 before the computer boots to the operating system
to enter Computer Setup. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
press F10 before the computer boots to the operating system to access the utility.

6. If you are using a diskette, insert it now.

7. Click File > Replicated Setup > Save to Removable Media. Follow the instructions on the screen
to create the configuration diskette or USB flash media device.

8. Download a BIOS utility for replicating setup (repset.exe) and copy it onto the configuration diskette
or USB flash media device. To obtain this utility, go to http://welcome.hp.com/country/us/en/
support.html?pageDisplay=drivers and enter the model number of the computer.

9. On the configuration diskette or USB flash media device, create an autoexec.bat file containing the
following command:

repset.exe

10. Turn off the computer to be configured. Insert the configuration diskette or USB flash media device
and turn the computer on. The configuration utility will run automatically.

11. Restart the computer when the configuration is complete.

Creating a Bootable Device

Supported USB Flash Media Device
Supported devices have a preinstalled image to simplify the process of making them bootable. All HP
or Compaq and most other USB flash media devices have this preinstalled image. If the USB flash media
device being used does not have this image, use the procedure later in this section (see Unsupported
USB Flash Media Device on page 50).
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To create a bootable USB flash media device, you must have:

● a supported USB flash media device

● a bootable DOS diskette with the FDISK and SYS programs (If SYS is not available, FORMAT may
be used, but all existing files on the USB flash media device will be lost.)

● a PC that is bootable from a USB flash media device

CAUTION: Some older PCs may not be bootable from a USB flash media device. If the default boot
order in the Computer Setup (F10) Utility lists the USB device before the hard drive, the computer can
be booted from a USB flash media device. Otherwise, a bootable diskette must be used.

1. Turn off the computer.

2. Insert the USB flash media device into one of the computer's USB ports and remove all other USB
storage devices except USB diskette drives.

3. Insert a bootable DOS diskette with FDISK.COM and either SYS.COM or FORMAT.COM into a
diskette drive and turn on the computer to boot to the DOS diskette.

4. Run FDISK from the A:\ prompt by typing FDISK and pressing Enter. If prompted, click Yes (Y) to
enable large disk support.

5. Enter Choice [5] to display the drives in the system. The USB flash media device will be the drive
that closely matches the size of one of the drives listed. It will usually be the last drive in the list.
Note the letter of the drive.

USB flash media device drive: __________

CAUTION: If a drive does not match the USB flash media device, do not proceed. Data loss can
occur. Check all USB ports for additional storage devices. If any are found, remove them, reboot
the computer, and proceed from step 4. If none are found, either the system does not support the
USB flash media device or the USB flash media device is defective. DO NOT proceed in attempting
to make the USB flash media device bootable.

6. Exit FDISK by pressing the Esc key to return to the A:\ prompt.

7. If your bootable DOS diskette contains SYS.COM, go to step 8. Otherwise, go to step 9.

8. At the A:\ prompt, enter SYS x: where x represents the drive letter noted above.

CAUTION: Be sure that you have entered the correct drive letter for the USB flash media device.

After the system files have been transferred, SYS will return to the A:\ prompt. Go to step 13.

9. Copy any files you want to keep from your USB flash media device to a temporary directory on
another drive (for example, the system's internal hard drive).

10. At the A:\ prompt, enter FORMAT /S X: where X represents the drive letter noted before.

CAUTION: Be sure that you have entered the correct drive letter for the USB flash media device.

FORMAT will display one or more messages and ask you each time whether you want to proceed.
Enter Y each time. FORMAT will format the USB flash media device, add the system files, and ask
for a Volume Label.

11. Press Enter for no label or enter one if desired.
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12. Copy any files you saved in step 9 back to your USB flash media device.

13. Remove the diskette and reboot the computer. The computer will boot to the USB flash media
device as drive C.

NOTE: The default boot order varies from computer to computer, and it can be changed in the
Computer Setup (F10) Utility.

If you have used a DOS version from Windows 9x, you may see a brief Windows logo screen. If
you do not want this screen, add a zero-length file named LOGO.SYS to the root directory of the
USB flash media device.

Return to Copying to Multiple Computers on page 47.

Unsupported USB Flash Media Device
To create a bootable USB flash media device, you must have:

● a USB flash media device

● a bootable DOS diskette with the FDISK and SYS programs (If SYS is not available, FORMAT may
be used, but all existing files on the USB flash media device will be lost.)

● a PC that is bootable from a USB flash media device

CAUTION: Some older PCs may not be bootable from a USB flash media device. If the default boot
order in the Computer Setup (F10) Utility lists the USB device before the hard drive, the computer can
be booted from a USB flash media device. Otherwise, a bootable diskette must be used.

1. If there are any PCI cards in the system that have SCSI, ATA RAID or SATA drives attached, turn
off the computer and unplug the power cord.

CAUTION: The power cord MUST be unplugged.

2. Open the computer and remove the PCI cards.

3. Insert the USB flash media device into one of the computer's USB ports and remove all other USB
storage devices except USB diskette drives. Close the computer cover.

4. Plug in the power cord and turn on the computer.

5. As soon as the computer is turned on, press F10 before the computer boots to the operating system
to enter Computer Setup. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
press F10 before the computer boots to the operating system to access the utility.

6. Go to Advanced > PCI Devices to disable both the PATA and SATA controllers. When disabling
the SATA controller, note the IRQ to which the controller is assigned. You will need to reassign the
IRQ later. Exit setup, confirming the changes.

SATA IRQ: __________

7. Insert a bootable DOS diskette with FDISK.COM and either SYS.COM or FORMAT.COM into a
diskette drive and turn on the computer to boot to the DOS diskette.

8. Run FDISK and delete any existing partitions on the USB flash media device. Create a new partition
and mark it active. Exit FDISK by pressing the Esc key.
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9. If the system did not automatically restart when exiting FDISK, press Ctrl+Alt+Del to reboot to the
DOS diskette.

10. At the A:\ prompt, type FORMAT C: /S and press Enter. Format will format the USB flash media
device, add the system files, and ask for a Volume Label.

11. Press Enter for no label or enter one if desired.

12. Turn off the computer and unplug the power cord. Open the computer and re-install any PCI cards
that were previously removed. Close the computer cover.

13. Plug in the power cord, remove the diskette, and turn on the computer.

14. As soon as the computer is turned on, press F10 before the computer boots to the operating system
to enter Computer Setup. Press Enter to bypass the title screen, if necessary.

15. Go to Advanced > PCI Devices and re-enable the PATA and SATA controllers that were disabled
in step 6. Put the SATA controller on its original IRQ.

16. Save the changes and exit. The computer will boot to the USB flash media device as drive C.

NOTE: The default boot order varies from computer to computer, and it can be changed in the
Computer Setup (F10) Utility. Refer to the Computer Setup (F10) Utility for instructions.

If you have used a DOS version from Windows 9x, you may see a brief Windows logo screen. If
you do not want this screen, add a zero-length file named LOGO.SYS to the root directory of the
USB flash media device.

Return to Copying to Multiple Computers on page 47.

Dual-State Power Button
With Advanced Configuration and Power Interface (ACPI) enabled, the power button can function either
as an on/off switch or as a standby button. The standby feature does not completely turn off power, but
instead causes the computer to enter a low-power standby state. This allows you to power down quickly
without closing applications and to return quickly to the same operational state without any data loss.

To change the power button’s configuration, complete the following steps:

1. Left click on the Start Button, then select Control Panel > Power Options.

2. In the Power Options Properties, select the Advanced tab.

3. In the Power Button section, select Stand by.

After configuring the power button to function as a standby button, press the power button to put the
system in a very low power state (standby). Press the button again to quickly bring the system out of
standby to full power status. To completely turn off all power to the system, press and hold the power
button for four seconds.

CAUTION: Do not use the power button to turn off the computer unless the system is not responding;
turning off the power without operating system interaction could cause damage to or loss of data on the
hard drive.
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HP Web Site Support
HP engineers rigorously test and debug software developed by HP and third-party suppliers, and
develop operating system specific support software, to ensure performance, compatibility, and reliability
for HP computers.

When making the transition to new or revised operating systems, it is important to implement the support
software designed for that operating system. If you plan to run a version of Microsoft Windows that is
different from the version included with the computer, you must install corresponding device drivers and
utilities to ensure that all features are supported and functioning properly.

HP has made the task of locating, accessing, evaluating, and installing the latest support software easier.
You can download the software from http://www.hp.com/support.

The Web site contains the latest device drivers, utilities, and flashable ROM images needed to run the
latest Microsoft Windows operating system on the HP computer.

Industry Standards
HP management solutions integrate with other systems management applications, and are based on
industry standards, such as:

● Web-Based Enterprise Management (WBEM)

● Windows Management Interface (WMI)

● Wake on LAN Technology

● ACPI

● SMBIOS

● Pre-boot Execution (PXE) support

Asset Tracking and Security
Asset tracking features incorporated into the computer provide key asset tracking data that can be
managed using HP Systems Insight Manager, HP Client Manager, HP Configuration Management
Solution, HP Client Configuration Manager, or other system management applications. Seamless,
automatic integration between asset tracking features and these products enables you to choose the
management tool that is best suited to the environment and to leverage the investment in existing tools.

HP also offers several solutions for controlling access to valuable components and information.
HP Embedded Security for ProtectTools, if installed, prevents unauthorized access to data and checks
system integrity and authenticates third-party users attempting system access. (For more information,
refer to the HP ProtectTools Security Manager Guide at http://www.hp.com/products/security.) Security
features such as HP Embedded Security for ProtectTools, the Smart Cover Sensor and the Smart Cover
Lock, available on some models, help to prevent unauthorized access to the internal components of the
personal computer. By disabling parallel, serial, or USB ports, or by disabling removable media boot
capability, you can protect valuable data assets. Memory Change and Smart Cover Sensor alerts can
be automatically forwarded to system management applications to deliver proactive notification of
tampering with a computer’s internal components.

NOTE: HP Embedded Security for ProtectTools, the Smart Cover Sensor, and the Smart Cover Lock
are available as options on some systems.

52 Chapter 5   Desktop Management



Use the following utilities to manage security settings on the HP computer:

● Locally, using the Computer Setup Utilities. See the Computer Setup (F10) Utility Guide included
with the computer for additional information and instructions on using the Computer Setup Utilities.

● Remotely, using HP Client Manager from Symantec, HP Client Automation, or System Software
Manager. This software enables the secure, consistent deployment and control of security settings.

The following table and sections refer to managing security features of the computer locally through the
Computer Setup (F10) Utilities.

Table 5-1  Security Features Overview

Option Description

Setup Password Allows you to set and enable setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the
ROM, and make changes to certain plug and play settings under Windows.

Power-On Password Allows you to set and enable power-on password. The power-on password prompt appears after a
power cycle. If the user does not enter the correct power-on password, the unit will not boot.

NOTE: This password does not appear on warm boots , such as Ctrl+Alt+Delete or Restart from
Windows, unless enabled in Password Options (see below).

Password Options

(This selection appears
only if a power-on
password or setup
password is set.)

Allows you to:

● Lock legacy resources (appears if a setup password is set)

● Enable/disable network server mode (appears if a power-on password is set)

● Specify whether the password is required for warm boot (Ctrl+Alt+Delete) (appears if a power-
on password is set)

● Enable/Disable Setup Browse Mode (appears if a setup password is set) (allows viewing, but
not changing, the F10 Setup Options without entering setup password)

● Enable/disable Stringent Password (appears if a power-on password is set), which when
enabled bypasses the onboard password jumper to disable the power-on password

See the Desktop Management Guide for more information.

Smart Cover (some
models)

Allows you to:

● Lock/unlock the Cover Lock.

● Set the Cover Removal Sensor to Disable/Notify User/Setup Password.

NOTE: Notify User alerts the user that the sensor has detected that the cover has been
removed. Setup Password requires that the setup password be entered to boot the computer if the
sensor detects that the cover has been removed.

This feature is supported on some models only.
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Device Security Allows you to set Device Available/Device Hidden for:

● Serial ports

● Parallel port

● Rear USB ports

● Front USB ports

● Internal USB ports

● System audio

● Network controllers (some models)

● Legacy diskette

● Embedded security device (some models)

● SATA0

● SATA1 (some models)

● SATA2 (some models)

● SATA3 (some models)

● eSATA (some models)

LoJack for HP
ProtectTools

Allows you to remotely monitor, manage, and track your computer.

Once activated, LoJack Pro for HP ProtectTools is configured from the Absolute Software Customer
Center. From the Customer Center, the administrator can configure LoJack for HP ProtectTools to
monitor or manage the computer. If the system is misplaced or stolen, the Customer Center can
assist local authorities to locate and recover the computer. If configured, LoJack Pro can continue
to function even if the hard drive is erased or replaced.

Network Service Boot Enables/disables the computer’s ability to boot from an operating system installed on a network
server. (Feature available on NIC models only; the network controller must be either a PCI expansion
card or embedded on the system board.)

System IDs Allows you to set:

● Asset tag (18-byte identifier), a property identification number assigned by the company to the
computer.

● Ownership tag (80-byte identifier) displayed during POST.

● Chassis serial number or Universal Unique Identifier (UUID) number. The UUID can only be
updated if the current chassis serial number is invalid. (These ID numbers are normally set in
the factory and are used to uniquely identify the system.)

● Keyboard locale setting (for example, English or German) for System ID entry.

DriveLock Security Allows you to assign or modify a master or user password for hard drives. When this feature is
enabled, the user is prompted to provide one of the DriveLock passwords during POST. If neither
is successfully entered, the hard drive will remain inaccessible until one of the passwords is
successfully provided during a subsequent cold-boot sequence.

NOTE: This selection will only appear when at least one drive that supports the DriveLock feature
is attached to the system.

Table 5-1  Security Features Overview (continued)
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Setup Security Level Provides a method to allow end-users limited access to change specified setup options, without
having to know the Setup Password.

This feature allows the administrator the flexibility to protect changes to essential setup options,
while allowing the user to view system settings and configure nonessential options. The administrator
specifies access rights to individual setup options on a case-by-case basis via the Setup Security
Level menu. By default, all setup options are assigned Setup Password, indicating the user must
enter the correct Setup Password during POST to make changes to any of the options. The
administrator may set individual items to None, indicating the user can make changes to the specified
options when setup has been accessed with invalid passwords. The choice, None, is replaced by
Power-On Password if a Power-On Password is enabled.

NOTE: Setup Browse Mode must be set to Enable in order for the user to enter Setup without
knowing the setup password.

System Security (some
models: these options
are hardware
dependent)

Data Execution Prevention (some models) (enable/disable) - Helps prevent operating system
security breaches.

Virtualization Technology (some models) (enable/disable) - Controls the virtualization features of the
processor. Changing this setting requires turning the computer off and then back on.

Virtualization Technology Directed I/O (some models) (enable/disable) - Controls virtualization DMA
remapping features of the chipset. Changing this setting requires turning the computer off and then
back on.

Trusted Execution Technology (some models) (enable/disable) - Controls the underlying processor
and chipset features needed to support a virtual appliance. Changing this setting requires turning
the computer off and then back on. To enable this feature you must enable the following features:

● Embedded Security Device Support

● Virtualization Technology

● Virtualization Technology Directed I/O

Embedded Security Device Support (some models) (enable/disable) - Permits activation and
deactivation of the Embedded Security Device. Changing this setting requires turning the computer
off and then back on.

NOTE: To configure the Embedded Security Device, a Setup password must be set.

● Reset to Factory Settings (some models) (Do not reset/Reset) - Resetting to factory defaults
will erase all security keys. Changing this setting requires turning the computer off and then
back on.

CAUTION: The embedded security device is a critical component of many security schemes.
Erasing the security keys will prevent access to data protected by the Embedded Security
Device. Choosing Reset to Factory Settings may result in significant data loss.

● Reset authentication credentials (some models) (Do not reset/Reset) - Selecting Reset disables
the power-on authentication support and clears the authentication information from the
Embedded Security Device. Changing this setting requires turning the computer off and then
back on

OS management of Embedded Security Device (some models) (enable/disable) - This option allows
the user to limit operating system control of the Embedded Security Device. Changing this setting
requires turning the computer off and then back on. This option allows the user to limit OS control
of the Embedded Security Device.

● Reset of Embedded Security Device through OS (some models) (enable/disable) - This option
allows the user to limit the operating system ability to request a Reset to Factory Settings of
the Embedded Security Device. Changing this setting requires turning the computer off and
then back on.

NOTE: To enable this option, a Setup password must be set.

PAVP (Some models) (disabled/min/max) - PAVP enables the Protected Audio Video Path in the
Chipset. This may allow viewing of some protected high definition content that would otherwise be
prohibited from playback. Selecting Max will assign 96 Megabytes of system memory exclusively to
PAVP.

Table 5-1  Security Features Overview (continued)
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Password Security
The power-on password prevents unauthorized use of the computer by requiring entry of a password
to access applications or data each time the computer is turned on or restarted. The setup password
specifically prevents unauthorized access to Computer Setup, and can also be used as an override to
the power-on password. That is, when prompted for the power-on password, entering the setup
password instead will allow access to the computer.

A network-wide setup password can be established to enable the system administrator to log in to all
network systems to perform maintenance without having to know the power-on password, even if one
has been established.

NOTE: System Software Manager (SSM) can be used to create and manage BIOS passwords from
within the Windows operating system. For more information see the SSM User’s Guide at
http://www.hp.com/go/ssm.

NOTE: HP Client Management Interface (HP CMI) provides access to BIOS setting management
including BIOS passwords from within the Windows operating system. For more information see the HP
Client Management Interface Technical Whitepaper at http://www.hp.com/go/hpcmi.

Establishing a Setup Password Using Computer Setup
If the system is equipped with an embedded security device, refer to the HP ProtectTools Security
Manager Guide at http://www.hp.com. Establishing a setup password through Computer Setup prevents
reconfiguration of the computer (use of the Computer Setup (F10) utility) until the password is entered.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press F10 before the computer boots to the operating system
to enter Computer Setup. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
press F10 before the computer boots to the operating system to access the utility.

3. Select Security, then select Setup Password and follow the instructions on the screen.

4. Before exiting, click File > Save Changes and Exit.

Establishing a Power-On Password Using Computer Setup
Establishing a power-on password through Computer Setup prevents access to the computer when
power is turned on, unless the password is entered. When a power-on password is set, Computer Setup
presents Password Options under the Security menu. Password options include Password Prompt
on Warm Boot. When Password Prompt on Warm Boot is enabled, the password must also be
entered each time the computer is rebooted.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press F10 before the computer boots to the operating system
to enter Computer Setup. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
press F10 before the computer boots to the operating system to access the utility.

3. Select Security, then Power-On Password and follow the instructions on the screen.

4. Before exiting, click File > Save Changes and Exit.
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Entering a Power-On Password
To enter a power-on password, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart the
Computer.

2. When the key icon appears on the monitor, type the current password, then press Enter.

NOTE: Type carefully; for security reasons, the characters you type do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful
tries, you must turn off the computer, then turn it on again before you can continue.

Entering a Setup Password
If the system is equipped with an embedded security device, refer to the HP ProtectTools Security
Manager Guide at http://www.hp.com.

If a setup password has been established on the computer, you will be prompted to enter it each time
you run Computer Setup.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press F10 before the computer boots to the operating system
to enter Computer Setup. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
press F10 before the computer boots to the operating system to access the utility.

3. When the key icon appears on the monitor, type the setup password, then press Enter.

NOTE: Type carefully; for security reasons, the characters you type do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful
tries, you must turn off the computer, then turn it on again before you can continue.

Changing a Power-On or Setup Password
If the system is equipped with an embedded security device, refer to the HP ProtectTools Security
Manager Guide at http://www.hp.com.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart the
Computer.

2. To change the Power-On password, go to step 3.

To change the Setup password, as soon as the computer is turned on, press F10 before the
computer boots to the operating system to enter Computer Setup. Press Enter to bypass the title
screen, if necessary.

NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
press F10 before the computer boots to the operating system to access the utility.

3. When the key icon appears, type the current password, a slash (/) or alternate delimiter character,
the new password, another slash (/) or alternate delimiter character, and the new password again
as shown: current password/new password/new password
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NOTE: Type carefully; for security reasons, the characters you type do not appear on the screen.

4. Press Enter.

The new password takes effect the next time you turn on the computer.

NOTE: Refer to the National Keyboard Delimiter Characterson page 58 for information about the
alternate delimiter characters. The power-on password and setup password may also be changed using
the Security options in Computer Setup.

Deleting a Power-On or Setup Password
If the system is equipped with an embedded security device, refer to the HP ProtectTools Security
Manager Guide at http://www.hp.com.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart the
Computer.

2. To delete the Power-On password, go to step 3.

To delete the Setup password, as soon as the computer is turned on, press F10 before the
computer boots to the operating system to enter Computer Setup. Press Enter to bypass the title
screen, if necessary.

NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
press F10 before the computer boots to the operating system to access the utility.

3. When the key icon appears, type the current password followed by a slash (/) or alternate delimiter
character as shown: current password/

4. Press Enter.

NOTE: Refer to National Keyboard Delimiter Characterson page 58 for information about the
alternate delimiter characters. The power-on password and setup password may also be changed
using the Security options in Computer Setup.

National Keyboard Delimiter Characters
Each keyboard is designed to meet country-specific requirements. The syntax and keys that you use to
change or delete the password depend on the keyboard that came with the computer.

National Keyboard Delimiter Characters

/ Arabic - Greek / Russian

= Belgian . Hebrew - Slovakian

- BHCMSS* - Hungarian - Spanish

/ Brazilian - Italian / Swedish/Finnish

/ Chinese / Japanese - Swiss

- Czech / Korean / Taiwanese

- Danish - Latin American / Thai

! French - Norwegian . Turkish

é French Canadian - Polish / U.S. English
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National Keyboard Delimiter Characters

- German - Portuguese   

* For Bosnia-Herzegovina, Croatia, Montenegro, Serbia, and Slovenia

Clearing Passwords
If you forget the password, you cannot access the computer. Refer to the Troubleshooting Guide for
instructions on clearing passwords.

If the system is equipped with an embedded security device, refer to the HP ProtectTools Security
Manager Guide at http://www.hp.com.

DriveLock
DriveLock is an industry-standard security feature that prevents unauthorized access to the data on ATA
hard. DriveLock has been implemented as an extension to Computer Setup. It is only available when
hard drives that support the ATA Security command set are detected. DriveLock is intended for HP
customers for whom data security is the paramount concern. For such customers, the cost of the hard
drive and the loss of the data stored on it is inconsequential when compared with the damage that could
result from unauthorized access to its contents. In order to balance this level of security with the practical
need to accommodate a forgotten password, the HP implementation of DriveLock employs a two-
password security scheme. One password is intended to be set and used by a system administrator
while the other is typically set and used by the end-user. There is no “back-door” that can be used to
unlock the drive if both passwords are lost. Therefore, DriveLock is most safely used when the data
contained on the hard drive is replicated on a corporate information system or is regularly backed up.
In the event that both DriveLock passwords are lost, the hard drive is rendered unusable. For users who
do not fit the previously defined customer profile, this may be an unacceptable risk. For users who do
fit the customer profile, it may be a tolerable risk given the nature of the data stored on the hard drive.

Using DriveLock
When one or more hard drives that support the ATA Security command set are detected, the DriveLock
option appears under the Security menu in Computer Setup. The user is presented with options to set
the master password or to enable DriveLock. A user password must be provided in order to enable
DriveLock. Since the initial configuration of DriveLock is typically performed by a system administrator,
a master password should be set first. HP encourages system administrators to set a master password
whether they plan to enable DriveLock or keep it disabled. This will give the administrator the ability to
modify DriveLock settings if the drive is locked in the future. Once the master password is set, the system
administrator may enable DriveLock or choose to keep it disabled.

If a locked hard drive is present, POST will require a password to unlock the device. If a power-on
password is set and it matches the device’s user password, POST will not prompt the user to re-enter
the password. Otherwise, the user will be prompted to enter a DriveLock password. On a cold boot,
either the master or the user password may be used. On a warm boot, enter the same password used
to unlock the drive during the preceding cold-boot. Users will have two attempts to enter a correct
password. On a cold boot, if neither attempt succeeds, POST will continue but the drive will remain
inaccessible. On a warm boot or restart from Windows, if neither attempt succeeds, POST will halt and
the user will be instructed to cycle power.
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DriveLock Applications
The most practical use of the DriveLock security feature is in a corporate environment. The system
administrator would be responsible for configuring the hard drive which would involve, among other
things, setting the DriveLock master password and a temporary user password. In the event that the
user forgets the user password or the equipment is passed on to another employee, the master
password can always be used to reset the user password and regain access to the hard drive.

HP recommends that corporate system administrators who choose to enable DriveLock also establish
a corporate policy for setting and maintaining master passwords. This should be done to prevent a
situation where an employee intentionally or unintentionally sets both DriveLock passwords before
leaving the company. In such a scenario, the hard drive would be rendered unusable and require
replacement. Likewise, by not setting a master password, system administrators may find themselves
locked out of a hard drive and unable to perform routine checks for unauthorized software, other asset
control functions, and support.

For users with less stringent security requirements, HP does not recommend enabling DriveLock. Users
in this category include personal users or users who do not maintain sensitive data on their hard drives
as a common practice. For these users, the potential loss of a hard drive resulting from forgetting both
passwords is much greater than the value of the data DriveLock has been designed to protect. Access
to Computer Setup and DriveLock can be restricted through the Setup password. By specifying a Setup
password and not giving it to end users, system administrators are able to restrict users from enabling
DriveLock.

Smart Cover Sensor
Cover Removal Sensor, available on some models, is a combination of hardware and software
technology that can alert you when the computer cover or side panel has been removed. There are
three levels of protection, as described in the following table.

Table 5-2  Smart Cover Sensor Protection Levels

Level Setting Description

Level 0 Disabled Smart Cover Sensor is disabled (default).

Level 1 Notify User When the computer is restarted, the screen displays a message
indicating that the computer cover or side panel has been removed.

Level 2 Setup Password When the computer is restarted, the screen displays a message
indicating that the computer cover or side panel has been removed. You
must enter the setup password to continue.

NOTE: These settings can be changed using Computer Setup. For more information about Computer Setup,
see the Computer Setup (F10) Utility Guide.

Setting the Smart Cover Sensor Protection Level
To set the Smart Cover Sensor protection level, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press F10 before the computer boots to the operating system
to enter Computer Setup. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
press F10 before the computer boots to the operating system to access the utility.
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3. Select Security > Smart Cover > Cover Removal Sensor, and select the desired security level.

4. Before exiting, click File > Save Changes and Exit.

Smart Cover Lock
The Smart Cover Lock is a software-controllable cover lock featured on some HP computers. This lock
prevents unauthorized access to the internal components. Computers ship with the Smart Cover Lock
in the unlocked position.

CAUTION: For maximum cover lock security, be sure to establish a setup password. The setup
password prevents unauthorized access to the Computer Setup utility.

NOTE: The Smart Cover Lock is available as an option on some systems.

Locking the Smart Cover Lock
To activate and lock the Smart Cover Lock, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press F10 before the computer boots to the operating system
to enter Computer Setup. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
press F10 before the computer boots to the operating system to access the utility.

3. Select Security > Smart Cover > Cover Lock > Lock option.

4. Before exiting, click File > Save Changes and Exit.

Unlocking the Smart Cover Lock
1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press F10 before the computer boots to the operating system
to enter Computer Setup. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
press F10 before the computer boots to the operating system to access the utility.

3. Select Security > Smart Cover > Cover Lock > Unlock.

4. Before exiting, click File > Save Changes and Exit.

Using the Smart Cover FailSafe Key
If you enable the Smart Cover Lock and cannot enter the password to disable the lock, you will need a
Smart Cover FailSafe Key to open the computer cover. You will need the key in any of the following
circumstances:

● Power outage

● Startup failure

● PC component failure (such as processor or power supply)

● Forgotten password
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CAUTION: The Smart Cover FailSafe Key is a specialized tool available from HP. Be prepared; order
this key before you need one at an authorized reseller or service provider.

To obtain the FailSafe Key, do any one of the following:

● Contact an authorized HP reseller or service provider.

● Call the appropriate number listed in the warranty.

For more information about using the Smart Cover FailSafe Key, consult the Hardware Reference
Guide.

Cable Lock Provision
The rear panel of the computer (some models) accommodates a cable lock so that the computer can
be physically secured to a work area.

For illustrated instructions, please see the Hardware Reference Guide.

Fingerprint Identification Technology
Eliminating the need to enter user passwords, HP Fingerprint Identification Technology tightens network
security, simplifies the login process, and reduces the costs associated with managing corporate
networks. Affordably priced, it is not just for high-tech, high-security organizations anymore.

NOTE: Support for Fingerprint Identification Technology varies by model.

Fault Notification and Recovery
Fault Notification and Recovery features combine innovative hardware and software technology to
prevent the loss of critical data and minimize unplanned downtime.

If the computer is connected to a network managed by HP Client Manager, the computer sends a fault
notice to the network management application. With HP Client Manager Software, you can also remotely
schedule diagnostics to automatically run on all managed PCs and create a summary report of failed
tests.

Drive Protection System
The Drive Protection System (DPS) is a diagnostic tool built into the hard drives installed in some HP
computers. DPS is designed to help diagnose problems that might result in unwarranted hard drive
replacement.

When HP computers are built, each installed hard drive is tested using DPS, and a permanent record
of key information is written onto the drive. Each time DPS is run, test results are written to the hard
drive. The service provider can use this information to help diagnose conditions that caused you to run
the DPS software. Refer to the Troubleshooting Guide for instructions on using DPS.

Surge-Tolerant Power Supply
An integrated surge-tolerant power supply provides greater reliability when the computer is hit with an
unpredictable power surge. This power supply is rated to withstand a power surge of up to 2000 volts
without incurring any system downtime or data loss.
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Thermal Sensor
The thermal sensor is a hardware and software feature that tracks the internal temperature of the
computer. This feature displays a caution message when the normal range is exceeded, which gives
you time to take action before internal components are damaged or data is lost.

CAUTION: A high temperature condition can result in damage to the system or data loss.

Asset Tracking and Security 63



6 Serial ATA Drive Guidelines and
Features

NOTE: Serial ATA = SATA

HP only supports the use of SATA hard drives on these computers.

SATA Hard Drives
Serial ATA Hard Drive Characteristics  

Number of pins/conductors in data cable 7/7

Number of pins in power cable 15

Maximum data cable length 39.37 in (100 cm)

Data interface voltage differential 400-700 mV

Drive voltages 3.3 V, 5 V, 12 V

Jumpers for configuring drive N/A

Data transfer rate 3.0 Gb/s

SATA connectors on the system board are color coded to make identification easier.

SATA Identification Color Port Attachment Sequence

Primary channel, device 0 Dark blue SATA 0 1

Primary channel, device 1 Light Blue SATA 2 4

Secondary channel, device 0 White SATA 1 2

Secondary channel, device 1 Orange SATA 3 3

NOTE: If there is an error on the application of the attach rules, a POST error message may be
displayed.

64 Chapter 6   Serial ATA Drive Guidelines and Features



SATA Hard Drive Cables

SATA Data Cable
Always use an HP approved SATA 3.0 Gb/s cable as it is fully backwards compatible with the SATA 1.5
Gb/s drives.

Current HP desktop products ship with SATA 3.0 Gb/s hard drives.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and never
bend it tighter than a 30 mm (1.18 in) radius.

The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive. As shown
in the table, each cable has 3 grounds, and 4 transmit/receive pins.

Pin Number Usage Device Plug Host Plug

P1 Ground Ground Ground

P2* A+ Transmit data Receive data

P3* A- Transmit data Receive data

P4 Ground Ground Ground

P5** B- Receive data Transmit data

P6** B+ Receive data Transmit data

P7 Ground Ground Ground

*P2 and P3 differential signal pair

**P5 and P6 differential signal pair

SATA Power Cable

Pin Usage Notes Pin Usage Notes

P1 V3.3 3.3 V power P9 V5 5 V power

P2 V3.3 3.3 V power P10 Ground

P3 V3.3 3.3 V power P11 Ground

P4 Ground P12 Ground

P5 Ground P13 V12 12 V power

P6 Ground P14 V12 12 V power

P7 V5 5 V power P15 V12 12 V power

P8 V5 5 V power
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ATA SMART Drives
The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP Personal
Computers have built-in drive failure prediction that warns the user or network administrator of an
impending failure or crash of the hard drive. The SMART drive tracks fault prediction and failure
indication parameters such as reallocated sector count, spin retry count, and calibration retry count. If
the drive determines that a failure is imminent, it generates a fault alert.

Hard Drive Capacities
The combination of the file system and the operating system used in the computer determines the
maximum usable size of a drive partition. A drive partition is the largest segment of a drive that may be
properly accessed by the operating system. A single hard drive may therefore be subdivided into a
number of unique drive partitions in order to make use of all of its space.

Because of the differences in the way that drive sizes are calculated, the size reported by the operating
system may differ from that marked on the hard drive or listed in the computer specification. Drive size
calculations by drive manufacturers are bytes to the base 10 while calculations by Microsoft are bytes
to the base 2.

Drive/Partition Capacity Limits

 Maximum Size

File System Controller Type Operating System Partition Drive

FAT 32 ATA Windows 2000/XP 32 GB 2 TB

NTFS ATA Windows NT/2000/XP 2 TB 2 TB
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7 Identifying the Chassis, Routine Care,
and Disassembly Preparation

This chapter provides general service information for the computer. Adherence to the procedures and
precautions described in this chapter is essential for proper service.

CAUTION: When the computer is plugged into an AC power source, voltage is always applied to the
system board. You must disconnect the power cord from the power source before opening the computer
to prevent system board or component damage.

Chassis Designations
The following subsections illustrate the HP Compaq 6000 Pro Microtower Business PC chassis designs.

Small Form Factor (SFF)
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Microtower (MT)

Electrostatic Discharge Information
A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic
device exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work
perfectly throughout a normal cycle. The device may function normally for a while, but it has been
degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the discharge
contains enough power to alter device parameters or melt silicon junctions.

Generating Static
The following table shows that:

● Different activities generate different amounts of static electricity.

● Static electricity increases as humidity decreases.

 Relative Humidity

Event 55% 40% 10%

Walking across carpet

Walking across vinyl floor

Motions of bench worker

Removing DIPs* from plastic tube

7,500 V

3,000 V

400 V

400 V

15,000 V

5,000 V

800 V

700 V

35,000 V

12,000 V

6,000 V

2,000 V

68 Chapter 7   Identifying the Chassis, Routine Care, and Disassembly Preparation



Removing DIPs* from vinyl tray

Removing DIPs* from Styrofoam

Removing bubble pack from PCB

Packing PCBs in foam-lined box

2,000 V

3,500 V

7,000 V

5,000 V

4,000 V

5,000 V

20,000 V

11,000 V

11,500 V

14,500 V

26,500 V

21,000 V

*These are then multi-packaged inside plastic tubes, trays, or Styrofoam.

NOTE: 700 volts can degrade a product.

Preventing Electrostatic Damage to Equipment
Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree
of sensitivity. The following packaging and grounding precautions are necessary to prevent damage to
electric components and accessories.

● To avoid hand contact, transport products in static-safe containers such as tubes, bags, or boxes.

● Protect all electrostatic parts and assemblies with conductive or approved containers or packaging.

● Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

● Place items on a grounded surface before removing them from their container.

● Always be properly grounded when touching a sensitive component or assembly.

● Avoid contact with pins, leads, or circuitry.

● Place reusable electrostatic-sensitive parts from assemblies in protective packaging or conductive
foam.

Personal Grounding Methods and Equipment
Use the following equipment to prevent static electricity damage to equipment:

● Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the ground
cords. To provide proper ground, a strap must be worn snug against bare skin. The ground cord
must be connected and fit snugly into the banana plug connector on the grounding mat or
workstation.

● Heel straps/Toe straps/Boot straps can be used at standing workstations and are compatible
with most types of shoes or boots. On conductive floors or dissipative floor mats, use them on both
feet with a maximum of one-megohm ± 10% resistance between the operator and ground.

Static Shielding Protection Levels

Method Voltage

Antistatic plastic

Carbon-loaded plastic

Metallized laminate

1,500

7,500

15,000
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Grounding the Work Area
To prevent static damage at the work area, use the following precautions:

● Cover the work surface with approved static-dissipative material. Provide a wrist strap connected
to the work surface and properly grounded tools and equipment.

● Use static-dissipative mats, foot straps, or air ionizers to give added protection.

● Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only at static-free work areas.

● Turn off power and input signals before inserting and removing connectors or test equipment.

● Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.

● Keep work area free of nonconductive materials such as ordinary plastic assembly aids and
Styrofoam.

● Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended Materials and Equipment
Materials and equipment that are recommended for use in preventing static electricity include:

● Antistatic tape

● Antistatic smocks, aprons, or sleeve protectors

● Conductive bins and other assembly or soldering aids

● Conductive foam

● Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance

● Static-dissipative table or floor mats with hard tie to ground

● Field service kits

● Static awareness labels

● Wrist straps and footwear straps providing one-megohm +/- 10% resistance

● Material handling packages

● Conductive plastic bags

● Conductive plastic tubes

● Conductive tote boxes

● Opaque shielding bags

● Transparent metallized shielding bags

● Transparent shielding tubes
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Operating Guidelines
To prevent overheating and to help prolong the life of the computer:

● Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and cold.

● Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all vented
sides of the computer and above the monitor to permit the required airflow.

● Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place the
keyboard, with the keyboard feet down, directly against the front of the desktop unit as this also
restricts airflow.

● Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign
matter can block the vents and limit the airflow. Be sure to unplug the computer before cleaning
the air vents.

● Never operate the computer with the cover or side panel removed.

● Do not stack computers on top of each other or place computers so near each other that they are
subject to each other’s re-circulated or preheated air.

● If the computer is to be operated within a separate enclosure, intake and exhaust ventilation must
be provided on the enclosure, and the same operating guidelines listed above will still apply.

● Keep liquids away from the computer and keyboard.

● Never cover the ventilation slots on the monitor with any type of material.

● Install or enable power management functions of the operating system or other software, including
sleep states.

Routine Care

General Cleaning Safety Precautions
1. Never use solvents or flammable solutions to clean the computer.

2. Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and then
use the cloth on the component.

3. Always unplug the computer when cleaning with liquids or damp cloths.

4. Always unplug the computer before cleaning the keyboard, mouse, or air vents.

5. Disconnect the keyboard before cleaning it.

6. Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the Computer Case
Follow all safety precautions in General Cleaning Safety Precautions on page 71 before cleaning the
computer.
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To clean the computer case, follow the procedures described below:

● To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

● For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it with a
cloth or swab dampened with clear water.

● For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will
evaporate quickly and not leave a residue.

● After cleaning, always wipe the unit with a clean, lint-free cloth.

● Occasionally clean the air vents on the computer. Lint and other foreign matter can block the vents
and limit the airflow.

Cleaning the Keyboard
Follow all safety precautions in General Cleaning Safety Precautions on page 71 before cleaning the
keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the
Computer Case on page 71.

When cleaning debris from under the keys, review all rules in General Cleaning Safety Precautions
on page 71 before following these procedures:

WARNING! Use safety glasses equipped with side shields before attempting to clean debris from
under the keys.

CAUTION: Visible debris underneath or between the keys may be removed by vacuuming or shaking.

CAUTION: Canned, pressurized air may be used to clean debris from under the keys. Caution should
be used as too much air pressure can dislodge lubricants applied under the wide keys.

CAUTION: If you remove a key, use a specially designed key puller to prevent damage to the keys.
This tool is available through many electronic supply outlets.

CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these keys are
improperly removed or installed, the keyboard may not function properly.

CAUTION: Cleaning under a key may be done with a swab moistened with isopropyl alcohol and
squeezed out. Be careful not to wipe away lubricants necessary for proper key functions. Use tweezers
to remove any fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the Monitor
● Wipe the monitor screen with a clean cloth moistened with water or with a towelette designed for

cleaning monitors. Do not use sprays or aerosols directly on the screen; the liquid may seep into
the housing and damage a component. Never use solvents or flammable liquids on the monitor.

● To clean the monitor body follow the procedures in Cleaning the Computer Case on page 71.
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Cleaning the Mouse
Before cleaning the mouse, ensure that the power to the computer is turned off.

● Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out
any debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

● To clean the mouse body, follow the procedures in Cleaning the Computer Case on page 71.

Service Considerations
Listed below are some of the considerations that you should keep in mind during the disassembly and
assembly of the computer.

Power Supply Fan
The power supply fan is a variable-speed fan based on the temperature in the power supply.

CAUTION: The cooling fan is always on when the computer is in the “On” mode. The cooling fan is
off when the computer is in “Standby,” “Suspend,” or “Off” modes.

You must disconnect the power cord from the power source before opening the computer to prevent
system board or component damage.

Tools and Software Requirements
To service the computer, you need the following:

● Torx T-15 screwdriver (HP screwdriver with bits, PN 161946-001)

● Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)

● Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)

● Phillips #2 screwdriver

● Diagnostics software

● HP tamper-resistant T-15 wrench (Smart Cover FailSafe Key, PN 166527-001) or HP tamper-
resistant bits (Smart Cover FailSafe Key, PN 166527-002)

Screws
The screws used in the computer are not interchangeable. They may have standard or metric threads
and may be of different lengths. If an incorrect screw is used during the reassembly process, it can
damage the unit. HP strongly recommends that all screws removed during disassembly be kept with
the part that was removed, then returned to their proper locations.

CAUTION: Metric screws have a black finish. U.S. screws have a silver finish and are used on hard
drives only.

CAUTION: As each subassembly is removed from the computer, it should be placed away from the
work area to prevent damage.
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Cables and Connectors
Most cables used throughout the unit are flat, flexible cables. These cables must be handled with care
to avoid damage. Apply only the tension required to seat or unseat the cables during insertion or removal
from the connector. Handle cables by the connector whenever possible. In all cases, avoid bending or
twisting the cables, and ensure that the cables are routed in such a way that they cannot be caught or
snagged by parts being removed or replaced.

CAUTION: When servicing this computer, ensure that cables are placed in their proper location during
the reassembly process. Improper cable placement can damage the computer.

Hard Drives
CAUTION: Handle hard drives as delicate, precision components, avoiding all physical shock and
vibration. This applies to failed drives as well as replacement spares.

● If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “Fragile: Handle With Care.”

● Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are actually mounted in the CPU.

● Avoid dropping drives from any height onto any surface.

● If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard drive
while the computer is on or in standby mode.

● Before handling a drive, ensure that you are discharged of static electricity. While handling a drive,
avoid touching the connector. For more information about preventing electrostatic damage, refer
to Electrostatic Discharge Information on page 68

● Do not use excessive force when inserting a drive.

● Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

Lithium Coin Cell Battery
The battery that comes with the computer provides power to the real-time clock and has a minimum
lifetime of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this guide
for instructions on the replacement procedures.

WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in
water or fire, or expose it to temperatures higher than 140ºF (60ºC). Do not attempt to recharge the
battery.

NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the general
household waste. In order to forward them to recycling or proper disposal, please use the public
collection system or return them to HP, their authorized partners, or their agents.
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8 Removal and Replacement Procedures
Microtower (MT) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper service.
After completing all necessary removal and replacement procedures, run the Diagnostics utility to verify
that all components operate properly.

NOTE: Not all features listed in this guide are available on all computers.

Serial Number Location
Each computer has a unique serial number and product ID number that are located on the top cover of
the computer. Keep these numbers available for use when contacting customer service for assistance.

Figure 8-1  Serial Number and Product ID Location
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Preparation for Disassembly
See Identifying the Chassis, Routine Care, and Disassembly Preparation on page 67 for initial safety
procedures.

1. Remove/disengage any security devices that prohibit opening the computer (External Security
Devices on page 118).

2. Close any open software applications.

3. Exit the operating system.

4. Remove any diskette, compact disc, or media card from the computer.

5. Turn off the computer and any peripheral devices that are connected to it.

CAUTION: Turn off the computer before disconnecting any cables.

Regardless of the power-on state, voltage is always present on the system board as long as the
system is plugged into an active AC outlet. In some systems the cooling fan is on even when the
computer is in the “Standby,” or “Suspend” modes. The power cord should always be disconnected
before servicing a unit.

6. Disconnect the power cord from the electrical outlet and then from the computer.

7. Disconnect all peripheral device cables from the computer.

8. Lay the computer down on its side to achieve a safe working position.

NOTE: During disassembly, label each cable as you remove it, noting its position and routing.
Keep all screws with the units removed.

CAUTION: The screws used in the computer are of different thread sizes and lengths; using the wrong
screw in an application may damage the unit.
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Access Panel
1. Prepare the computer for disassembly (Preparation for Disassembly on page 76).

CAUTION: Before removing the computer access panel, ensure that the computer is turned off
and that the power cord is disconnected from the electrical outlet.

2. Loosen the two captive thumbscrews (1) that secure the access panel to the computer chassis.

3. Use the handle located between the thumbscrews to lift the access panel off the unit (2).

NOTE: You may want to lay the computer on its side to install internal parts. Be sure the side
with the access panel is facing up.

Figure 8-2  Removing the Computer Access Panel

To install the access panel, reverse the removal procedure.
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Front Bezel
1. Prepare the computer for disassembly (Preparation for Disassembly on page 76).

2. Remove the computer access panel.

3. Lift up the three tabs on the side of the bezel (1), then rotate the bezel off the chassis (2).

Figure 8-3  Removing the Front Bezel

To reinstall the front bezel, reverse the removal procedure.
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Removing Bezel Blanks
On some models, there are bezel blanks covering the 3.5-inch and 5.25-inch external drive bays that
need to be removed before installing a drive. To remove a bezel blank:

1. Remove the access panel and front bezel.

2. To remove a bezel blank, push the two retaining tabs that hold the bezel blank in place towards
the outer right edge of the bezel (1) and slide the bezel blank back and to the right to remove it
(2).

Figure 8-4  Removing a Bezel Blank
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Cable Management
Always follow good cable management practices when working inside the computer.

● Keep cables away from major heat sources like the heat sink.

● Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these
are not designed to take excessive pressure on them.

● Keep cables clear of sliding or moveable parts to prevent them from being cut or crimped when
the parts are moved.

● When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the
wires.

● Some flat ribbon cables come prefolded. Never change the folds on these cables.

● Do not bend any cable sharply. A sharp bend can break the internal wires.

● Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

● Never crease a SATA data cable.

● Do not rely on components like the drive cage, power supply, or computer cover to push cables
down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cables from the P1 or P3 connectors on the system board,
always follow these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector (1).

2. Grasp the cable end of the connector and pull it straight up (2).

CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could
damage the cable and result in a failed power supply.
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Cable Connections
System board connectors are color-coded to make it easier to find the proper connection.

Connector Name Connector Color Description

PWR, P1 White Power supply, 6-pin

P2 White Power supply, 6-pin

PWRCPU, P3 White Power supply, 4-pin

PS STAT White Power supply, 6-pin

SATA PWR1, P160 Black Optical drive power connector, 4-pin

SATA PWR2, P161 Black Hard drive power connector, 4-pin

CHFAN, P9 Maroon Chassis fan

PB/LED, P5 Black Front power button/LED

CHFAN2, P11 Maroon 2nd chassis fan

FRNT_USB1, P24 Yellow Front I/O USB

FRNT_USB2, P25 Green Front I/O USB

FRONT AUD, P23 Blue Front audio

SPRK, P6 White Internal speaker

COMB, P52 Black Serial port

SATA0, P60 Dark blue 1st HDD

SATA1, P61 White 1st ODD or 2nd HDD if no HDD present

SATA2, P62 Light blue 2nd HDD if ODD present

SATA3, P63 Orange eSATA port or extra ODD/HDD
connector

PAR, P126 Black Parallel port

MEDIA, P150 Black Media reader
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Memory
The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3-
SDRAM) dual inline memory modules (DIMMs).

The memory sockets on the system board can be populated with up to four industry-standard DIMMs.
These memory sockets are populated with at least one preinstalled DIMM. To achieve the maximum
memory support, you can populate the system board with up to 16-GB of memory configured in a high-
performing dual channel mode.

For proper system operation, the DDR3-SDRAM DIMMs must be:

● industry-standard 240-pin

● unbuffered non-ECC PC3-8500 DDR3-1066 MHz-compliant or PC3-10600 DDR3-1333 MHz-
compliant

NOTE: 1333 MHz DIMMS will only run at a speed of 1066 MHz.

● 1.5 volt DDR3-SDRAM DIMMs

The DDR3-SDRAM DIMMs must also:

● support CAS latency 7 DDR3 1066 MHz (7-7-7 timing) and CAS latency 9 DDR3 1333 MHz (9-9-9
timing)

● contain the mandatory JEDEC SPD information

In addition, the computer supports:

● 512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies

● single-sided and double-sided DIMMs

● DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM are not
supported

NOTE: The system will not operate properly if you install unsupported DIMMs.

There are four DIMM sockets on the system board, with two sockets per channel. The sockets are
labeled DIMM1, DIMM2, DIMM3, and DIMM4. Sockets DIMM1 and DIMM2 operate in memory channel
A. Sockets DIMM3 and DIMM4 operate in memory channel B.
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Figure 8-5  DIMM Socket Locations

Table 8-1  DIMM Socket Locations

Item Description Socket Color

1 DIMM1 socket, Channel A (populate first) Black

2 DIMM2 socket, Channel A (populate third) White

3 DIMM3 socket, Channel B (populate second) White

4 DIMM4 socket, Channel B (populate fourth) White

NOTE: A DIMM must occupy the black DIMM1 socket. Otherwise, the system will
display a POST error message indicating that a memory module must be installed in the
wrong socket.

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the DIMMs are installed.

● The system will operate in single channel mode if the DIMM sockets are populated in one channel
only.

● The system will operate in a higher-performing dual channel mode if the total memory capacity of
the DIMMs in Channel A is equal to the total memory capacity of the DIMMs in Channel B. The
technology and device width can vary between the channels. For example, if Channel A is
populated with two 512-MB DIMMs and Channel B is populated with one 1-GB DIMM, the system
will operate in dual channel mode.

● The system will operate in flex mode if the total memory capacity of the DIMMs in Channel A is not
equal to the total memory capacity of the DIMMs in Channel B. In flex mode, the channel populated
with the least amount of memory describes the total amount of memory assigned to dual channel
and the remainder is assigned to single channel. For optimal speed, the channels should be
balanced so that the largest amount of memory is spread between the two channels. If one channel
will have more memory than the other, the larger amount should be assigned to Channel A. For
example, if you are populating the sockets with one 1-GB DIMM, and three 512-MB DIMMs,
Channel A should be populated with the 1-GB DIMM and one 512-MB DIMM, and Channel B should
be populated with the two 512-MB DIMMs. With this configuration, 2-GB will run as dual channel
and 512-MB will run as single channel.

● In any mode, the maximum operational speed is determined by the slowest DIMM in the system.
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CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power to
drain before adding or removing memory modules. Regardless of the power-on state, voltage is always
supplied to the memory modules as long as the computer is plugged into an active AC outlet. Adding
or removing memory modules while voltage is present may cause irreparable damage to the memory
modules or system board. If you see an LED light on the system board, voltage is still present.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or oxidation
resulting from having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 76).

2. Remove the computer access panel (Access Panel on page 77).

WARNING! To reduce risk of personal injury from hot surfaces, allow the internal system
components to cool before touching.
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3. Open both latches of the memory module socket (1), and insert the memory module into the
socket (2).

Figure 8-6  Installing a DIMM

NOTE: A memory module can be installed in only one way. Match the notch on the module with
the tab on the memory socket.

A DIMM must occupy the XMM4 socket. Always populate XMM4 before XMM2, and XMM3 before
XMM1 (populate the black sockets before white sockets in each channel).

A DIMM must occupy the black DIMM1 socket.

Populate the DIMM sockets in the following order: DIMM1, DIMM3, DIMM2, then DIMM4.

For maximum performance, populate the sockets so that the memory capacity is spread as equally
as possible between Channel A and Channel B. Refer to Populating DIMM Socketson page 127
for more information.

4. Push the module down into the socket, ensuring that the module is fully inserted and properly
seated. Make sure the latches are in the closed position (3).

5. Repeat steps 3 and 4 for any additional modules that you want to install.

NOTE: The computer automatically recognizes the additional memory when turned on.
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Expansion Cards
The computer has one PCI expansion slot, two PCI Express x1 expansion slots, and one PCI Express
x16 expansion slot.

Figure 8-7  Expansion Slot Locations

Table 8-2  Expansion Slot Locations

Item Description

1 PCI expansion slot

2 PCI Express x16 expansion slot

3 PCI Express x1 expansion slot

4 PCI Express x1 expansion slot

NOTE: You can install a PCI Express x1, x4, x8, or x16 expansion card in the PCI Express x16
expansion slot.

To remove, replace, or add an expansion card:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 76).

2. Remove the computer access panel (Access Panel on page 77).

3. Locate the correct vacant expansion socket on the system board and the corresponding expansion
slot on the back of the computer chassis.

86 Chapter 8   Removal and Replacement Procedures Microtower (MT) Chassis



4. Release the slot cover retention latch that secures the PCI slot covers by lifting the green tab on
the latch and rotating the latch to the open position.

Figure 8-8  Opening the Expansion Slot Retainer

5. Before installing an expansion card, remove the expansion slot cover or the existing expansion
card.

NOTE: Before removing an installed expansion card, disconnect any cables that may be attached
to the expansion card.

a. If you are installing an expansion card in a vacant socket, remove the appropriate expansion
slot cover on the back of the chassis. Pull the slot cover straight up then away from the inside
of the chassis.

Figure 8-9  Removing an Expansion Slot Cover
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b. If you are removing a standard PCI card or PCI Express x1 card, hold the card at each end,
and carefully rock it back and forth until the connectors pull free from the socket. Pull the
expansion card straight up from the socket then away from the inside of the chassis to release
it from the chassis frame. Be sure not to scrape the card against the other components.

Figure 8-10  Removing a Standard PCI Expansion Card

c. If you are removing a PCI Express x16 card, pull the retention arm on the back of the expansion
socket away from the card and carefully rock the card back and forth until the connectors pull
free from the socket. Pull the expansion card straight up from the socket then away from the
inside of the chassis to release it from the chassis frame. Be sure not to scrape the card against
the other components.

Figure 8-11  Removing a PCI Express x16 Expansion Card

6. Store the removed card in anti-static packaging.

88 Chapter 8   Removal and Replacement Procedures Microtower (MT) Chassis



7. If you are not installing a new expansion card, install an expansion slot cover to close the open
slot.

CAUTION: After removing an expansion card, you must replace it with a new card or expansion
slot cover for proper cooling of internal components during operation.

8. To install a new expansion card, hold the card just above the expansion socket on the system
board then move the card toward the rear of the chassis so that the bracket on the card is aligned
with the open slot on the rear of the chassis. Press the card straight down into the expansion socket
on the system board.

Figure 8-12  Installing an Expansion Card

NOTE: When installing an expansion card, press firmly on the card so that the whole connector
seats properly in the expansion card slot.

9. Rotate the slot cover retention latch back in place to secure the expansion card.

Figure 8-13  Closing the Expansion Slot Retainer
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10. Connect external cables to the installed card, if needed. Connect internal cables to the system
board, if needed.

11. Reconfigure the computer, if necessary. Refer to the Computer Setup (F10) Utility Guide for
instructions on using Computer Setup.

Installing and Removing Drives
When installing additional drives, follow these guidelines:

● The primary Serial ATA (SATA) hard drive must be connected to the dark blue primary SATA
connector on the system board labeled SATA0.

● Connect a SATA optical drive to the white SATA connector on the system board labeled SATA1.

● Connect devices in order of SATA0, SATA1, SATA2, then SATA3.

● Connect an eSATA adapter cable to the orange SATA3 connector.

NOTE: The eSATA adapter installs into one of the expansion slots on the rear of the computer.
You must configure the SATA3 connector to function as eSATA in the Computer Setup utility.
Select Storage > Storage Options > eSATA Port to reconfigure the SATA3 connector. Refer to
the Computer Setup (F10) Utility Guide for more information.

● Connect a media card reader USB cable to the USB connector on the system board labeled MEDIA.
If the media card reader has a 1394 port, connect the 1394 cable to the 1394 PCI card.

● The system does not support Parallel ATA (PATA) optical drives or PATA hard drives.

● You must install guide screws to ensure the drive will line up correctly in the drive cage and lock
in place. HP has provided extra guide screws for the external drive bays (four 6-32 isolation
mounting guide screws and eight M3 metric guide screws), installed on the side of the drive bays.
The 6-32 isolation mounting screws are required for a secondary hard drive. All other drives (except
the primary hard drive) use M3 metric screws. The HP-supplied metric screws are black and the
HP-supplied isolation mounting screws are silver and blue. If you are replacing the primary hard
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drive, you must remove the four silver and blue 6-32 isolation mounting guide screws from the old
hard drive and install them in the new hard drive.

Figure 8-14  Extra Guide Screw Locations

No. Guide Screw Device

1 Black M3 Metric Screws All Other Drives (except primary hard drive)

2 Silver and Blue 6-32 Isolation Mounting Screws Secondary Hard Drive

CAUTION: To prevent loss of work and damage to the computer or drive:

If you are inserting or removing a drive, shut down the operating system properly, turn off the computer,
and unplug the power cord. Do not remove a drive while the computer is on or in standby mode.

Before handling a drive, ensure that you are discharged of static electricity. While handling a drive, avoid
touching the connector.

Handle a drive carefully; do not drop it.

Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

If a drive must be mailed, place the drive in a bubble-pack mailer or other protective packaging and label
the package “Fragile: Handle With Care.”
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System Board Drive Connections
Refer to the following illustration and table to identify the system board drive connectors.

Figure 8-15  System Board Drive Connections

Table 8-3  System Board Drive Connections

No. System Board Connector System Board Label Color

1 SATA0 SATA0 dark blue

2 SATA1 SATA1 white

3 SATA2 SATA2 light blue

4 SATA3 SATA3 orange

5 Media Card Reader MEDIA black

NOTE: The orange SATA3 connector can be reconfigured as eSATA in the Computer Setup utility if
you are installing an eSATA adapter. Select Storage > Storage Options > eSATA Port to reconfigure
the SATA3 connector. Refer to the Computer Setup (F10) Utility Guide for more information.
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Removing an External 5.25-inch or 3.5-inch Drive
CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 76).

2. Remove the access panel (Access Panel on page 77).

3. Remove the front bezel (Front Bezel on page 78).

4. Disconnect the drive cables, as indicated in the following illustrations.

a. If you are removing a 5.25-inch optical drive, disconnect the power cable (1) and data
cable (2) from the back of the drive.

Figure 8-16  Disconnecting the Optical Drive Cables
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b. If you are removing a media card reader, disconnect the USB cable from the system board.
If the media card reader has a 1394 port, disconnect the 1394 cable from the PCI card.

Figure 8-17  Disconnecting the Media Card Reader USB Cable

Figure 8-18  Disconnecting the Media Card Reader 1394 Cable
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5. A latch drive bracket with release tabs secures the drives in the drive bay. Lift the release tab on
the latch drive bracket (1) for the drive you want to remove, then slide the drive from its drive
bay (2).

Figure 8-19  Removing the External Drives

6. Remove the four guide screws (two on each side) from the old drive. You will need these screws
to install a new drive.
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Installing an External 5.25-inch or 3.5-inch Drive
NOTE: The system does not support Parallel ATA (PATA) optical drives.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 76).

2. Remove the access panel (Access Panel on page 77).

3. Remove the front bezel (Front Bezel on page 78).

4. Install four M3 metric guide screws in the lower holes on each side of the drive. HP has provided
eight extra M3 metric guide screws on the front of the chassis, under the front bezel. The M3 metric
guide screws are black. Refer to Installing and Removing Drives on page 90 for an illustration of
the extra M3 metric guide screws location.

CAUTION: Use only 5-mm long screws as guide screws. Longer screws can damage the internal
components of the drive.

NOTE: When replacing the drive, transfer the four M3 metric guide screws from the old drive to
the new one.

Figure 8-20  Installing Guide Screws (Optical Drive Shown)

5. Slide the drive into the drive bay, making sure to align the guide screws with the guide slots, until
the drive snaps into place.

Figure 8-21  Sliding the External Drives into the Drive Cage
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6. Connect the power and data cables to the drive as indicated in the following illustrations.

a. If you are installing an optical drive, connect the power cable (1) and data cable (2) to the back
of the drive.

Figure 8-22  Connecting the Optical Drive Cables

CAUTION: Never crease or bend a SATA data cable tighter than a 30 mm (1.18 in) radius.
A sharp bend can break the internal wires.
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b. If you are installing a media card reader, connect the USB cable to the system board. If the
media card reader has a 1394 port, connect the 1394 cable to the PCI card.

Figure 8-23  Connecting the Media Card Reader USB Cable

Figure 8-24  Connecting the Media Card Reader 1394 Cable

7. If installing a new drive, connect the opposite end of the data cable to the appropriate system board
connector.

NOTE: If you are installing a new optical drive, connect the SATA cable to the next available
SATA system board connector in the following order: SATA1, SATA2, then SATA3.

Refer to System Board Drive Connectionson page 92 for an illustration of the system board drive
connectors.
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Removing an Internal 3.5-inch Hard Drive
NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so
that you can transfer the data to the new hard drive.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 76).

2. Remove the access panel (Access Panel on page 77).

3. Disconnect the power cable (1) and data cable (2) from the back of the hard drive.

Figure 8-25  Disconnecting the Hard Drive Cables

4. Release the drive by pulling the release tab away from the drive (1) and sliding the drive out of the
bay (2).

Figure 8-26  Removing a Hard Drive

5. Remove the four guide screws (two on each side) from the old drive. You will need these screws
to install a new drive.
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Installing an Internal 3.5-inch Hard Drive
NOTE: The system does not support Parallel ATA (PATA) hard drives.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 76).

2. Remove the access panel (Access Panel on page 77).

3. Install the four guide screws (two on each side) that were removed from the old drive into the new
drive. The screws help guide the drive into its proper position in the bay. Extra guide screws are
provided on the exterior of the hard drive bays.

Figure 8-27  Installing Hard Drive Guide Screws

NOTE: The hard drive uses 6-32 isolation mounting guide screws. Four extra guide screws are
installed on the exterior of the hard drive bays. The HP-supplied isolation mounting guide screws
are silver and blue. Refer to Installing and Removing Driveson page 90 for an illustration of the
extra 6-32 isolation mounting guide screws location.

If you are replacing a drive, transfer the guides screws from the old drive to the new one.

4. Slide the drive into the drive bay, making sure to align the guide screws with the guide slots, until
the drive snaps into place. The bottom bay is for the primary hard drive. The upper bay is for an
optional secondary hard drive.

Figure 8-28  Sliding a Hard Drive into the Drive Bay
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5. Connect the power cable (1) and data cable (2) to the back of the hard drive.

Figure 8-29  Connecting the Hard Drive Cables

CAUTION: Never crease or bend a SATA data cable tighter than a 30 mm (1.18 in) radius. A
sharp bend can break the internal wires.

6. If installing a new drive, connect the opposite end of the data cable to the appropriate system board
connector.

NOTE: If your system has only one SATA hard drive, you must connect the hard drive data cable
to the dark blue connector labeled SATA0 to avoid any hard drive performance problems. If you
are adding a second hard drive, connect the data cable to the next available (unpopulated) SATA
connector on the system board in the following order: SATA0, SATA1, SATA2, SATA3.

7. Route the power and data cables in their cable retainers.

Removing and Replacing a Removable 3.5-inch SATA Hard Drive
Some models are equipped with a Removable SATA Hard Drive Enclosure in the 5.25-inch external
drive bay. The hard drive is housed in a carrier that can be quickly and easily removed from the drive
bay. To remove and replace a drive in the carrier:

NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so
that you can transfer the data to the new hard drive.

1. Unlock the hard drive carrier with the key provided and slide the carrier out of the enclosure.
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2. Remove the screw from the rear of the carrier (1) and slide the top cover off the carrier (2).

Figure 8-30  Removing the Carrier Cover

3. Remove the adhesive strip that secures the thermal sensor to the top of the hard drive (1) and
move the thermal sensor away from the carrier (2).

Figure 8-31  Removing the Thermal Sensor
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4. Remove the four screws from the bottom of the hard drive carrier.

Figure 8-32  Removing the Security Screws

5. Slide the hard drive back to disconnect it from the carrier then lift it up and out of the carrier.

Figure 8-33  Removing the Hard Drive
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6. Place the new hard drive in the carrier then slide the hard drive back so that it seats in the SATA
connector on the carrier's circuit board. Be sure the connector on the hard drive is pressed all the
way into the connector on the carrier's circuit board.

Figure 8-34  Replacing the Hard Drive

7. Replace the four screws in the bottom of the carrier to hold the drive securely in place.

Figure 8-35  Replacing the Security Screws
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8. Place the thermal sensor on top of the hard drive in a position that does not cover the label (1) and
attach the thermal sensor to the top of the hard drive with the adhesive strip (2).

Figure 8-36  Replacing the Thermal Sensor

9. Slide the cover on the carrier (1) and replace the screw on the rear of the carrier to secure the cover
in place (2).

Figure 8-37  Replacing the Carrier Cover

10. Slide the hard drive carrier into the enclosure on the computer and lock it with the key provided.

NOTE: The carrier must be locked for power to be supplied to the hard drive.
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Fan/Baffle Assembly
1. Prepare the computer for disassembly (Preparation for Disassembly on page 76).

2. Remove the access panel (Access Panel on page 77).

3. Unplug the fan cable from the system board (CHFAN1, P9).

4. Press the lever that secures the assembly to the chassis (1), pivot the assembly forward toward
the front of the computer (2), and then lift the assembly straight up and out of the computer (3).

To reinstall the fan/baffle, reverse the removal procedure.
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Front I/O Assembly
1. Prepare the computer for disassembly (Preparation for Disassembly on page 76).

2. Remove the computer access panel (Access Panel on page 77).

3. Remove the front bezel (Front Bezel on page 78).

4. Remove the cables from the clip on top of the baffle.

5. Disconnect the three front I/O cables (yellow, green, and blue) from the system board connectors
(FRNT_USB1, FRNT_USB2, and FRNT_AUD).

6. Remove the silver T15 screw (1) that secures the assembly to the chassis.

7. Rotate the assembly to the right (2), and then lift the assembly away from the computer while
threading the wires through the hole in the front of the chassis.

To reinstall the panel, reverse the removal procedure.
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Power Switch/LED Assembly
1. Prepare the computer for disassembly (Preparation for Disassembly on page 76).

2. Remove the access panel (Access Panel on page 77).

3. Remove the front bezel (Front Bezel on page 78).

4. Disconnect the cable from the system board (P5, PB/LED).

5. With the computer on its side, press on the bottom of the assembly (1) and rotate upward (2) to
disengage it from the chassis.

6. Pull the assembly away from the chassis while threading the cable through the hole in front of the
chassis.

To reinstall the assembly, insert the tabs on the right side of the assembly into the slots in the chassis,
and then rotate the left side of the assembly down until it snaps into place.
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Heat sink
WARNING! To reduce risk of personal injury from hot surfaces, allow the internal system components
to cool before touching.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 76).

2. Remove the computer access panel (Access Panel on page 77).

3. Loosen the four silver T15 captive screws that secure the heat sink to the system board.

CAUTION: Heat sink retaining screws should be removed in diagonally opposite pairs (as in an
X) to even the downward forces on the processor. This is especially important as the pins on the
socket are very fragile and any damage to them may require replacing the system board.

4. Remove the heat sink from the processor.

When reinstalling the heat sink, make sure that its bottom has been cleaned with an alcohol wipe and
fresh thermal grease has been applied to the top of the processor.

CAUTION: Heat sink retaining screws should be tightened in diagonally opposite pairs (as in an X) to
evenly seat the heat sink on the processor. This is especially important as the pins on the socket are
very fragile and any damage to them may require replacing the system board.
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Processor
1. Prepare the computer for disassembly (Preparation for Disassembly on page 76).

2. Remove the access panel (Access Panel on page 77).

3. Remove the heat sink (Heat sink on page 109).

4. Rotate the locking lever to its full open position (1).

5. Raise and rotate the microprocessor retainer to its fully open position (2).

6. Carefully lift the processor from the socket (3).

CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

The heat sink must be installed within 24 hours of installing the processor to prevent damage to
the processor’s solder connections.

To install a new processor:

1. Place the processor in its socket and close the retainer.

2. Secure the locking lever.

If reusing the existing heat sink, go to step 3.

If using a new heat sink, go to step 5.

3. If reusing the existing heat sink, apply the thermal grease provided in the spares kit to the top of
the processor.

4. Clean the bottom of the heat sink with the provided alcohol pad and place it atop the processor.
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5. If using a new heat sink, remove the protective covering from the bottom of the heat sink and place
it in position atop the processor.

6. Secure the heat sink to the system board and system board tray with the four captive screws and
attach the heat sink control cable to the system board.

CAUTION: heat sink retaining screws should be tightened in diagonally opposite pairs (as in an
X) to evenly seat the heat sink on the processor. This is especially important as the pins on the
socket are very fragile and any damage to them may require replacing the system board.

NOTE: After installing a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system BIOS can
be found on the Web at: http://h18000.www1.hp.com/support/files.

Speaker
1. Prepare the computer for disassembly (Preparation for Disassembly on page 76).

2. Remove the access panel (Access Panel on page 77).

3. Remove the baffle (Fan/Baffle Assembly on page 106).

4. Disconnect the speaker wire from the system board (SPKR, P6).

5. From the inside of the chassis, remove the two silver T15 screws that secure the speaker to the
chassis.

6. Slide the speaker up and lift it out of the chassis.

To replace the speaker, reverse the removal procedures.

When replacing the speaker, be sure to route the cable through the hole in the left side of the processor
baffle.
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Rear Chassis Fan
1. Prepare the computer for disassembly (Preparation for Disassembly on page 76).

2. Remove the access panel (Access Panel on page 77).

3. Disconnect the fan control cable from the system board (CHFAN2).

4. Remove the four silver Phillips screws that secure the fan to the chassis.

5. Lift the fan out of the chassis.

To install the fan assembly, reverse the removal procedure. Be sure to orient the air flow out of the unit.
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Power Supply
1. Prepare the computer for disassembly (Preparation for Disassembly on page 76).

2. Remove the access panel (Access Panel on page 77).

3. Disconnect all power cables from the drives and from the system board.

4. Remove the four silver T15 screws that connect the power supply to the chassis.

5. Press the tab on the base pan in front of the power supply that holds it in place.

6. Slide the power supply toward the front of the computer, rotate toward the fan so the power supply
clears the lip on the top of the chassis, and then lift the power supply out of the chassis.

To install the power supply, reverse the removal procedure.
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System Board
1. Prepare the computer for disassembly (Preparation for Disassembly on page 76).

2. Remove the access panel (Access Panel on page 77).

3. Remove all expansion boards (Expansion Cards on page 86).

4. Disconnect all cables connected to the system board, noting their location for reinstallation.

5. Remove the heat sink (Heat sink on page 109).

6. Remove the eight screws that secure the system board to the chassis.

7. Slide the system board toward the front of the computer to disengage the I/O panel from the rear
of the chassis.

8. Lift the system board out of the computer.

When reinstalling the system board, first insert the I/O panel back into the slots in the rear of the chassis,
and then align the board with the chassis screw holes.

NOTE: When replacing the system board, you must change the chassis serial number in the BIOS.

114 Chapter 8   Removal and Replacement Procedures Microtower (MT) Chassis



Battery
The battery that comes with the computer provides power to the real-time clock. When replacing the
battery, use a battery equivalent to the battery originally installed in the computer. The computer comes
with a 3-volt lithium coin cell battery.

WARNING! The computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.

Do not expose to temperatures higher than 60°C (140ºF).

Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.

Replace the battery only with the HP spare designated for this product.

CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When
the battery is removed or replaced, the CMOS settings will be cleared. Refer to the Computer Setup
(F10) Utility Guide for information on backing up the CMOS settings.

Static electricity can damage the electronic components of the computer or optional equipment. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall
socket. The lithium battery is only used when the computer is NOT connected to AC power.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, go to http://www.hp.com/
recycle.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 76).

2. Remove the computer access panel (Access Panel on page 77).

NOTE: It may be necessary to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

4. Depending on the type of battery holder on your system board, complete the following instructions
to replace the battery:

Battery 115



Type 1 Battery Holder
1. Lift the battery out of its holder.

2. Slide the replacement battery into position, positive side up.

3. The battery holder automatically secures the battery in the proper position.

4. Replace the computer access panel.

5. Plug in the computer and turn on power to the computer.

6. Reset the date and time and any special system setups using Computer Setup. Refer to the
Computer Setup (F10) Utility Guide.

Type 2 Battery Holder
1. To release the battery from its holder, squeeze the metal clamp (1) that extends above one edge

of the battery. When the battery pops up, lift it out.

2. To insert the new battery, slide one edge of the replacement battery under the holder’s lip with the
positive side up (2). Push the other edge down until the clamp snaps over the other edge of the
battery.

3. Replace the computer access panel.
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4. Plug in the computer and turn on power to the computer.

5. Reset the date and time and any special system setups using Computer Setup. Refer to the
Computer Setup (F10) Utility Guide.

Type 3 Battery Holder
1. Pull back on the clip (1) that holds the battery in place, then remove the battery (2).

2. Insert the new battery and position the clip back in place.

3. Replace the computer access panel.

4. Plug in the computer and turn on power to the computer.

5. Reset the date and time and any special system setups using Computer Setup. Refer to the
Computer Setup (F10) Utility Guide.
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External Security Devices
The following security devices are used to prevent unauthorized access to the internal components of
the computer and/or secure the computer to a fixed object.

Cable Lock
Figure 8-38  Installing a Cable Lock

Padlock
Figure 8-39  Installing a Padlock
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HP Business PC Security Lock
1. Fasten the security cable by looping it around a stationary object.

Figure 8-40  Securing the Cable to a Fixed Object

2. Thread the keyboard and mouse cables through the lock.

Figure 8-41  Threading the Keyboard and Mouse Cables
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3. Screw the lock to the chassis using the screw provided.

Figure 8-42  Attaching the Lock to the Chassis

4. Insert the plug end of the security cable into the lock (1) and push the button in (2) to engage the
lock. Use the key provided to disengage the lock.

Figure 8-43  Engaging the Lock

Front Bezel Security
The front bezel can be locked in place by installing a security screw provided by HP. To install the
security screw:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 76).

2. Remove the access panel (Access Panel on page 77).

3. Remove the front bezel (Front Bezel on page 78).
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4. Remove the security screw from the inside of the front bezel.

Figure 8-44  Retrieving the Front Bezel Security Screw

5. Replace the front bezel.

6. Install the screw through the interior of the front of the chassis into the front bezel. The screw hole
is located toward the middle of the right edge of the chassis between the hard drive bay and
speaker.

Figure 8-45  Installing the Front Bezel Security Screw
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9 Removal and Replacement Procedures
Small Form Factor (SFF) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper service.
After completing all necessary removal and replacement procedures, run the Diagnostics utility to verify
that all components operate properly.

NOTE: Not all features listed in this guide are available on all computers.

Preparation for Disassembly
See Identifying the Chassis, Routine Care, and Disassembly Preparation on page 67 for initial safety
procedures.

1. Remove/disengage any security devices that prohibit opening the computer (External Security
Devices on page 169).

2. Close any open software applications.

3. Exit the operating system.

4. Remove any diskette, compact disc. or media card from the computer.

5. Turn off the computer and any peripheral devices that are connected to it.

CAUTION: Turn off the computer before disconnecting any cables.

Regardless of the power-on state, voltage is always present on the system board as long as the
system is plugged into an active AC outlet. In some systems the cooling fan is on even when the
computer is in the “Standby,” or “Suspend” modes. The power cord should always be disconnected
before servicing a unit.

6. Disconnect the power cord from the electrical outlet and then from the computer.

7. If the computer is on a stand, remove the computer from the stand.

8. Disconnect all peripheral device cables from the computer.

NOTE: During disassembly, label each cable as you remove it, noting its position and routing.
Keep all screws with the units removed.

CAUTION: The screws used in the computer are of different thread sizes and lengths; using the
wrong screw in an application may damage the unit.
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Access Panel
1. Prepare the computer for disassembly (Preparation for Disassembly on page 122).

2. Lift up on the access panel handle (1) then lift the access panel off the computer (2).

Figure 9-1  Removing the Access Panel

To install the access panel, reverse the removal procedure.
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Front Bezel
1. Prepare the computer for disassembly (Preparation for Disassembly on page 122).

2. Remove the access panel (Access Panel on page 123).

3. Lift up the three tabs on the side of the bezel (1), then rotate the bezel off the chassis (2).

Figure 9-2  Removing the Front Bezel

To install the front bezel, reverse the removal procedure.
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Bezel Blanks
On some models, there are bezel blanks covering the 3.5-inch and 5.25-inch external drive bays that
need to be removed before installing a drive. To remove a bezel blank:

1. Remove the access panel (Access Panel on page 123).

2. Remove the front bezel (Front Bezel on page 124)..

3. To remove a bezel blank, push the two retaining tabs that hold the bezel blank in place towards
the outer right edge of the bezel (1) and slide the bezel blank back and to the right to remove it
(2).

Figure 9-3  Removing a Bezel Blank
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Installing Additional Memory
The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3-
SDRAM) dual inline memory modules (DIMMs).

DIMMs
The memory sockets on the system board can be populated with up to four industry-standard DIMMs.
These memory sockets are populated with at least one preinstalled DIMM. To achieve the maximum
memory support, you can populate the system board with up to 16-GB of memory configured in a high-
performing dual channel mode.

DDR3-SDRAM DIMMs
For proper system operation, the DDR3-SDRAM DIMMs must be:

● industry-standard 240-pin

● unbuffered non-ECC PC3-8500 DDR3-1066 MHz-compliant or PC3-10600 DDR3-1333 MHz-
compliant

NOTE: 1333 MHz DIMMS will only run at a speed of 1066 MHz.

● 1.5 volt DDR3-SDRAM DIMMs

The DDR3-SDRAM DIMMs must also:

● support CAS latency 7 DDR3 1066 MHz (7-7-7 timing) and CAS latency 9 DDR3 1333 MHz (9-9-9
timing)

● contain the mandatory JEDEC SPD information

In addition, the computer supports:

● 512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies

● single-sided and double-sided DIMMs

● DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM are not
supported

NOTE: The system will not operate properly if you install unsupported DIMMs.
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Populating DIMM Sockets
There are four DIMM sockets on the system board, with two sockets per channel. The sockets are
labeled DIMM1, DIMM2, DIMM3, and DIMM4. Sockets DIMM1 and DIMM2 operate in memory channel
A. Sockets DIMM3 and DIMM4 operate in memory channel B.

Figure 9-4  DIMM Socket Locations

Table 9-1  DIMM Socket Locations

Item Description Socket Color

1 DIMM1 socket, Channel A (populate first) Black

2 DIMM2 socket, Channel A (populate third) White

3 DIMM3 socket, Channel B (populate second) White

4 DIMM4 socket, Channel B (populate fourth) White

NOTE: A DIMM must occupy the black DIMM1 socket. Otherwise, the system will
display a POST error message indicating that a memory module must be installed in the
wrong socket.

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the DIMMs are installed.

● The system will operate in single channel mode if the DIMM sockets are populated in one channel
only.

● The system will operate in a higher-performing dual channel mode if the total memory capacity of
the DIMMs in Channel A is equal to the total memory capacity of the DIMMs in Channel B. The
technology and device width can vary between the channels. For example, if Channel A is
populated with two 512-MB DIMMs and Channel B is populated with one 1-GB DIMM, the system
will operate in dual channel mode.

● The system will operate in flex mode if the total memory capacity of the DIMMs in Channel A is not
equal to the total memory capacity of the DIMMs in Channel B. In flex mode, the channel populated
with the least amount of memory describes the total amount of memory assigned to dual channel
and the remainder is assigned to single channel. For optimal speed, the channels should be
balanced so that the largest amount of memory is spread between the two channels. If one channel
will have more memory than the other, the larger amount should be assigned to Channel A. For
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example, if you are populating the sockets with one 1-GB DIMM, and three 512-MB DIMMs,
Channel A should be populated with the 1-GB DIMM and one 512-MB DIMM, and Channel B should
be populated with the two 512-MB DIMMs. With this configuration, 2-GB will run as dual channel
and 512-MB will run as single channel.

● In any mode, the maximum operational speed is determined by the slowest DIMM in the system.

Installing DIMMs
CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power to
drain before adding or removing memory modules. Regardless of the power-on state, voltage is always
supplied to the memory modules as long as the computer is plugged into an active AC outlet. Adding
or removing memory modules while voltage is present may cause irreparable damage to the memory
modules or system board. If you see an LED light on the system board, voltage is still present.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or oxidation
resulting from having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 122).

2. Remove the access panel (Access Panel on page 123).

3. Rotate up the external drive bay housing to access the memory module sockets on the system
board.

Figure 9-5  Rotating the Drive Cage Up
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4. Open both latches of the memory module socket (1), and insert the memory module into the
socket (2).

Figure 9-6  Installing a DIMM

NOTE: A memory module can be installed in only one way. Match the notch on the module with
the tab on the memory socket.

A DIMM must occupy the black DIMM1 socket.

Populate the DIMM sockets in the following order: DIMM1, DIMM3, DIMM2, then DIMM4.

For maximum performance, populate the sockets so that the memory capacity is spread as equally
as possible between Channel A and Channel B. Refer to Populating DIMM Socketson page 127
for more information.

5. Push the module down into the socket, ensuring that the module is fully inserted and properly
seated. Make sure the latches are in the closed position (3).

6. Repeat steps 5 and 6 to install any additional modules.

The computer should automatically recognize the additional memory the next time you turn on the
computer.
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Expansion Cards
The computer has one PCI expansion slot, two PCI Express x1 expansion slots, and one PCI Express
x16 expansion slot.

NOTE: The PCI and PCI Express slots support only low profile cards.

Figure 9-7  Expansion Slot Locations

Table 9-2  Expansion Slot Locations

Item Description

1 PCI expansion slot

2 PCI Express x16 expansion slot

3 PCI Express x1 expansion slot

4 PCI Express x1 expansion slot

NOTE: You can install a PCI Express x1, x4, x8, or x16 expansion card in the PCI Express x16 slot.

To install an expansion card:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 122).

2. Remove the access panel (Access Panel on page 123).

3. Locate the correct vacant expansion socket on the system board and the corresponding expansion
slot on the back of the computer chassis.
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4. Release the slot cover retention latch that secures the PCI slot covers by lifting the green tab on
the latch and rotating the latch to the open position.

Figure 9-8  Opening the Expansion Slot Retainer

5. Before installing an expansion card, remove the expansion slot cover or the existing expansion
card.

a. If you are installing an expansion card in a vacant socket, remove the appropriate expansion
slot cover on the back of the chassis. Pull the slot cover straight up then away from the inside
of the chassis.

Figure 9-9  Removing an Expansion Slot Cover
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b. If you are removing a standard PCI card or PCI Express x1 card, hold the card at each end,
and carefully rock it back and forth until the connectors pull free from the socket. Pull the
expansion card straight up from the socket then away from the inside of the chassis to release
it from the chassis frame. Be sure not to scrape the card against the other components.

NOTE: Before removing an installed expansion card, disconnect any cables that may be
attached to the expansion card.

Figure 9-10  Removing a Standard PCI Expansion Card

c. If you are removing a PCI Express x16 card, pull the retention arm on the back of the expansion
socket away from the card and carefully rock the card back and forth until the connectors pull
free from the socket. Pull the expansion card straight up from the socket then away from the
inside of the chassis to release it from the chassis frame. Be sure not to scrape the card against
the other components.

Figure 9-11  Removing a PCI Express x16 Expansion Card
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6. Store the removed card in anti-static packaging.

7. If you are not installing a new expansion card, install an expansion slot cover to close the open
slot.

CAUTION: After removing an expansion card, you must replace it with a new card or expansion
slot cover for proper cooling of internal components during operation.

8. To install a new expansion card, hold the card just above the expansion socket on the system
board then move the card toward the rear of the chassis so that the bracket on the card is aligned
with the open slot on the rear of the chassis. Press the card straight down into the expansion socket
on the system board.

Figure 9-12  Installing an Expansion Card

NOTE: When installing an expansion card, press firmly on the card so that the whole connector
seats properly in the expansion card slot.
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9. Rotate the slot cover retention latch back in place to secure the expansion card.

Figure 9-13  Closing the Expansion Slot Retainer

10. Connect external cables to the installed card, if needed. Connect internal cables to the system
board, if needed.

11. Reconfigure the computer, if necessary. Refer to the Computer Setup (F10) Utility Guide for
instructions on using Computer Setup.
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Cable Management
The Small Form Factor chassis is a very compact computer and proper routing of the internal cables is
critical to the operation of the computer. Follow good cable management practices when working inside
the computer.

● Keep cables away from major heat sources like the heat sink.

● Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these
are not designed to take excessive pressure on them.

● Keep cables clear of movable or rotating parts like the power supply and drive cage to prevent
them from being cut or crimped when the component is lowered into its normal position.

● When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the
wires.

● Some flat ribbon cables come prefolded. Never change the folds on these cables.

● Do not bend any cable sharply. A sharp bend can break the internal wires.

● Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

● Never crease a SATA data cable.

● Do not rely on components like the drive cage, power supply, or computer cover to push cables
down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cables from the P1 connector on the system board, always
follow these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector (1).

2. Grasp the cable end of the connector and pull it straight up (2).

CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could
damage the cable and result in a failed power supply.

Figure 9-14  Removing a power supply cable from its connector
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Cable Connections
System board connectors are color-coded to make it easier to find the proper connection.

Connector Name Connector Color Description

PWR, P1 White Power supply, 6-pin

P2 White Power supply, 6-pin

PWRCPU, P3 White Power supply, 4-pin

PS STAT White Power supply, 6-pin

SATA PWR1, P160 Black Optical drive power connector, 4-pin

SATA PWR2, P161 Black Hard drive power connector, 4-pin

CHFAN, P9 Maroon Chassis fan

PB/LED, P5 Black Front power button/LED

CHFAN2, P11 Maroon 2nd chassis fan

FRNT_USB1, P24 Yellow Front I/O USB

FRNT_USB2, P25 Green Front I/O USB

FRONT AUD, P23 Blue Front audio

SPRK, P6 White Internal speaker

COMB, P52 Black Serial port

SATA0, P60 Dark blue 1st HDD

SATA1, P61 White 1st ODD or 2nd HDD if no HDD present

SATA2, P62 Light blue 2nd HDD if ODD present

SATA3, P63 Orange eSATA port or extra ODD/HDD
connector

PAR, P126 Black Parallel port

MEDIA, P150 Black Media reader

136 Chapter 9   Removal and Replacement Procedures Small Form Factor (SFF) Chassis



Drive Positions
Figure 9-15  Drive Positions

Table 9-3  Drive Positions

1 3.5-inch internal hard drive bay

2 3.5-inch external drive bay for optional drives (media card reader shown)

3 5.25-inch external drive bay for optional drives (optical drive shown)

NOTE: The drive configuration on your computer may be different than the drive
configuration shown above.

To verify the type, size, and capacity of the storage devices installed in the computer, run Computer
Setup. Refer to the Computer Setup (F10) Utility Guide for more information.
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Installing and Removing Drives
When installing additional drives, follow these guidelines:

● The primary Serial ATA (SATA) hard drive must be connected to the dark blue primary SATA
connector on the system board labeled SATA0.

● Connect a SATA optical drive to the white SATA connector on the system board labeled SATA1.

● Connect devices in order of SATA0, SATA1, SATA2, then SATA3

● Connect an eSATA adapter cable to the orange SATA3 connector.

NOTE: The eSATA adapter installs into one of the expansion slots on the rear of the computer.
You must configure the SATA3 connector to function as eSATA in the Computer Setup utility.
Select Storage > Storage Options > eSATA Port to reconfigure the SATA3 connector. Refer to
the Computer Setup (F10) Utility Guide for more information.

● Connect a media card reader USB cable to the USB connector on the system board labeled MEDIA.
If the media card reader has a 1394 port, connect the 1394 cable to the 1394 PCI card.

● The system does not support Parallel ATA (PATA) optical drives or PATA hard drives.

● You must install guide screws to ensure the drive will line up correctly in the drive cage and lock
in place. HP has provided extra guide screws for the external drive bays (five 6-32 standard screws
and four M3 metric screws), installed in the front of the chassis, under the front bezel. The 6-32
standard screws are required for a secondary hard drive. All other drives (except the primary hard
drive) use M3 metric screws. The HP-supplied metric screws are black and the HP-supplied
standard screws are silver. If you are replacing the primary hard drive, you must remove the four
silver and blue 6-32 isolation mounting guide screws from the old hard drive and install them in the
new hard drive.

Figure 9-16  Extra Guide Screw Locations

No. Guide Screw Device

1 Black M3 Metric Screws All Other Drives (except primary hard drive)

2 Silver 6-32 Standard Screws Secondary Hard Drive

There are at total of five extra silver 6-32 standard screws. Four are used as guide screws for a secondary
hard drive. The fifth is used for bezel security (see Front Bezel Security on page 120 for more information).
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CAUTION: To prevent loss of work and damage to the computer or drive:

If you are inserting or removing a drive, shut down the operating system properly, turn off the computer,
and unplug the power cord. Do not remove a drive while the computer is on or in standby mode.

Before handling a drive, ensure that you are discharged of static electricity. While handling a drive, avoid
touching the connector.

Handle a drive carefully; do not drop it.

Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

If a drive must be mailed, place the drive in a bubble-pack mailer or other protective packaging and label
the package “Fragile: Handle With Care.”
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System Board Drive Connections
Refer to the following illustration and table to identify the system board drive connectors.

Figure 9-17  System Board Drive Connections

Table 9-4  System Board Drive Connections

No. System Board Connector System Board Label Color

1 SATA0 SATA0 dark blue

2 SATA1 SATA1 white

3 SATA2 SATA2 light blue

4 SATA3 SATA3 orange

5 Media Card Reader MEDIA black

NOTE: The orange SATA3 connector can be reconfigured as eSATA in the Computer Setup utility if
you are installing an eSATA adapter. Select Storage > Storage Options > eSATA Port to reconfigure
the SATA3 connector. Refer to the Computer Setup (F10) Utility Guide for more information.
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Removing an External 5.25-inch Drive
CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.

To remove a 5.25-inch external drive:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 122).

2. Remove the access panel (Access Panel on page 123).

3. Remove the front bezel (Bezel Blanks on page 125).

4. Rotate the drive cage to its upright position.

Figure 9-18  Rotating the Drive Cage Up

5. If removing an optical drive, disconnect the power cable (1) and data cable (2) from the rear of the
optical drive.

Figure 9-19  Disconnecting the Power and Data Cables
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6. Rotate the drive cage back down to its normal position.

CAUTION: Be careful not to pinch any cables or wires when rotating the drive cage down.

Figure 9-20  Rotating the Drive Cage Down

7. Press down on the green drive retainer button located on the left side of the drive to disengage the
drive from the drive cage (1). While pressing the drive retainer button, slide the drive back until it
stops, then lift it up and out of the drive cage (2).

Figure 9-21  Removing the 5.25-inch Drive

NOTE: To replace the drive, reverse the removal procedure. When replacing a drive, transfer the four
guide screws from the old drive to the new one.

Installing an Optical Drive into the 5.25-inch Drive Bay
To install an optional 5.25-inch optical drive:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 122).

2. Remove the access panel (Access Panel on page 123).

3. If you are installing a drive in a bay covered by a bezel blank, remove the front bezel then remove
the bezel blank. See Bezel Blanks on page 125 for more information.
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4. Install four M3 metric guide screws in the lower holes on each side of the drive. HP has provided
four extra M3 metric guide screws on the front of the chassis, under the front bezel. The M3 metric
guide screws are black. Refer to Installing and Removing Drives on page 138 for an illustration of
the extra M3 metric guide screws location.

CAUTION: Use only 5-mm long screws as guide screws. Longer screws can damage the internal
components of the drive.

NOTE: When replacing the drive, transfer the four M3 metric guide screws from the old drive to
the new one.

Figure 9-22  Installing Guide Screws in the Optical Drive

5. Position the guide screws on the drive into the J-slots in the drive bay. Then slide the drive toward
the front of the computer until it locks into place.

Figure 9-23  Installing the Optical Drive
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6. Rotate the drive cage to its upright position.

Figure 9-24  Rotating the Drive Cage Up

7. Connect the SATA data cable to the white system board connector labeled SATA1.

8. Route the data cable through the cable guides.

CAUTION: There are two cable guides that keep the data cable from being pinched by the drive
cage when raising or lowering it. One is located on the bottom side of the drive cage. The other is
located on the chassis frame under the drive cage. Ensure that the data cable is routed through
these guides before connecting it to the optical drive.

9. Connect the power cable (1) and data cable (2) to the rear of the optical drive.

Figure 9-25  Connecting the Power and Data Cables
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10. Rotate the drive cage back down to its normal position.

CAUTION: Be careful not to pinch any cables or wires when rotating the drive cage down.

Figure 9-26  Rotating the Drive Cage Down

The system automatically recognizes the drive and reconfigures the computer.

Removing an External 3.5-inch Drive
CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.

The 3.5-inch drive is located underneath the 5.25-inch drive. You must remove the external 5.25-inch
drive before removing the external 3.5-inch drive.

1. Follow the procedure in Removing an External 5.25-inch Drive on page 141 to remove the 5.25-
inch drive and access the 3.5-inch drive.

CAUTION: Ensure that the computer is turned off and that the power cord is disconnected from
the electrical outlet before proceeding.
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2. Disconnect the drive cables from the rear of the drive, or, if you are removing a media card reader,
disconnect the USB and 1394 cables from the system board as indicated in the following
illustrations.

NOTE: On some models, the media card reader does not include a 1394 port or cable.

Figure 9-27  Disconnecting the Media Card Reader USB Cable

Figure 9-28  Disconnecting the Media Card Reader 1394 Cable
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3. Press down on the green drive retainer button located on the left side of the drive to disengage the
drive from the drive cage (1). While pressing the drive retainer button, slide the drive back until it
stops, then lift it up and out of the drive cage (2).

Figure 9-29  Removing a 3.5-inch Drive (Media Card Reader Shown)

NOTE: To replace the 3.5-inch drive, reverse the removal procedure.

When replacing a 3.5-inch drive, transfer the four guide screws from the old drive to the new one.

Installing a Drive into the 3.5-inch External Drive Bay
The 3.5-inch bay is located underneath the 5.25-inch drive. To install a drive into the 3.5-inch bay:

NOTE: Install guide screws to ensure the drive will line up correctly in the drive cage and lock in place.
HP has provided extra guide screws for the external drive bays (four 6-32 standard screws and four M3
metric screws), installed in the front of the chassis, under the front bezel. A secondary hard drive uses
6-32 standard screws. All other drives (except the primary hard drive) use M3 metric screws. The HP-
supplied M3 metric screws are black and the HP-supplied 6-32 standard screws are silver. Refer to
Installing and Removing Driveson page 138 for illustrations of the guide screw locations.

1. Follow the procedure in Removing an External 5.25-inch Drive on page 141 to remove the 5.25-
inch drive and access the 3.5-inch drive bay.

CAUTION: Ensure that the computer is turned off and that the power cord is disconnected from
the electrical outlet before proceeding.

2. If you are installing a drive in a bay covered by a bezel blank, remove the front bezel then remove
the bezel blank. See Bezel Blanks on page 125 for more information.

Installing and Removing Drives 147



3. Position the guide screws on the drive into the J-slots in the drive bay. Then slide the drive toward
the front of the computer until it locks into place.

Figure 9-30  Installing a Drive into the 3.5-inch Drive Bay (Media Card Reader Shown)

4. Connect the appropriate drive cables:

a. If installing a second hard drive, connect the power and data cables to the rear of the drive
and connect the other end of the data cable to the next available (unpopulated) SATA
connector on the system board by following the numbered sequence of the connectors.

b. If installing a media card reader, connect the USB cable from the media card reader to the
USB connector on the system board labeled MEDIA. If the media card reader includes a 1394
port, connect the 1394 cable to the 1394 PCI card.

NOTE: Refer to System Board Drive Connectionson page 140 for an illustration of the
system board drive connectors.

5. Replace the 5.25-inch drive.
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Removing and Replacing the Primary 3.5-inch Internal SATA Hard Drive
NOTE: The system does not support Parallel ATA (PATA) hard drives.

Before you remove the old hard drive, be sure to back up the data from the old hard drive so that you
can transfer the data to the new hard drive.

The preinstalled 3.5-inch hard drive is located under the power supply. To remove and replace the hard
drive:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 122).

2. Remove the access panel (Access Panel on page 123).

3. Rotate the drive cage for external drives to its upright position.

Figure 9-31  Rotating the Drive Cage Up
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4. Rotate the power supply to its upright position. The hard drive is located beneath the power supply.

Figure 9-32  Raising the Power Supply

5. Disconnect the power cable (1) and data cable (2) from the back of the hard drive.

Figure 9-33  Disconnecting the Hard Drive Power Cable and Data Cable
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6. Press down on the green release latch next to the hard drive (1). While holding the latch down,
slide the drive forward until it stops, then lift the drive up and out of the bay (2).

Figure 9-34  Removing the Hard Drive

7. To install a hard drive, you must transfer the silver and blue isolation mounting guide screws from
the old hard drive to the new hard drive.

Figure 9-35  Installing Hard Drive Guide Screws
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8. Align the guide screws with the slots on the chassis drive cage, press the hard drive down into the
bay, then slide it back until it stops and locks in place.

Figure 9-36  Installing the Hard Drive

9. Connect the power and data cables to the back of the hard drive.

NOTE: When replacing the primary hard drive, be sure to route the SATA and power cables
through the cable guide on the bottom of the chassis frame behind the hard drive.

If the system has only one SATA hard drive, the data cable must be connected to the dark blue
connector labeled SATA0 on the system board to avoid any hard drive performance problems. If
you are adding a second hard drive, connect the other end of the data cable to the next available
(unpopulated) SATA connector on the system board in the following order: SATA0, SATA1, SATA2,
SATA3.

10. Rotate the drive cage for external drives and the power supply down to their normal positions.

152 Chapter 9   Removal and Replacement Procedures Small Form Factor (SFF) Chassis



Removing and Replacing a Removable 3.5-inch SATA Hard Drive
Some models are equipped with a Removable SATA Hard Drive Enclosure in the 5.25-inch external
drive bay. The hard drive is housed in a carrier that can be quickly and easily removed from the drive
bay. To remove and replace a drive in the carrier:

NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so
that you can transfer the data to the new hard drive.

1. Unlock the hard drive carrier with the key provided and slide the carrier out of the enclosure.

2. Remove the screw from the rear of the carrier (1) and slide the top cover off the carrier (2).

Figure 9-37  Removing the Carrier Cover

3. Remove the adhesive strip that secures the thermal sensor to the top of the hard drive (1) and
move the thermal sensor away from the carrier (2).

Figure 9-38  Removing the Thermal Sensor

Installing and Removing Drives 153



4. Remove the four screws from the bottom of the hard drive carrier.

Figure 9-39  Removing the Security Screws

5. Slide the hard drive back to disconnect it from the carrier then lift it up and out of the carrier.

Figure 9-40  Removing the Hard Drive
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6. Place the new hard drive in the carrier then slide the hard drive back so that it seats in the SATA
connector on the carrier's circuit board. Be sure the connector on the hard drive is pressed all the
way into the connector on the carrier's circuit board.

Figure 9-41  Replacing the Hard Drive

7. Replace the four screws in the bottom of the carrier to hold the drive securely in place.

Figure 9-42  Replacing the Security Screws
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8. Place the thermal sensor on top of the hard drive in a position that does not cover the label (1) and
attach the thermal sensor to the top of the hard drive with the adhesive strip (2).

Figure 9-43  Replacing the Thermal Sensor

9. Slide the cover on the carrier (1) and replace the screw on the rear of the carrier to secure the cover
in place (2).

Figure 9-44  Replacing the Carrier Cover

10. Slide the hard drive carrier into the enclosure on the computer and lock it with the key provided.

NOTE: The carrier must be locked for power to be supplied to the hard drive.
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Baffle
1. Prepare the computer for disassembly (Preparation for Disassembly on page 122).

2. Remove the access panel (Access Panel on page 123).

3. Remove the cable from the arm that extends from the side of the baffle (1).

4. Lift the baffle straight up out of the chassis (2).

Figure 9-45  Removing the baffle

To install the baffle, reverse the removal procedure.
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Front Fan Assembly
1. Prepare the computer for disassembly (Preparation for Disassembly on page 122).

2. Remove the access panel (Access Panel on page 123).

3. Remove the front bezel (Front Bezel on page 124).

4. Remove the baffle (Baffle on page 157).

5. Disconnect the fan cable from the system board (CH FAN1, P9).

6. On the front of the computer, press the left and bottom tabs to disengage the fan assembly from
the chassis.

Figure 9-46  Removing the chassis fan

7. Lift the assembly out of the chassis.

To install the chassis fan, reverse the removal procedure. Be sure to orient the air flow into the unit.
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Front I/O and Power Switch Assembly
1. Prepare the computer for disassembly (Preparation for Disassembly on page 122).

2. Remove the access panel (Access Panel on page 123).

3. Remove the front bezel (Front Bezel on page 124).

4. Remove the front fan assembly (Front Fan Assembly on page 158).

5. Remove the black T15 screw (1) that secures the assembly to the chassis.

Figure 9-47  Removing the front I/O device/power switch

6. Rotate the drive cage to its upright position.

7. Disconnect the cables (2) from the system board.

Figure 9-48  Disconnecting the cables from the system board
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8. While holding the body of the assembly, pull the assembly away from the front of the chassis while
guiding the cables through the hole in the drive cage (3).

Figure 9-49  Guiding the wires through the drive cage

9. Remove the assembly from the chassis.

To reinstall the front I/O/power supply assembly, reverse the removal procedure.
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Speaker
1. Prepare the computer for disassembly (Preparation for Disassembly on page 122).

2. Remove the access panel (Access Panel on page 123).

3. Remove the front bezel (Front Bezel on page 124).

4. Rotate the drive cage to its upright position.

5. Disconnect the speaker wire from the system board (SPKR, P5).

6. Remove the two black T15 screws that secure the speaker to the chassis.

Figure 9-50  Removing the speaker

7. Lift the speaker from the inside of the chassis to remove it.

To install the speaker, reverse the removal procedures.
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Heat sink
1. Prepare the computer for disassembly (Preparation for Disassembly on page 122).

2. Remove the access panel (Access Panel on page 123).

3. Remove the baffle (Baffle on page 157).

4. Remove the front fan assembly (Front Fan Assembly on page 158).

5. Loosen the four captive screws that secure the heat sink to the system board tray.

CAUTION: Heat sink retaining screws should be removed in diagonally opposite pairs (as in an
X) to even the downward forces on the processor. This is especially important as the pins on the
socket are very fragile and any damage to them may require replacing the system board.

6. Lift the heat sink from atop the processor and set it on its side to keep from contaminating the work
area with thermal grease.

Figure 9-51  Removing the heat sink

When reinstalling the heat sink, make sure that its bottom has been cleaned with an alcohol wipe and
fresh thermal grease has been applied to the top of the processor.

CAUTION: Heat sink retaining screws should be tightened in diagonally opposite pairs (as in an X) to
evenly seat the heat sink on the processor to avoid damage that could require replacing the system
board.

Failure to install the fan shroud may cause the computer to overheat.
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Processor
1. Prepare the computer for disassembly (Preparation for Disassembly on page 122).

2. Remove the access panel (Access Panel on page 123).

3. Remove the fan shroud (Baffle on page 157).

4. Remove the heat sink (Heat sink on page 162).

5. Rotate the locking lever to its full open position (1).

6. Raise and rotate the microprocessor retainer to its fully open position (2).

7. Carefully lift the processor from the socket (3).

CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

The heat sink must be installed within 24 hours of installing the processor to prevent damage to
the processor’s solder connections.

Figure 9-52  Removing the processor

To install a new processor:

1. Place the processor in its socket and close the retainer.

2. Secure the locking lever. If reusing the existing heat sink, go to step 3. If using a new heat sink, go
to step 6.

3. If reusing the existing heat sink, clean the bottom of the heat sink with the alcohol pad provided in
the spares kit.

CAUTION: Before reinstalling the heat sink you must clean the top of the processor and the
bottom of the heat sink with an alcohol pad supplied in the spares kit. After the alcohol has
evaporated, apply thermal grease to the top of the processor from the syringe supplied in the spares
kit.
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4. Apply the thermal grease provided in the spares kit to the top of the processor and install the heat
sink atop the processor.

5. Go to step 7.

6. If using a new heat sink, remove the protective covering from the bottom of the heat sink and place
it in position atop the processor.

7. Secure the heat sink to the system board and system board tray with the four captive screws and
attach the heat sink control cable to the system board.

CAUTION: Heat sink retaining screws should be tightened in diagonally opposite pairs (as in an
X) to evenly seat the heat sink on the processor. This is especially important as the pins on the
socket are very fragile and any damage to them may require replacing the system board.

NOTE: After installing a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system BIOS can
be found on the Web at: http://h18000.www1.hp.com/support/files.

Power Supply
WARNING! Voltage is always present on the system board when the computer is plugged into an
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord should
be disconnected from the computer and/or the AC outlet before opening the computer.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 122).

2. Remove the access panel (Access Panel on page 123).

3. Rotate the drive cage up and disconnect the power cables from all of the drives.

4. Disconnect the power cables from the system board.

5. Rotate the power supply to its full upright position (1), pull the power supply forward (2) until the
posts on the power supply move forward in the power supply bracket (3), and then lift the power
supply straight up and out of the chassis.

Figure 9-53  Removing the power supply
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To install the power supply, reverse the removal procedure.

CAUTION: When installing the power supply cables, make sure they are properly positioned so they
are not cut by the drive cage and are not pinched by the rotating power supply.

System Board
1. Prepare the computer for disassembly (Preparation for Disassembly on page 122).

2. Remove the access panel (Access Panel on page 123).

3. Remove all PCI and PCI Express expansion boards (Expansion Cards on page 130).

4. Remove the baffle from the chassis (Baffle on page 157).

5. Remove the fan from the chassis (Front Fan Assembly on page 158).

6. Rotate the drive cage to its upright position.

7. Rotate the power supply to its full upright position.

8. Disconnect all data and power cables from the system board.

9. If applicable, disconnect the serial port from the system board.

10. Disconnect the balance of the cables from the system board.

11. Remove the heat sink (Heat sink on page 162).

12. Remove the eight screws that secure the system board to the chassis.

Figure 9-54  Removing the system board

13. Lift up the front of the system board, and then pull the system board forward, up, and out of the
chassis.

To install the system board, reverse the removal procedure.

NOTE: When replacing the system board, you must also change the chassis serial number in the
BIOS.

NOTE: The heat sink should be installed on the system board before the system board is reinstalled
in the chassis.
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CAUTION: Before reinstalling the heat sink you must clean the top of the processor and the bottom
of the heat sink with an alcohol pad supplied in the spares kit. After the alcohol has evaporated, apply
thermal grease to the top of the processor from the syringe supplied in the spares kit.

CAUTION: When reconnecting the cables it is important that they be positioned so they do not interfere
with the rotation of the drive cage or power supply.

Battery
The battery that comes with your computer provides power to the real-time clock and has a lifetime of
about three years. When replacing the battery, use a battery equivalent to the battery originally installed
on the computer. The computer comes with a 3-volt lithium coin cell battery.

NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall
socket. The lithium battery is only used when the computer is NOT connected to AC power.

WARNING! This computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.

Do not expose to temperatures higher than 140°F (60°C).

Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.

Replace the battery only with the HP spare designated for this product.

CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When
the battery is removed or replaced, the CMOS settings will be cleared. Refer to the Computer Setup
(F10) Utility Guide for information on backing up the CMOS settings.

NOTE: HP encourages customers to recycle used electronic hardware, HP original print cartridges,
and rechargeable batteries. For more information about recycling programs, go to http://www.hp.com/
recycle.

CAUTION: Static electricity can damage the electronic components of the computer or optional
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 122).

2. Remove the access panel (Access Panel on page 123).

NOTE: It may be necessary to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

4. Depending on the type of battery holder on your system board, complete the following instructions
to replace the battery:
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Type 1 Battery Holder
1. Lift the battery out of its holder.

Figure 9-55  Removing the battery from a type 1 holder

2. Slide the replacement battery into position, positive side up.

3. The battery holder automatically secures the battery in the proper position.

4. Replace the computer access panel.

5. Plug in the computer and turn on power to the computer.

6. Reset the date and time, your passwords, and any special system setups, using Computer Setup.
Refer to the Computer Setup (F10) Utility Guide.

Type 2 Battery Holder
1. To release the battery from its holder, squeeze the metal clamp that extends above one edge of

the battery. When the battery pops up, lift it out (1).

2. To insert the new battery, slide one edge of the replacement battery under the holder’s lip with the
positive side up (2). Push the other edge down until the clamp snaps over the other edge of the
battery.

Figure 9-56  Removing the battery from a type 2 holder

3. Replace the computer access panel.
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4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer Setup.
Refer to the Computer Setup (F10) Utility Guide.

Type 3 Battery Holder
1. Pull back on the clip (1) that holds the battery in place, then remove the battery (2).

2. Insert the new battery and position the clip back in place.

Figure 9-57  Removing the battery from a type 3 holder

3. Replace the computer access panel.

4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer Setup.
Refer to the Computer Setup (F10) Utility Guide.
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External Security Devices
The following security devices are used to prevent unauthorized access to the internal components of
the computer and/or secure the computer to a fixed object.

NOTE: For information on data security features, refer to the Computer Setup (F10) Utility Guide,
the Desktop Management Guide, and the HP ProtectTools Security Manager Guide (some models)
at http://www.hp.com.

Installing a Security Lock
The security locks displayed below and on the following pages can be used to secure the computer.

Cable Lock
Figure 9-58  Installing a Cable Lock
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Padlock
Figure 9-59  Installing a Padlock

HP Business PC Security Lock
1. Fasten the security cable by looping it around a stationary object.

Figure 9-60  Securing the Cable to a Fixed Object
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2. Thread the keyboard and mouse cables through the lock.

Figure 9-61  Threading the Keyboard and Mouse Cables

3. Screw the lock to the chassis using the screw provided.

Figure 9-62  Attaching the Lock to the Chassis
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4. Insert the plug end of the security cable into the lock (1) and push the button in (2) to engage the
lock. Use the key provided to disengage the lock.

Figure 9-63  Engaging the Lock

Front Bezel Security
The front bezel can be locked in place by installing a security screw provided by HP. To install the
security screw:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 122).

2. Remove the access panel (Access Panel on page 123).

3. Remove the front bezel (Front Bezel on page 124).

4. Remove one of the five silver 6-32 standard screws located on the front of the chassis behind the
bezel.

Figure 9-64  Retrieving the Front Bezel Security Screw

5. Replace the front bezel.
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6. Install the security screw next to the middle front bezel release tab to secure the front bezel in
place.

Figure 9-65  Installing the Front Bezel Security Screw

7. Replace the access panel.
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Using the Small Form Factor Computer in a Tower
Orientation

The Small Form Factor computer can be used in a tower orientation with an optional tower stand that
can be purchased from HP.

1. Remove/disengage any security devices that prohibit opening the computer.

2. Remove all removable media, such as compact discs or USB flash drives, from the computer.

3. Turn off the computer properly through the operating system, then turn off any external devices.

4. Disconnect the power cord from the power outlet and disconnect any external devices.

CAUTION: Regardless of the power-on state, voltage is always present on the system board as
long as the system is plugged into an active AC outlet. You must disconnect the power cord to
avoid damage to the internal components of the computer.

5. Orient the computer so that its right side is facing down and place the computer in the optional
stand.

Figure 9-66  Changing from Desktop to Tower Orientation

NOTE: To stabilize the computer in a tower orientation, HP recommends the use of the optional
tower stand.

6. Reconnect the power cord and any external devices, then turn on the computer.

NOTE: Ensure at least 10.2 centimeters (4 inches) of space on all sides of the computer remains clear
and free of obstructions.
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A Connector Pin Assignments

This appendix contains the pin assignments for many computer and workstation connectors. Some of
these connectors may not be used on the product being serviced.

Keyboard
Connector and Icon Pin Signal

1

2

3

Data

Unused

Ground

4

5

6

+5 VDC

Clock

Unused

Mouse
Connector and Icon Pin Signal

1

2

3

Data

Unused

Ground

4

5

6

+5 VDC

Clock

Unused
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Ethernet RJ-45
Connector and Icon Pin Signal

1

2

3

4

(+) Transmit Data

(-) Transmit Data

(+) Receive Data

Unused

5

6

7

8

Unused

(-) Receive Data

Unused

Unused

Serial Interface, Powered and Non-Powered
Connector and Icon Pin Signal

1

2

3

Carrier Detect (12V if powered)

Receive Data

Transmit Data

4

5

6

Data Terminal Ready

Signal Ground

Data Set Ready

7

8

9

Request to Send

Clear to Send

Ring Indicator (5V if powered)

USB
Connector and Icon Pin Signal

1

2

3

4

+5 VDC

- Data

+ Data

Ground
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Microphone
Connector and Icon (1/8” miniphone) Pin Signal

1 2 3
1 (Tip)

2 (Ring)

3 (Shield)

Audio_left

Audio_Right

Ground

Headphone
Connector and Icon (1/8” miniphone) Pin Signal

1 2 3
1 (Tip)

2 (Ring)

3 (Shield)

Audio_left

Power_Right

Ground

Line-in Audio
Connector and Icon (1/8” miniphone) Pin Signal

1 2 3
1 (Tip)

2 (Ring)

3 (Shield)

Audio_In_Left

Audio_In_Right

Ground

Line-out Audio
Connector and Icon (1/8” miniphone) Pin Signal

1 2 3
1 (Tip)

2 (Ring)

3 (Shield)

Audio_Out_Left

Audio_Out_Right

Ground
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Monitor
Connector and Icon

Pin Signal  Pin Signal

1

2

3

4

Red Analog

Green Analog

Blue Analog

Not used

 9

10

11

12

+5V (fused)

Ground

Not used

DDC Serial Data

5

6

7

8

Ground

Ground

Ground

Ground

 13

14

15

Horizontal Sync

Vertical Sync

DDC Serial Clock

4-Pin Power (for CPU)
Connector and Icon Pin Signal

1

2

3

4

GND

GND

+12V CPU

-12V CPU
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PCI Express
x1, x4, x8, and x16 PCI Express Connector

Pin A

Pin Signal Pin Signal Pin Signal Pin Signal Pin Signal

1

2

3

4

5

PRSNT1

+12V

+12V

GND

JTAG2

6

7

8

9

10

JTAG3

JTAG4

JTAG5

+3.3V

+3.3V

11

12

13

14

15

PERST#

GND

REFCLK+

REFCLK-

GND

16

17

18

19

20

PERp0

PERn0

GND

RSVD

GND

21

22

23

24

25

PERp1

PERn1

GND

GND

PERp2

26

27

28

29

30

PERn(2)

GND

GND

PERp3

PERn3

31

32

33

34

35

GND

RSVD

RSVD

GND

PERp4

36

37

38

39

40

PERn4

GND

GND

PERp5

PERn5

41

42

43

44

45

GND

GND

PERp6

PERn6

GND

46

47

48

49

50

GND

PERp7

PERn7

GND

RSVD

51

52

53

54

55

GND

PERp8

PERN8

GND

GND

56

57

58

59

60

PERp9

PERn9

GND

GND

PERp10

61

62

63

64

65

PERn10

GND

GND

PERp11

PERn11

66

67

68

69

70

GND

GND

PERp12

PERn12

GND

71

72

73

74

75

GND

PERp13

PERn13

GND

GND

76

77

78

79

80

PERp14

PERn14

GND

GND

PERp15

81

82

PERn15

GND

      

Pin B information is on the next page

NOTE: x1 PCI Express uses pins 1-18

x4 PCI Express uses pins 1-32

x8 PCI Express uses pins 1-49

x16 PCI Express uses pins 1-8
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PCI Express
x1, x4, x8, and x16 PCI Express Connector

Pin B

Pin Signal Pin Signal Pin Signal Pin Signal Pin Signal

1

2

3

4

5

+12V

+12V

RSVD

GND

SMCLK

6

7

8

9

10

SMDAT

GND

+3.3 V

JTAG1

3.3vAux

11

12

13

14

15

WAKE#

RSVD

GND

PETp0

PETn0

16

17

18

19

20

GND

GND

PETp1

PETn1

21

22

23

24

25

GND

GND

PETp2

PETn2

GND

26

27

28

29

30

GND

PETp3

PETn3

GND

RSVD

31

32

33

34

35

PRSNT2#

GND

PETp4

PETn4

GND

36

37

38

39

40

GND

PETp5

PETn5

GND

GND

41

42

43

44

45

PETp6

PRTn6

GND

GND

PETp7

46

47

48

49

50

PETn7

GND

PRSNT2#

GND

PETp8

51

52

53

54

55

PETn8

GND

GND

PETp9

PETn9

56

57

58

59

60

GND

GND

PETp10

PETn10

GND

61

62

63

64

65

GND

PETp11

PETn11

GND

GND

66

67

68

69

70

PETp12

PETn12

GND

GND

PETp13

71

72

73

74

75

PETn13

GND

GND

PETp14

PETn14

76

77

78

79

80

GND

GND

PETp15

PETn15

GND

81

82

PRSNT2#

RSVD

      

Pin B information is on the next page

NOTE: x1 PCI Express uses pins 1-18

x4 PCI Express uses pins 1-32

x8 PCI Express uses pins 1-49

x16 PCI Express uses pins 1-8
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DVI Connector
Connector and Icon

Pin Signal  Pin Signal

1

2

3

4

T.M.D.S. Data2–

T.M.D.S. Data2+

T.M.D.S. Data2/4 Shield

T.M.D.S. Data4–

 13

14

15

16

T.M.D.S. Data3+

+5V Power

Ground (for +5V)

Hot Pug Detect

5

6

7

8

T.M.D.S. Data4+

DDC Clock

DDC Data

No Connect

 17

18

19

20

T.M.D.S. Data0–

T.M.D.S. Data0+

T.M.D.S. Data0/5 Shield

T.M.D.S. Data5–

9

10

11

12

T.M.D.S. Data1–

T.M.D.S. Data1+

T.M.D.S. Data1/3 Shield

T.M.D.S. Data3–

 21

22

23

24

T.M.D.S. Data5+

T.M.D.S. Data Shield

T.M.D.S. Clock+

T.M.D.S. Clock-
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DisplayPort Connector
Connector and Icon

Pin Signal  Pin Signal

1

2

3

4

ML_Lane 0 (p)

Ground

ML_Lane 0 (n)

ML_Lane 1 (p)

 13

14

15

16

CONFIG1

CONFIG2

AUX CH (p)

Ground

5

6

7

8

Ground

ML_Lane 1 (n)

ML_Lane 2 (p)

Ground

 17

18

19

20

AUX CH (n)

Hot Plug

Return

DP_PWR

9

10

11

12

ML_Lane 2 (n)

ML_Lane 3 (p)

Ground

ML_Lane 3 (n)
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B Power Cord Set Requirements

The power supplies on some computers have external power switches. The voltage select switch feature
on the computer permits it to operate from any line voltage between 100-120 or 220-240 volts AC. Power
supplies on those computers that do not have external power switches are equipped with internal
switches that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where
you purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you use
the computer.

General Requirements
The requirements listed below are applicable to all countries:

1. The power cord must be approved by an acceptable accredited agency responsible for evaluation
in the country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a nominal
voltage rating of 125 or 250 volts AC, as required by each country’s power system.

3. The diameter of the wire must be a minimum of 0.75 mm2 or 18AWG, and the length of the cord
must be between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed upon
it or against it. Particular attention should be paid to the plug, electrical outlet, and the point where the
cord exits from the product.

WARNING! Do not operate this product with a damaged power cord set. If the power cord set is
damaged in any manner, replace it immediately.

Japanese Power Cord Requirements
For use in Japan, use only the power cord received with this product.

CAUTION: Do not use the power cord received with this product on any other products.
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Country-Specific Requirements
Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency  Country Accrediting Agency

Australia (1)

Austria (1)

Belgium (1)

Canada (2)

EANSW

OVE

CEBC

CSA

 Italy (1)

Japan (3)

Norway (1)

Sweden (1)

IMQ

METI

NEMKO

SEMKO

Denmark (1)

Finland (1)

France (1)

Germany (1)

DEMKO

SETI

UTE

VDE

 Switzerland (1)

United Kingdom (1)

United States (2)

SEV

BSI

UL

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm2 conductor size. Wall plug must
be a two-pole grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.

184 Appendix B   Power Cord Set Requirements



C POST Error Messages

This appendix lists the error codes, error messages, and the various indicator light and audible
sequences that you may encounter during Power-On Self-Test (POST) or computer restart, the probable
source of the problem, and steps you can take to resolve the error condition.

POST Message Disabled suppresses most system messages during POST, such as memory count
and non-error text messages. If a POST error occurs, the screen will display the error message. To
manually switch to the POST Messages Enabled mode during POST, press any key (except F10 or
F12). The default mode is POST Message Disabled.

The speed at which the computer loads the operating system and the extent to which it is tested are
determined by the POST mode selection.

Quick Boot is a fast startup process that does not run all of the system level tests, such as the memory
test. Full Boot runs all of the ROM-based system tests and takes longer to complete.

Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish
the schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.

NOTE: For more information on Computer Setup, see the Computer Setup (F10) Utility Guide.

185



POST Numeric Codes and Text Messages
This section covers those POST errors that have numeric codes associated with them. The section also
includes some text messages that may be encountered during POST.

NOTE: The computer will beep once after a POST text message is displayed on the screen.

Table C-1  Numeric Codes and Text Messages

Control panel message Description Recommended action

101-Option ROM Checksum Error System ROM or expansion board option
ROM checksum.

1. Verify the correct ROM.

2. Flash the ROM if needed.

3. If an expansion board was recently
added, remove it to see if the problem
remains.

4. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 233.)

5. If the message disappears, there may
be a problem with the expansion card.

6. Replace the system board.

103-System Board Failure DMA or timers. 1. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 233.)

2. Remove expansion boards.

3. Replace the system board.

110-Out of Memory Space for Option ROMs Recently added PCI expansion card contains
an option ROM too large to download during
POST.

1. If a PCI expansion card was recently
added, remove it to see if the problem
remains.

2. In Computer Setup, set Advanced >
Device Options > NIC PXE Option
ROM Download to DISABLE to prevent
PXE option ROM for the internal NIC
from being downloaded during POST to
free more memory for an expansion
card's option ROM. Internal PXE option
ROM is used for booting from the NIC to
a PXE server.

162-System Options Not Set Configuration incorrect.

RTC (real-time clock) battery may need to
be replaced.

Run Computer Setup and check the
configuration in Advanced > Onboard
Devices.

Reset the date and time under Control
Panel. If the problem persists, replace the
RTC battery. See the Hardware Reference
Guide for instructions on installing a new
battery, or contact an authorized dealer or
reseller for RTC battery replacement.
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Control panel message Description Recommended action

163-Time & Date Not Set Invalid time or date in configuration memory.

RTC (real-time clock) battery may need to
be replaced.

Reset the date and time under Control
Panel (Computer Setup can also be used). If
the problem persists, replace the RTC
battery. See the Hardware Reference Guide
for instructions on installing a new battery, or
contact an authorized dealer or reseller for
RTC battery replacement.

163-Time & Date Not Set CMOS jumper may not be properly installed. Check for proper placement of the CMOS
jumper if applicable.

164-Memory Size Error Memory amount has changed since the last
boot (memory added or removed).

Press the F1 key to save the memory
changes.

164-Memory Size Error Memory configuration incorrect. 1. Run Computer Setup or Windows
utilities.

2. Make sure the memory module(s) are
installed properly.

3. If third-party memory has been added,
test using HP-only memory.

4. Verify proper memory module type.

201-Memory Error RAM failure. 1. Ensure memory modules are correctly
installed.

2. Verify proper memory module type.

3. Remove and replace the identified faulty
memory module(s).

4. If the error persists after replacing
memory modules, replace the system
board.

213-Incompatible Memory Module in
Memory Socket(s) X, X, ...

A memory module in memory socket
identified in the error message is missing
critical SPD information, or is incompatible
with the chipset.

1. Verify proper memory module type.

2. Try another memory socket.

3. Replace DIMM with a module
conforming to the SPD standard.

214-DIMM Configuration Warning Populated DIMM Configuration is not
optimized.

Rearrange the DIMMs so that each channel
has the same amount of memory.

215-DIMM Configuration Error Populated DIMM configuration is not
optimized.

Remove power from the system and reinstall
memory modules. On AMD systems,
populate modules starting with slot XMM4,
then XMM3, followed by slots XMM2 and
XMM1. On Intel systems, populate modules
starting with slot DIMM1, then DIMM3,
followed by slots DIMM2 and DIMM4.

219-ECC Memory Module Detected ECC
Modules not supported on this Platform

Recently added memory module(s) support
ECC memory error correction.

1. If additional memory was recently
added, remove it to see if the problem
remains.

2. Check product documentation for
memory support information.

Table C-1  Numeric Codes and Text Messages (continued)
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Control panel message Description Recommended action

301-Keyboard Error Keyboard failure. 1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

303-Keyboard Controller Error I/O board keyboard controller. 1. Reconnect keyboard with computer
turned off.

2. Replace the system board.

304-Keyboard or System Unit Error Keyboard failure. 1. Reconnect the keyboard with computer
turned off.

2. Ensure that none of the keys are
depressed.

3. Replace the keyboard.

4. Replace the system board.

501-Display Adapter Failure Graphics display controller. 1. Reseat the graphics card (if applicable).

2. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 233.)

3. Verify monitor is attached and turned
on.

4. Replace the graphics card (if possible).

510-Flash Screen Image Corrupted Flash Screen image has errors. Reflash the system ROM with the latest BIOS
image.

511-CPU Fan not detected CPU fan is not connected or may have
malfunctioned.

1. Reseat CPU fan.

2. Reseat fan cable.

3. Replace CPU fan.

512-Rear Chassis Fan not detected Rear chassis fan is not connected or may
have malfunctioned.

1. Reseat rear chassis fan.

2. Reseat fan cable.

3. Replace rear chassis fan.

513-Front Chassis Fan not detected Front chassis fan is not connected or may
have malfunctioned.

1. Reseat front chassis fan.

2. Reseat fan cable.

3. Replace front chassis fan.

515-Power Supply Fan not detected Power supply fan is not connected or may
have malfunctioned.

1. Reseat power supply fan.

2. Reseat fan cable.

3. Replace power supply fan.

Table C-1  Numeric Codes and Text Messages (continued)
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Control panel message Description Recommended action

605-Diskette Drive Type Error Mismatch in drive type. 1. Disconnect any other diskette controller
devices (tape drives).

2. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 233.)

660-Display cache is detected unreliable Integrated graphics controller display cache
is not working properly and will be disabled.

Replace system board if minimal graphics
degrading is an issue.

912-Computer Cover Has Been Removed
Since Last System Startup

Computer cover was removed since last
system startup.

No action required.

917-Front Audio Not Connected Front audio harness has been detached or
unseated from motherboard.

Reconnect or replace front audio harness.

921-Front USB 1 Not Connected Front USB harness has been detached or
unseated from motherboard.

Reconnect or replace front USB harness.

922-Front USB 1 Not Connected Front USB harness has been detached or
unseated from motherboard.

Reconnect or replace front USB harness.

921-Device in PCI Express slot failed to
initialize

There is an incompatibility/problem with this
device and the system or PCI Express Link
could not be retrained to an x1.

Try rebooting the system. If the error
reoccurs, the device may not work with this
system

1151-Serial Port A Address Conflict Detected Both external and internal serial ports are
assigned to COM1.

1. Remove any serial port expansion
cards.

2. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 233.)

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1152-Serial Port B Address Conflict Detected Both external and internal serial ports are
assigned to COM2.

1. Remove any serial port expansion
cards.

2. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 233.)

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1155-Serial Port Address Conflict Detected Both external and internal serial ports are
assigned to same IRQ.

1. Remove any serial port expansion
cards.

2. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 233.)

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

Table C-1  Numeric Codes and Text Messages (continued)
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Control panel message Description Recommended action

1720-SMART Hard Drive Detects Imminent
Failure

Hard drive is about to fail. (Some hard drives
have a hard drive firmware patch that will fix
an erroneous error message.)

1. Determine if hard drive is giving correct
error message. Enter Computer Setup
and run the Drive Protection System test
under Storage > DPS Self-test.

2. Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

3. Back up contents and replace hard
drive.

1796-SATA Cabling Error One or more SATA devices are improperly
attached. For optimal performance, the SATA
0 and SATA 1 connectors must be used
before SATA 2 and SATA 3.

Ensure SATA connectors are used in
ascending order. For one device, use SATA
0. For two devices, use SATA 0 and SATA 1.
For three devices, use SATA 0, SATA 1, and
SATA 2.

1797-SATA Drivelock is not supported in
RAID mode.

Drivelock is enabled on one or more SATA
hard drives, and they cannot be accessed
while the system is configured for RAID
mode.

Either remove the Drivelocked SATA device
or disable the Drivelock feature. To disable
the Drivelock feature, enter Computer Setup,
change Storage > Storage Options > SATA
Emulation to IDE, and select File > Save
Changes and Exit. Reenter Computer Setup
and select Security > Drivelock Security.
For each listed Drivelock-capable SATA
device, ensure Drivelock is Disabled. Lastly,
change Storage > Storage Options > SATA
Emulation back to RAID and select File >
Save Changes and Exit.

1801-Microcode Patch Error Processor is not supported by ROM BIOS. 1. Upgrade BIOS to proper version.

2. Change the processor.

2200-PMM Allocation Error during MEBx
Download

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the computer,
restore the original memory
configuration, and reboot the computer.

4. If the error persists, replace the system
board.

2201-MEBx Module did not checksum
correctly

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the computer.

4. If the error persists, replace the system
board.

Table C-1  Numeric Codes and Text Messages (continued)
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Control panel message Description Recommended action

2202-PMM Deallocation Error during MEBx
cleanup

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the computer.

4. If the error persists, replace the system
board.

2203-Setup error during MEBx execution MEBx selection or exit resulted in a setup
failure.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the computer.

4. If the error persists, replace the system
board.

2204-Inventory error during MEBx execution BIOS information passed to the MEBx
resulted in a failure.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version.

3. If the error still persists, replace the
system board.

2205-Interface error during MEBx execution MEBx operation experienced a hardware
error during communication with ME.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version.

3. If the error still persists, replace the
system board.

2211-Memory not configured correctly for
proper MEBx execution.

DIMM1 is not installed. Make sure there is a memory module in the
black DIMM1 socket and that it is properly
seated.

Invalid Electronic Serial Number Electronic serial number is missing. Enter the correct serial number in Computer
Setup.

Memory Parity Error Parity RAM failure.

Third-party graphics card may be causing a
problem.

Run Computer Setup and Diagnostic utilities.

Remove third-party graphics card to see if the
problem goes away.

Table C-1  Numeric Codes and Text Messages (continued)
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Control panel message Description Recommended action

Network Server Mode Active and No
Keyboard Attached

Keyboard failure while Network Server Mode
enabled.

1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

Parity Check 2 Parity RAM failure.

Third-party graphics card may be causing a
problem.

Run Computer Setup and Diagnostic utilities.

Remove third-party graphics card to see if the
problem goes away.

Interpreting POST Diagnostic Front Panel LEDs and
Audible Codes

This section covers the front panel LED codes as well as the audible codes that may occur before or
during POST that do not necessarily have an error code or text message associated with them.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to the
system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure
to disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.

NOTE: If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of the
computer and refer to the following table to determine the front panel LED codes.

Recommended actions in the following table are listed in the order in which they should be performed.

Not all diagnostic lights and audible codes are available on all models.

Table C-2  Diagnostic Front Panel LEDs and Audible Codes

Activity Beeps Possible Cause Recommended Action

Green Power LED On. None Computer on. None

Green Power LED flashes
every two seconds.

None Computer in Suspend to
RAM mode (some models
only) or normal Suspend
mode.

None required. Press any key or move the mouse
to wake the computer.

Red Power LED flashes two
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

2 Processor thermal
protection activated:

A fan may be blocked or
not turning.

OR

The heat sink/fan
assembly is not properly
attached to the processor.

1. Ensure that the computer air vents are not
blocked and the processor cooling fan is
running.

2. Open hood, press power button, and see if
the processor fan spins. If the processor fan
is not spinning, make sure the fan's cable is
plugged onto the system board header.

3. If fan is plugged in, but is not spinning, then
replace heat sink/fan assembly.

4. Contact an authorized reseller or service
provider.

Table C-1  Numeric Codes and Text Messages (continued)
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Activity Beeps Possible Cause Recommended Action

Red Power LED flashes three
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

3 Processor not installed
(not an indicator of bad
processor).

1. Check to see that the processor is present.

2. Reseat the processor.

Red Power LED flashes four
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

4 Power failure (power
supply is overloaded).

1. Open the hood and ensure the 4 or 6-wire
power supply cable is seated into the
connector on the system board.

2. Check if a device is causing the problem by
removing ALL attached devices (such as
hard or optical drives and expansion cards).
Power on the system. If the system enters the
POST, then power off and replace one
device at a time and repeat this procedure
until failure occurs. Replace the device that
is causing the failure. Continue adding
devices one at a time to ensure all devices
are functioning properly.

3. Replace the power supply.

4. Replace the system board.

Red Power LED flashes five
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

5 Pre-video memory error. CAUTION: To avoid damage to the DIMMs or
the system board, you must unplug the computer
power cord before attempting to reseat, install, or
remove a DIMM module.

1. Reseat DIMMs.

2. Replace DIMMs one at a time to isolate the
faulty module.

3. Replace third-party memory with HP
memory.

4. Replace the system board.

Red Power LED flashes six
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

6 Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the
system board.

Red Power LED flashes seven
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

7 System board failure
(ROM detected failure
prior to video).

Replace the system board.

Table C-2  Diagnostic Front Panel LEDs and Audible Codes (continued)
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Activity Beeps Possible Cause Recommended Action

Red Power LED flashes eight
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

8 Invalid ROM based on bad
checksum.

1. Reflash the system ROM with the latest BIOS
image. See the “Boot Block Emergency
Recovery Mode” section of the Desktop
Management Guide for more information.

2. Replace the system board.

Red Power LED flashes nine
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

9 System powers on but is
unable to boot.

1. Check that the voltage selector, located on
the rear of the power supply (some models),
is set to the appropriate voltage. Proper
voltage setting depends on your region.

2. Unplug the AC power cord from the
computer, wait 30 seconds, then plug the
power cord back in to the computer.

3. Replace the system board.

4. Replace the processor.

Red Power LED flashes ten
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

10 Bad option card. 1. Check each option card by removing the card
(one at a time if multiple cards), then power
on the system to see if fault goes away.

2. Once a bad card is identified, remove and
replace the bad option card.

3. Replace the system board.

Table C-2  Diagnostic Front Panel LEDs and Audible Codes (continued)
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Activity Beeps Possible Cause Recommended Action

Red Power LED flashes eleven
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

11 The current processor
does not support a feature
previously enabled on this
system.

1. Install a TXT capable processor.

2. Disable TXT in the Computer Setup (F10)
utility.

3. Reinstall the original processor.

System does not power on and
LEDs are not flashing.

None System unable to power
on.

Press and hold the power button for less than 4
seconds. If the hard drive LED turns green, the
power button is working correctly. Try the
following:

1. Check that the voltage selector (some
models), located on the rear of the power
supply, is set to the appropriate voltage.
Proper voltage setting depends on your
region.

2. Replace the system board.

OR

Press and hold the power button for less than 4
seconds. If the hard drive LED does not turn on
green then:

1. Check that the unit is plugged into a working
AC outlet.

2. Open hood and check that the power button
harness is properly connected to the system
board.

3. Check that both power supply cables are
properly connected to the system board.

4. Check to see if the 5V_aux light on the
system board is turned on. If it is turned on,
then replace the power button harness. If the
problem persists, replace the system board.

5. If the 5V_aux light on the system board is not
turned on, remove the expansion cards one
at a time until the 5V_aux light on the system
board turns on. It the problem persists,
replace the power supply.

Table C-2  Diagnostic Front Panel LEDs and Audible Codes (continued)
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D Troubleshooting Without Diagnostics

This chapter provides information on how to identify and correct minor problems, such as hard drive,
optical drive, graphics, audio, memory, and software problems. If you encounter problems with the
computer, refer to the tables in this chapter for probable causes and recommended solutions.

NOTE: For information on specific error messages that may appear on the screen during Power-On
Self-Test (POST) at startup, refer to Appendix A, POST Error Messageson page 185.

Safety and Comfort
WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment
may result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/
ergo for more information on choosing a workspace and creating a safe and comfortable work
environment. For more information, refer to the Safety & Regulatory Information guide.

Before You Call for Technical Support
If you are having problems with the computer, try the appropriate solutions below to try to isolate the
exact problem before calling for technical support.

● Run the HP diagnostic tool.

● Run the hard drive self-test in Computer Setup. Refer to the Computer Setup (F10) Utility Guide
for more information.

● Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights
are error codes that will help you diagnose the problem. Refer to Appendix A, POST Error
Messages on page 185 for more information.

● If the screen is blank, plug the monitor into a different video port on the computer if one is available.
Or, replace the monitor with a monitor that you know is functioning properly.

● If you are working on a network, plug another computer with a different cable into the network
connection. There may be a problem with the network plug or cable.

● If you recently added new hardware, remove the hardware and see if the computer functions
properly.

● If you recently installed new software, uninstall the software and see if the computer functions
properly.

● Boot the computer to the Safe Mode to see if it will boot without all of the drivers loaded. When
booting the operating system, use “Last Known Configuration.”
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● Refer to the comprehensive online technical support at http://www.hp.com/support.

● Refer to Helpful Hints on page 197 in this guide.

To assist you in resolving problems online, HP Instant Support Professional Edition provides you with
self-solve diagnostics. If you need to contact HP support, use HP Instant Support Professional Edition's
online chat feature. Access HP Instant Support Professional Edition at: http://www.hp.com/go/ispe.

Access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest online
support information, software and drivers, proactive notification, and worldwide community of peers and
HP experts.

If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that
your service call is handled properly:

● Be in front of your computer when you call.

● Write down the computer serial number, product ID number, and monitor serial number before
calling.

● Spend time troubleshooting the problem with the service technician.

● Remove any hardware that was recently added to your system.

● Remove any software that was recently installed.

NOTE: For sales information and warranty upgrades (Care Packs), call your local authorized service
provider or dealer.

Helpful Hints
If you encounter problems with the computer, monitor, or software, see the following list of general
suggestions before taking further action:

● Check that the computer and monitor are plugged into a working electrical outlet.

● Check that the computer is turned on and the green power light is on.

● Check that the monitor is turned on and the green monitor light is on.

● Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights
are error codes that will help you diagnose the problem. Refer to Appendix A, POST Error
Messages on page 185 for more information.

● Turn up the brightness and contrast controls of the monitor if the monitor is dim.

● Press and hold any key. If the system beeps, then the keyboard should be operating correctly.

● Check all cable connections for loose connections or incorrect connections.

● Wake the computer by pressing any key on the keyboard or pressing the power button. If the system
remains in suspend mode, shut down the computer by pressing and holding the power button for
at least four seconds then press the power button again to restart the computer. If the system will
not shut down, unplug the power cord, wait a few seconds, then plug it in again. The computer will
restart if it is set to automatic start after power loss in Computer Setup as soon as power is restored.
If it does not restart, press the power button to start the computer.
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● Reconfigure the computer after installing a non-plug and play expansion board or other option.
See Solving Hardware Installation Problems on page 217 for instructions.

● Be sure that all the needed device drivers have been installed. For example, if you are using a
printer, you need a driver for that model printer.

● Remove all bootable media (CD or USB device) from the system before turning it on.

● If you have installed an operating system other than the factory-installed operating system, check
to be sure that it is supported on the system.

● If the system has multiple video sources (embedded, PCI, or PCI-Express adapters) installed
(embedded video on some models only) and a single monitor, the monitor must be plugged into
the monitor connector on the source selected as the primary VGA adapter. During boot, the other
monitor connectors are disabled and if the monitor is connected into these ports, the monitor will
not function. You can select which source will be the default VGA source in Computer Setup.

CAUTION: When the computer is plugged into an AC power source, there is always voltage applied
to the system board. You must disconnect the power cord from the power source before opening the
computer to prevent system board or component damage.
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Solving General Problems
You may be able to easily resolve the general problems described in this section. If a problem persists
and you are unable to resolve it yourself or if you feel uncomfortable about performing the operation,
contact an authorized dealer or reseller.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to the
system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure
to disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.

Table D-1  Solving General Problems

Computer appears locked up and will not turn off when the power button is pressed.

Cause Solution

Software control of the power switch is not functional. 1. Press and hold the power button for at least four seconds
until the computer turns off.

2. Disconnect the power cord from the electrical outlet.

Computer will not respond to USB keyboard or mouse.

Cause Solution

Computer is in standby mode. To resume from standby mode, press the power button or
press any key.

CAUTION: When attempting to resume from standby mode,
do not hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

System has locked up. Restart computer.

Computer date and time display is incorrect.

Cause Solution

RTC (real-time clock) battery may need to be replaced.

NOTE: Connecting the computer to a live AC outlet prolongs
the life of the RTC battery.

First, reset the date and time under Control Panel (Computer
Setup can also be used to update the RTC date and time). If
the problem persists, replace the RTC battery. See the
Hardware Reference Guide for instructions on installing a new
battery, or contact an authorized dealer or reseller for RTC
battery replacement.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key may be on. Press the Num Lock key. The Num Lock light should not be on
if you want to use the arrow keys. The Num Lock key can be
disabled (or enabled) in Computer Setup.
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There is no sound or sound volume is too low.

Cause Solution

System volume may be set low or muted. 1. Check the F10 BIOS settings to make sure the internal
system speaker is not muted (this setting does not affect
the external speakers).

2. Make sure the external speakers are properly connected
and powered on and that the speakers' volume control is
set correctly.

3. Use the system volume control available in the operating
system to make sure the speakers are not muted or to
increase the volume.

The audio device may be connected to the wrong jack on the
rear of the computer.

Ensure that the device is connected to the correct jack on the
rear of the computer.

Cannot remove computer cover or access panel.

Cause Solution

Smart Cover Lock, featured on some computers, is locked. Unlock the Smart Cover Lock using Computer Setup.

The Smart Cover FailSafe Key, a device for manually disabling
the Smart Cover Lock, is available from HP. You will need the
FailSafe Key in case of forgotten password, power loss, or
computer malfunction. Order PN 166527-001 for the wrench-
style key or PN 166527-002 for the screwdriver bit key.

Poor performance is experienced.

Cause Solution

Processor is hot. 1. Make sure airflow to the computer is not blocked. Leave
a 10.2-cm (4-inch) clearance on all vented sides of the
computer and above the monitor to permit the required
airflow.

2. Make sure fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Hard drive is full. Transfer data from the hard drive to create more space on the
hard drive.

Low on memory. Add more memory.

Hard drive fragmented. Defragment hard drive.

Program previously accessed did not release reserved
memory back to the system.

Restart the computer.

Virus resident on the hard drive. Run virus protection program.

Table D-1  Solving General Problems (continued)
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Poor performance is experienced.

Cause Solution

Too many applications running. 1. Close unnecessary applications to free up memory.

2. Add more memory. Some applications run in the
background and can be closed by right-clicking on their
corresponding icons in the task tray. To prevent these
applications from launching at startup, go to Start >
Run (Windows XP) or Start > Accessories > Run
(Windows Vista) and type msconfig. On the Startup tab
of the System Configuration Utility, clear applications that
you do not want to launch automatically.

Some software applications, especially games, are stressful
on the graphics subsystem

1. Lower the display resolution for the current application or
consult the documentation that came with the application
for suggestions on how to improve performance by
adjusting parameters in the application.

2. Add more memory.

3. Upgrade the graphics solution.

Cause unknown. Restart the computer.

Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a two
second pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing).

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

2. Open hood, press power button, and see if the processor
fan spins. If the processor fan is not spinning, make sure
the fan's cable is plugged onto the system board header.

3. If fan is plugged in, but is not spinning, then replace the
heat sink/fan assembly.

4. Contact an authorized reseller or service provider.

Table D-1  Solving General Problems (continued)
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System does not power on and the LEDs on the front of the computer are not flashing.

Cause Solution

System unable to power on. Press and hold the power button for less than 4 seconds. If the
hard drive LED turns green, then:

1. Remove the expansion cards one at a time until the
5V_aux light on the system board turns on.

2. Replace the system board.

OR

Press and hold the power button for less than 4 seconds. If the
hard drive LED does not turn on green then:

1. Check that the unit is plugged into a working AC outlet.

2. Open hood and check that the power button harness is
properly connected to the system board.

3. Check that both power supply cables are properly
connected to the system board.

4. Check to see if the 5V_aux light on the system board is
turned on. If it is turned on, then replace the power button
harness.

5. If the 5V_aux light on the system board is off, then replace
the power supply.

6. Replace the system board.

Table D-1  Solving General Problems (continued)

202 Appendix D   Troubleshooting Without Diagnostics



Solving Power Problems
Common causes and solutions for power problems are listed in the following table.

Table D-2  Solving Power Problems

Power supply shuts down intermittently.

Cause Solution

Power supply will not turn on because of internal power supply
fault.

Contact an authorized service provider to replace the power
supply.

Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a two
second pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

2. Open hood, press power button, and see if the processor
fan spins. If the processor fan is not spinning, make sure
the fan's cable is plugged onto the system board header.

3. If fan is plugged in, but is not spinning, then replace the
heat sink/fan assembly.

4. Contact an authorized reseller or service provider.

Power LED flashes Red four times, once every second, followed by a two second pause, and the computer beeps four
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Power failure (power supply is overloaded). 1. Open the hood and ensure the 4- or 6-wire power supply
cable is seated into the connector on the system board.

2. Check if a device is causing the problem by removing ALL
attached devices (such as hard or optical drives and
expansion cards). Power on the system. If the system
enters the POST, then power off and replace one device
at a time and repeat this procedure until failure occurs.
Replace the device that is causing the failure. Continue
adding devices one at a time to ensure all devices are
functioning properly.

3. Replace the power supply.

4. Replace the system board.
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Solving Hard Drive Problems
Table D-3  Solving Hard Drive Problems

Hard drive error occurs.

Cause Solution

Hard disk has bad sectors or has failed. 1. In Microsoft Windows XP, right-click Start, click
Explore, and select a drive. Select File > Properties >
Tools. Under Error-checking, click Check Now.

In Microsoft Windows Vista, right-click Start, click
Explore, and right-click on a drive. Select
Properties then select the Tools tab. Under Error-
checking click Check Now.

2. Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.

Disk transaction problem.

Cause Solution

Either the directory structure is bad or there is a problem with
a file.

In Microsoft Windows XP, right-click Start, click Explore, and
select a drive. Select File > Properties > Tools. Under Error-
checking, click Check Now.

In Microsoft Windows Vista, right-click Start, click Explore,
and right-click on a drive. Select Properties then select the
Tools tab. Under Error-checking click Check Now.

Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 217. If the system still does not
recognize the new device, check to see if the device is listed
within Computer Setup. If it is listed, the probable cause is a
driver problem. If it is not listed, the probable cause is a
hardware problem.

If this is a newly installed drive, run the Computer Setup utility
and try adding a POST delay under Advanced > Power-On
Options.

The device is attached to a SATA port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly after initial power up. Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.
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Nonsystem disk/NTLDR missing message.

Cause Solution

The system is trying to start from a media device that is not
bootable.

Remove the media device from the drive.

The system is trying to start from the hard drive but the hard
drive may have been damaged.

1. Insert a bootable media device into the drive and restart
the computer.

2. Check the hard drive format using fdisk: If NTFS
formatting, use a third party reader to evaluate the drive.
If FAT32 formatting, the hard drive cannot be accessed.

System files missing or not properly installed. 1. Insert a bootable media device into the drive and restart
the computer.

2. Check the hard drive format using Fdisk: If NFTFS
formatting, use a third party reader to evaluate the drive.
If FAT32 formatting, the hard drive cannot be accessed.

3. Install system files for the appropriate operating system.

Hard drive boot has been disabled in Computer Setup. Run the Computer Setup utility and enable the hard drive entry
in the Storage > Boot Order list.

Bootable hard drive is not attached as first in a multi-hard drive
configuration.

If attempting to boot from a hard drive, ensure it is attached to
the system board connector labeled SATA 0.

Bootable hard drive's controller is not listed first in the Boot
Order.

Run the Computer Setup utility and select Storage > Boot
Order and ensure the bootable hard drive's controller is listed
immediately under the Hard Drive entry.

Computer will not boot from hard drive.

Cause Solution

The device is attached to a SATA port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Boot order is not correct. Run the Computer Setup utility and change boot sequence
in Storage > Boot Order.

Hard Drive's “Emulation Type” is set to “None.” Run the Computer Setup utility and change the “Emulation
Type” to “Hard Disk” in the device's details under Storage >
Device Configuration.

Hard drive is damaged. Observe if the front panel Power LED is blinking RED and if
any beeps are heard. See Appendix A, POST Error
Messages on page 185 to determine possible causes for the
blinking red and beep codes.

See the Worldwide Limited Warranty for terms and conditions.

Table D-3  Solving Hard Drive Problems (continued)
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Computer seems to be locked up.

Cause Solution

Program in use has stopped responding to commands. Attempt the normal Windows “Shut Down” procedure. If this
fails, press the power button for four or more seconds to turn
off the power. To restart the computer, press the power button
again.

The removable hard drive has no power to the hard drive enclosure.

Cause Solution

The lock on the enclosure is not turned to the “ON” position. Insert the key and turn the lock clockwise 90 degrees. The
green LED on the front of the enclosure should be on.

Power cable from the computer power supply to the enclosure
frame is not properly connected.

Check the power supply to make sure it is properly connected
to the rear of the enclosure frame.

The removable hard drive is not recognized by the computer.

Cause Solution

The removable hard drive carrier is not fully seated in the
enclosure frame or the hard drive is not fully seated in the
carrier.

Push the carrier into the enclosure frame so that the connector
on the rear of the frame is properly seated. If this does not solve
the problem, turn off the computer, remove the carrier, and
check to see if the connector on the hard drive is properly
seated in the carrier.

The removable hard drive enclosure is beeping and the green LED is flashing.

Cause Solution

Fan failure alarm on the removable hard drive enclosure has
been activated.

Shut down the computer and contact HP for a replacement
enclosure.

Table D-3  Solving Hard Drive Problems (continued)
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Solving Media Card Reader Problems
Table D-4  Solving Media Card Reader Problems

Media card will not work in a digital camera after formatting it in Microsoft Windows XP or Microsoft Windows Vista.

Cause Solution

By default, Windows XP and Windows Vista will format any
media card with a capacity greater than 32MB with the FAT32
format. Most digital cameras use the FAT (FAT16 & FAT12)
format and can not operate with a FAT32 formatted card.

Either format the media card in the digital camera or select FAT
file system to format the media card in a computer with
Windows XP or Windows Vista.

A write-protected or locked error occurs when attempting to write to the media card.

Cause Solution

Media card is locked. Locking the media card is a safety feature
that prevents writing to and deleting from an SD/Memory Stick/
PRO card.

If using an SD card, make sure that the lock tab located on the
right of the SD card is not in the locked position. If using a
Memory Stick/PRO card, make sure that the lock tab located
on the bottom of the Memory Stick/PRO card is not in the
locked position.

Can not write to the media card.

Cause Solution

The media card is a read-only memory (ROM) card. Check the manufacturer’s documentation included with your
card to see if it writable. Refer to the previous section for a list
of compatible cards.

Media card is locked. Locking the media card is a safety feature
that prevents writing to and deleting from an SD/Memory Stick/
PRO card.

If using an SD card, make sure that the lock tab located on the
right of the SD card is not in the locked position. If using a
Memory Stick/PRO card, make sure that the lock tab located
on the bottom of the Memory Stick/PRO card is not in the
locked position.

Unable to access data on the media card after inserting it into a slot.

Cause Solution

The media card is not inserted properly, is inserted in the wrong
slot, or is not supported.

Ensure that the card is inserted properly with the gold contact
on the correct side. The green LED will light if inserted properly.

Do not know how to remove a media card correctly.

Cause Solution

The computer’s software is used to safely eject the card. Open My Computer (Windows XP) or Computer (Windows
Vista), right-click on the corresponding drive icon, and select
Eject. Then pull the card out of the slot.

NOTE: Never remove the card when the green LED is
flashing
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After installing the media card reader and booting to Windows, the reader and the inserted cards are not recognized
by the computer.

Cause Solution

The operating system needs time to recognize the device if the
reader was just installed into the computer and you are turning
the PC on for the first time.

Wait a few seconds so that the operating system can recognize
the reader and the available ports, and then recognize
whatever media is inserted in the reader.

After inserting a media card in the reader, the computer attempts to boot from the media card.

Cause Solution

The inserted media card has boot capability. If you do not want to boot from the media card, remove it during
boot or do not select the option to boot from the inserted media
card during the boot process.

Solving Display Problems
If you encounter display problems, see the documentation that came with the monitor and to the common
causes and solutions listed in the following table.

Table D-5  Solving Display Problems

Blank screen (no video).

Cause Solution

Monitor is not turned on and the monitor light is not on. Turn on the monitor and check that the monitor light is on.

Bad monitor. Try a different monitor.

The cable connections are not correct. Check the cable connection from the monitor to the computer
and to the electrical outlet.

You may have a screen blanking utility installed or energy
saver features are enabled.

Press any key or click the mouse button and, if set, type your
password.

System ROM is corrupted; system is running in Boot Block
Emergency Recovery Mode (indicated by eight beeps).

Reflash the system ROM with the latest BIOS image. See the
“Boot Block Emergency Recovery Mode” section of the
Desktop Management Guide for more information

You are using a fixed-sync monitor and it will not sync at the
resolution chosen.

Be sure that the monitor can accept the same horizontal scan
rate as the resolution chosen.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby mode,
do not hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Monitor cable is plugged into the wrong connector. If the computer system has both an integrated graphics
connector and an add-in graphics card connector, plug the
monitor cable into the graphics card connector on the back of
the computer.

Table D-4  Solving Media Card Reader Problems (continued)
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Blank screen (no video).

Cause Solution

Monitor settings in the computer are not compatible with the
monitor.

1. In Windows XP Control Panel, double-click the Display
icon and select the Settings tab.

In Windows Vista Control Panel, under Appearance and
Personalization, select Adjust screen resolution.

2. Use the sliding control to reset the resolution.

Monitor is configured to use an input that is not active. Use the monitor's on-screen menu controls to select the input
that is being driven by the system. Refer to the monitor's user
documentation for more information on the on-screen controls
and settings.

Cannot enable integrated graphics after installing a PCI Express graphics card.

Cause Solution

On systems with Intel integrated graphics, the integrated
graphics cannot be enabled after installing a PCI Express x16.

The integrated graphics can be enabled in Computer Setup if
a PCI or PCI Express x1 graphics card is installed, but it cannot
be enabled if there is a graphics card in the PCI Express x16
slot.

On systems with AMD integrated graphics, the integrated
graphics can be enabled in Computer Setup only if an AMD
PCI Express x16 graphics card is installed.

On systems with AMD integrated graphics, install an AMD PCI
Express x16 graphics card and enable the integrated graphics
in Computer Setup.

Blank screen and the power LED flashes Red five times, once every second, followed by a two second pause, and the
computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video memory error. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Blank screen and the power LED flashes Red six times, once every second, followed by a two second pause, and the
computer beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card. Power on the system.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the system
board.

Table D-5  Solving Display Problems (continued)
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Blank screen and the power LED flashes Red seven times, once every second, followed by a two second pause, and
the computer beeps seven times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

System board failure (ROM detected failure prior to video). Replace the system board.

Monitor does not function properly when used with energy saver features.

Cause Solution

Monitor without energy saver capabilities is being used with
energy saver features enabled.

Disable monitor energy saver feature.

Dim characters.

Cause Solution

The brightness and contrast controls are not set properly. Adjust the monitor brightness and contrast controls.

Cables are not properly connected. Check that the graphics cable is securely connected to the
graphics card and the monitor.

Blurry video or requested resolution cannot be set.

Cause Solution

If the graphics controller was upgraded, the correct graphics
drivers may not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of displaying requested resolution. Change requested resolution.

Graphics card is bad. Replace the graphics card.

The picture is broken up, rolls, jitters, or flashes.

Cause Solution

The monitor connections may be incomplete or the monitor
may be incorrectly adjusted.

1. Be sure the monitor cable is securely connected to the
computer.

2. In a two-monitor system or if another monitor is in close
proximity, be sure the monitors are not interfering with
each other’s electromagnetic field by moving them apart.

3. Fluorescent lights or fans may be too close to the monitor.

Monitor needs to be degaussed. Degauss the monitor. Refer to the documentation that came
with the monitor for instructions.

Table D-5  Solving Display Problems (continued)
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Image is not centered.

Cause Solution

Position may need adjustment. Press the monitor's Menu button to access the OSD menu.
Select ImageControl/ Horizontal Position or Vertical
Position to adjust the horizontal or vertical position of the
image.

“No Connection, Check Signal Cable” displays on screen.

Cause Solution

Monitor video cable is disconnected. Connect the video cable between the monitor and computer.

CAUTION: Ensure that the computer power is off while
connecting the video cable.

“Out of Range” displays on screen.

Cause Solution

Video resolution and refresh rate are set higher than what the
monitor supports.

Restart the computer and enter Safe Mode. Change the
settings to a supported setting then restart the computer so that
the new settings take effect.

Vibrating or rattling noise coming from inside a CRT monitor when powered on.

Cause Solution

Monitor degaussing coil has been activated. None. It is normal for the degaussing coil to be activated when
the monitor is powered on.

Clicking noise coming from inside a CRT monitor.

Cause Solution

Electronic relays have been activated inside the monitor. None. It is normal for some monitors to make a clicking noise
when turned on and off, when going in and out of standby
mode, and when changing resolutions.

High pitched noise coming from inside a flat panel monitor.

Cause Solution

Brightness and/or contrast settings are too high. Lower brightness and/or contrast settings.

Table D-5  Solving Display Problems (continued)
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Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or unable to
center the picture on the screen (flat panel monitors using an analog VGA input connection only).

Cause Solution

Flat panel monitor’s internal digital conversion circuits may be
unable to correctly interpret the output synchronization of the
graphics card.

1. Select the monitor’s Auto-Adjustment option in the
monitor’s on-screen display menu.

2. Manually synchronize the Clock and Clock Phase on-
screen display functions. To download a SoftPaq that will
assist you with the synchronization, go to the following
Web site, select the appropriate monitor, and download
either SP32347 or SP32202: http://www.hp.com/support

Graphics card is not seated properly or is bad. 1. Reseat the graphics card.

2. Replace the graphics card.

Certain typed symbols do not appear correct.

Cause Solution

The font you are using does not support that particular symbol. Use the Character Map to locate and select the appropriate
symbol. Click Start > All Programs > Accessories > System
Tools > Character Map. You can copy the symbol from the
Character Map into a document.

Solving Audio Problems
If the computer has audio features and you encounter audio problems, see the common causes and
solutions listed in the following table.

Table D-6  Solving Audio Problems

Sound cuts in and out.

Cause Solution

Processor resources are being used by other open
applications.

Shut down all open processor-intensive applications.

Direct sound latency, common in many media player
applications.

In Windows XP only:

1. From the Control Panel, select Sounds and Audio
Devices.

2. On the Audio tab, select a device from the Sound
Playback list.

3. Click the Advanced button and select the Performance
tab.

4. Set the Hardware acceleration slider to None and the
Sample rate conversion quality slider to Good and
retest the audio.

5. Set the Hardware acceleration slider to Full and the
Sample rate conversion quality slider to Best and
retest the audio.

Table D-5  Solving Display Problems (continued)
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Sound does not come out of the speaker or headphones.

Cause Solution

Software volume control is turned down or muted. Double-click the Speaker icon on the taskbar, then make sure
that Mute is not selected and use the volume slider to adjust
the volume.

Audio is hidden in Computer Setup. Enable the audio in Computer Setup: Security >
Device Security > System Audio.

The external speakers are not turned on. Turn on the external speakers.

The audio device may be connected to the wrong jack. Ensure that the device is connected to the correct jack on the
computer. The speakers should be plugged into the rear line-
out jack and the headphones should be plugged into the front
headphone jack.

External speakers plugged into the wrong audio jack on a
recently installed sound card.

See the sound card documentation for proper speaker
connection.

Digital CD audio is not enabled. Enable digital CD audio. In the Device Manager, right-click on
the CD/DVD device and select Properties. Make sure Enable
digital CD audio for this CD-ROM device is checked.

Headphones or devices connected to the line-out connector
mute the internal speaker.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external speakers.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby mode,
do not hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Internal speaker is disabled in Computer Setup. Enable the internal speaker in Computer Setup. Select
Advanced > Device Options > Internal Speaker.

One or more audio solutions are installed in the system. Ensure that your application is set to use the correct audio
device.

Sound from headphones is not clear or muffled.

Cause Solution

Headphones are plugged into the rear audio output connector.
The rear audio output connector is for powered audio devices
and is not designed for headphone use.

Plug the headphones into the headphone connector on the
front of the computer.

Computer appears to be locked up while recording audio.

Cause Solution

The hard disk may be full. Before recording, make sure there is enough free space on the
hard disk. You can also try recording the audio file in a
compressed format.

Table D-6  Solving Audio Problems (continued)
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Line-in jack is not functioning properly.

Cause Solution

Jack has been reconfigured in the audio driver or application
software.

In the audio driver or application software, reconfigure the jack
or set the jack to its default value.

Headphone/Microphone jack on the front of the computer is not functioning properly.

Cause Solution

Jack has been reconfigured in the audio driver or application
software.

In the audio driver or application software, reconfigure the jack
or set the jack to its default value.

Table D-6  Solving Audio Problems (continued)

214 Appendix D   Troubleshooting Without Diagnostics



Solving Printer Problems
If you encounter printer problems, see the documentation that came with the printer and to the common
causes and solutions listed in the following table.

Table D-7  Solving Printer Problems

Printer will not print.

Cause Solution

Printer is not turned on and online. Turn the printer on and make sure it is online.

The correct printer drivers for the application are not installed. 1. Install the correct printer driver for the application.

2. Try printing using the MS-DOS command:

DIR C:\ > [printer port]

where [printer port] is the address of the printer being
used. If the printer works, reload the printer driver.

If you are on a network, you may not have made the connection
to the printer.

Make the proper network connections to the printer.

Printer may have failed. Run printer self-test.

Printer will not turn on.

Cause Solution

The cables may not be connected properly. Reconnect all cables and check the power cord and electrical
outlet.

Printer prints garbled information.

Cause Solution

The correct printer driver for the application is not installed. Install the correct printer driver for the application.

The cables may not be connected properly. Reconnect all cables.

Printer memory may be overloaded. Reset the printer by turning it off for one minute, then turn it
back on.

Printer is offline.

Cause Solution

The printer may be out of paper. Check the paper tray and refill it if it is empty. Select online.
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Solving Keyboard and Mouse Problems
If you encounter keyboard or mouse problems, see the documentation that came with the equipment
and to the common causes and solutions listed in the following table.

Table D-8  Solving Keyboard Problems

Keyboard commands and typing are not recognized by the computer.

Cause Solution

Keyboard connector is not properly connected. 1. On the Windows XP Desktop, click Start > Shut Down.

On the Windows Vista Desktop, click Start, click the
arrow on the lower right corner of the Start menu, then
select Shut Down.

2. After the shutdown is complete, reconnect the keyboard
to the back of the computer and restart the computer.

Program in use has stopped responding to commands. Shut down your computer using the mouse and then restart
the computer.

Keyboard needs repairs. See the Worldwide Limited Warranty for terms and conditions.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby mode,
do not hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key may be on. Press the Num Lock key. The Num Lock light should not be on
if you want to use the arrow keys. The Num Lock key can be
disabled (or enabled) in Computer Setup.

Table D-9  Solving Mouse Problems

Mouse does not respond to movement or is too slow.

Cause Solution

Mouse connector is not properly plugged into the back of the
computer.

Shut down the computer using the keyboard.

1. Press the Ctrl and Esc keys at the same time (or press
the Windows logo key) to display the Start menu.

2. Use the arrow keys to select Shut Down and then press
the Enter key.

3. After the shutdown is complete, plug the mouse
connector into the back of the computer (or the keyboard)
and restart.

Program in use has stopped responding to commands. Shut down the computer using the keyboard then restart the
computer.
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Mouse does not respond to movement or is too slow.

Cause Solution

Mouse may need cleaning. Remove the roller ball cover on the mouse and clean the
internal components.

Mouse may need repair. See the Worldwide Limited Warranty for terms and conditions.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby mode,
do not hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Mouse will only move vertically, horizontally, or movement is jerky.

Cause Solution

Mouse roller ball or the rotating encoder shafts that make
contact with the ball are dirty.

Remove roller ball cover from the bottom of the mouse and
clean the internal components with a mouse cleaning kit
available from most computer stores.

Solving Hardware Installation Problems
You may need to reconfigure the computer when you add or remove hardware, such as an additional
drive or expansion card. If you install a plug and play device, Windows automatically recognizes the
device and configures the computer. If you install a non–plug and play device, you must reconfigure the
computer after completing installation of the new hardware. In Windows, use the Add Hardware
Wizard and follow the instructions that appear on the screen.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to the
system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure
to disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.

Table D-10  Solving Hardware Installation Problems

A new device is not recognized as part of the system.

Cause Solution

Device is not seated or connected properly. Ensure that the device is properly and securely connected and
that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables are
unplugged.

Ensure that all cables are properly and securely connected and
that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on. Turn off the computer, turn on the external device, then turn on
the computer to integrate the device with the computer system.

When the system advised you of changes to the configuration,
you did not accept them.

Reboot the computer and follow the instructions for accepting
the changes.

Table D-9  Solving Mouse Problems (continued)
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A new device is not recognized as part of the system.

Cause Solution

A plug and play board may not automatically configure when
added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic
settings for the board and choose a basic configuration that
does not cause a resource conflict. You can also use Computer
Setup to reconfigure or disable devices to resolve the resource
conflict.

USB ports on the computer are disabled in Computer Setup. Enter Computer Setup (F10) and enable the USB ports.

Computer will not start.

Cause Solution

Wrong memory modules were used in the upgrade or memory
modules were installed in the wrong location.

1. Review the Hardware Reference Guide for your system
to determine if you are using the correct memory modules
and to verify the proper installation.

2. Observe the beeps and LED lights on the front of the
computer. Beeps and flashing LEDs are codes for
specific problems.

3. If you still cannot resolve the issue, contact Customer
Support.

Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps five
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. CAUTION: To avoid damage to the DIMMs or the system
board, you must unplug the computer power cord before
attempting to reseat, install, or remove a DIMM module.

1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty module.

NOTE: Refer to the Hardware Reference Guide for your
system for proper DIMM installation instructions.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Table D-10  Solving Hardware Installation Problems (continued)
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Power LED flashes Red six times, once every second, followed by a two second pause, and the computer beeps six
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Graphics card is not seated properly or is bad, or system board
is bad.

For systems with a graphics card:

1. Reseat the graphics card. Power on the system.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the system
board.

Power LED flashes Red ten times, once every second, followed by a two second pause, and the computer beeps ten
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Bad option card. 1. Check each option card by removing the cards one at time
(if multiple cards), then power on the system to see if fault
goes away.

2. Once bad card is identified, remove and replace bad
option card.

3. Replace the system board.

Table D-10  Solving Hardware Installation Problems (continued)
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Solving Network Problems
Some common causes and solutions for network problems are listed in the following table. These
guidelines do not discuss the process of debugging the network cabling.

Table D-11  Solving Network Problems

Wake-on-LAN feature is not functioning.

Cause Solution

Wake-on-LAN is not enabled. To enable Wake-on-LAN in Windows XP:

1. Select Start > Control Panel.

2. Double-click Network Connections.

3. Double-click Local Area Connection.

4. Click Properties.

5. Click Configure.

6. Click the Power Management tab, then select the check
box to Allow this device to bring the computer out of
standby.

To enable Wake-on-LAN in Windows Vista:

1. Select Start > Control Panel.

2. Under Network and Internet, select View network
status and tasks.

3. In the Tasks list, select Manage network connections.

4. Double-click Local Area Connection.

5. Click the Properties button.

6. Click the Configure button.

7. Click the Power Management tab, then select the check
box to Allow this device to wake the computer.

Network driver does not detect network controller.

Cause Solution

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system via
Device Manager.

Incorrect network driver. Check the network controller documentation for the correct
driver or obtain the latest driver from the manufacturer’s Web
site.
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Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause Solution

No active network is detected. Check cabling and network equipment for proper connection.

Network controller is not set up properly. Check for the device status within Windows, such as Device
Manager for driver load and the Network Connections applet
within Windows for link status.

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system via
Device Manager.

Network driver is not properly loaded. Reinstall network drivers.

System cannot autosense the network. Disable auto-sensing capabilities and force the system into the
correct operating mode.

Diagnostics reports a failure.

Cause Solution

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The cable is attached to the incorrect connector. Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other end
of the cable.

Ensure that the cable and device at the other end are operating
correctly.

Network controller interrupt is shared with an expansion board. Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller is defective. Contact an authorized service provider.

Diagnostics passes, but the computer does not communicate with the network.

Cause Solution

Network drivers are not loaded, or driver parameters do not
match current configuration.

Make sure the network drivers are loaded and that the driver
parameters match the configuration of the network controller.

Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer. Select the Network icon in the Control Panel and configure
the network controller.

Network controller stopped working when an expansion board was added to the computer.

Cause Solution

Network controller interrupt is shared with an expansion board. Under the Computer Setup Advanced menu, change the
resource settings for the board.

Table D-11  Solving Network Problems (continued)
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Network controller stopped working when an expansion board was added to the computer.

Cause Solution

The network controller requires drivers. Verify that the drivers were not accidentally deleted when the
drivers for a new expansion board were installed.

The expansion board installed is a network card (NIC) and
conflicts with the embedded NIC.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

Network controller stops working without apparent cause.

Cause Solution

The files containing the network drivers are corrupted. Reinstall the network drivers.

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The network controller is defective. Contact an authorized service provider.

New network card will not boot.

Cause Solution

New network card may be defective or may not meet industry-
standard specifications.

Install a working, industry-standard NIC, or change the boot
sequence to boot from another source.

Cannot connect to network server when attempting Remote System Installation.

Cause Solution

The network controller is not configured properly. Verify Network Connectivity, that a DHCP Server is present,
and that the Remote System Installation Server contains the
NIC drivers for your NIC.

System setup utility reports unprogrammed EEPROM.

Cause Solution

Unprogrammed EEPROM. Contact an authorized service provider.

Table D-11  Solving Network Problems (continued)
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Solving Memory Problems
If you encounter memory problems, some common causes and solutions are listed in the following table.

CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending on
the Management Engine (ME) settings on some models). To avoid damage to the DIMMs or the system
board, you must unplug the computer power cord before attempting to reseat, install, or remove a DIMM
module.

For those systems that support ECC memory, HP does not support mixing ECC and non-ECC memory.
Otherwise, the computer will not boot the operating system.

NOTE: On some models. the memory count will be affected by configurations with the Management
Engine (ME) enabled. The ME uses 8MB of system memory in single channel mode or 16MB of memory
in dual-channel mode to download, decompress, and execute the ME firmware for Out-of-Band (OOB),
third-party data storage, and other management functions.

Table D-12  Solving Memory Problems

System will not boot or does not function properly after installing additional memory modules.

Cause Solution

On Intel systems, A memory module is not installed in the
DIMM1 socket.

Ensure that a memory module is installed in the black DIMM1
socket on the system board. This socket must be populated
with a memory module. Populate DIMM sockets in the
following order for Intel systems: DIMM1, DIMM3, DIMM2,
DIMM4.

On AMD systems, a memory module is not installed in the
system board memory socket.

The sockets must be populated with at least one memory
module. Install memory modules in the following order: XMM4,
XMM3, XMM2, XMM1.

Memory module is not the correct type or speed grade for the
system or the new memory module is not seated properly.

Replace module with the correct industry-standard device for
the computer. On some models, ECC and non-ECC memory
modules cannot be mixed.

Out of memory error.

Cause Solution

Memory configuration may not be set up correctly. Use the Device Manager to check memory configuration.

You have run out of memory to run the application. Check the application documentation to determine the memory
requirements.

Memory count during POST is wrong.

Cause Solution

The memory modules may not be installed correctly. Check that the memory modules have been installed correctly
and that proper modules are used.

Integrated graphics may use system memory. No action required.
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Insufficient memory error during operation.

Cause Solution

Too many Terminate and Stay Resident programs (TSRs) are
installed.

Delete any TSRs that you do not need.

You have run out of memory for the application. Check the memory requirements for the application or add
more memory to the computer.

Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps five
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Solving Processor Problems
If you encounter processor problems, common causes and solutions are listed in the following table.

Table D-13  Solving Processor Problems

Poor performance is experienced.

Cause Solution

Processor is hot. 1. Make sure the airflow to the computer is not blocked.

2. Make sure the fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Power LED flashes Red three times, once every second, followed by a two second pause.

Cause Solution

Processor is not seated properly or not installed. 1. Check to see that the processor is present.

2. Reseat the processor.

Table D-12  Solving Memory Problems (continued)
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Power LED flashes Red eleven times, once every second, followed by a two second pause.

Cause Solution

The current processor does not support a feature previously
enabled on this system.

1. Install a TXT capable processor.

2. Disable TXT in the Computer Setup (F10) utility.

3. Reinstall the original processor.

Solving CD-ROM and DVD Problems
If you encounter CD-ROM or DVD problems, see the common causes and solutions listed in the
following table or to the documentation that came with the optional device.

Table D-14  Solving CD-ROM and DVD Problems

System will not boot from CD-ROM or DVD drive.

Cause Solution

The device is attached to a SATA port that has been hidden in
the Computer Setup utility.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure CD-
ROM is enabled in Storage > Boot Order.

Network Server Mode is enabled in Computer Setup. Run the Computer Setup utility and disable Network Server
Mode in Security > Password Options.

Non-bootable CD in drive. Try a bootable CD in the drive.

Boot order not correct. Run the Computer Setup utility and change boot sequence
in Storage > Boot Order.

Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 217. If the system still does not
recognize the new device, check to see if the device is listed
within Computer Setup. If it is listed, the probable cause is a
driver problem. If it is not listed, the probable cause is a
hardware problem.

If this is a newly installed drive, run the Computer Setup utility
and try adding a POST delay under Advanced > Power-On
Options.

The device is attached to a SATA port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up. Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.
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CD-ROM or DVD devices are not detected or driver is not loaded.

Cause Solution

Drive is not connected properly or not properly configured. See the documentation that came with the optional device.

Movie will not play in the DVD drive.

Cause Solution

Movie may be regionalized for a different country. See the documentation that came with the DVD drive.

Decoder software is not installed. Install decoder software.

Damaged media. Replace media.

Movie rating locked out by parental lock. Use DVD software to remove parental lock.

Media installed upside down. Reinstall media.

Cannot eject compact disc (tray-load unit).

Cause Solution

Disc not properly seated in the drive. Turn off the computer and insert a thin metal rod into the
emergency eject hole and push firmly. Slowly pull the tray out
from the drive until the tray is fully extended, then remove
the disc.

CD-ROM, CD-RW, DVD-ROM, or DVD-R/RW drive cannot read a disc or takes too long to start.

Cause Solution

Media has been inserted upside down. Re-insert the media with the label facing up.

The DVD-ROM drive takes longer to start because it has to
determine the type of media played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive determine
the type of media being played. If the disc still does not start,
read the other solutions listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD cleaning kit, available from most
computer stores.

Windows does not detect the CD-ROM or DVD-ROM drive. 1. Use Device Manager to remove or uninstall the device.

2. Restart the computer and let Windows detect the CD or
DVD driver.

Recording or copying CDs is difficult or impossible.

Cause Solution

Wrong or poor quality media type. 1. Try using a slower speed when recording.

2. Verify that you are using the correct media for the drive.

3. Try a different brand of media. Quality varies widely
between manufacturers.

Table D-14  Solving CD-ROM and DVD Problems (continued)
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Solving USB Flash Drive Problems
If you encounter USB flash drive problems, common causes and solutions are listed in the following
table.

Table D-15  Solving USB Flash Drive Problems

USB flash drive is not seen as a drive letter in Windows.

Cause Solution

The drive letter after the last physical drive is not available. Change the default drive letter for the flash drive in Windows.

USB flash drive not found (identified).

Cause Solution

The device is attached to a USB port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure that “Device
Available” is selected for the USB Ports under Security >
Device Security.

The device was not properly seated before power-up. Ensure the device is fully inserted into the USB port before
applying power to the system

System will not boot from USB flash drive.

Cause Solution

Boot order is not correct. Run the Computer Setup utility and change boot sequence
in Storage > Boot Order.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure USB
is enabled in Storage > Boot Order.

The image on the device is not bootable. Follow the procedures described in the “ROM Flash:
Replicating the Setup: Creating a Bootable Device: Supported
USB Flash Media Device” section of the Service Reference
Guide.

The computer boots to DOS after making a bootable flash drive.

Cause Solution

Flash drive is bootable. Install the flash drive only after the operating system boots.
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Solving Front Panel Component Problems
If you encounter problems with devices connected to the front panel, refer to the common causes and
solutions listed in the following table.

Table D-16  Solving Front Panel Component Problems

A USB device, headphone, or microphone is not recognized by the computer.

Cause Solution

Device is not properly connected. 1. Turn off the computer.

2. Reconnect the device to the front of the computer and
restart the computer.

The device does not have power. If the USB device requires AC power, be sure one end is
connected to the device and one end is connected to a live
outlet.

The correct device driver is not installed. 1. Install the correct driver for the device.

2. You might need to reboot the computer.

The cable from the device to the computer does not work. 1. If possible, replace the cable.

2. Restart the computer.

The device is not working. 1. Replace the device.

2. Restart the computer.

USB ports on the computer are disabled in Computer Setup. Enter Computer Setup (F10) and enable the USB ports.

Solving Internet Access Problems
If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the
common causes and solutions listed in the following table.

Table D-17  Solving Internet Access Problems

Unable to connect to the Internet.

Cause Solution

Internet Service Provider (ISP) account is not set up properly. Verify Internet settings or contact your ISP for assistance.

Modem is not set up properly. Reconnect the modem. Verify the connections are correct
using the quick setup documentation.

Web browser is not set up properly. Verify that the Web browser is installed and set up to work with
your ISP.

Cable/DSL modem is not plugged in. Plug in cable/DSL modem. You should see a “power” LED light
on the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted due
to bad weather.

Try connecting to the Internet at a later time or contact your
ISP. (If the cable/DSL service is connected, the “cable” LED
light on the front of the cable/DSL modem will be on.)

The CAT5 UTP cable is disconnected. Connect the CAT5 UTP cable between the cable modem and
the computers’s RJ-45 connector. (If the connection is good,
the “PC” LED light on the front of the cable/DSL modem will be
on.)
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Unable to connect to the Internet.

Cause Solution

IP address is not configured properly. Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of
information that a Web server can store temporarily with the
Web browser. This is useful for having the browser remember
some specific information that the Web server can later
retrieve.)

Windows Vista

1. Select Start > Control Panel.

2. Click Network and Internet.

3. Click Internet Options.

4. In the Browsing history section on the General tab, click
the Delete button.

5. Click the Delete cookies button.

Windows XP

1. Select Start > Control Panel.

2. Double-click Internet Options.

3. On the General tab, click the Delete Cookies button.

Cannot automatically launch Internet programs.

Cause Solution

You must log on to your ISP before some programs will start. Log on to your ISP and launch the desired program.

Table D-17  Solving Internet Access Problems (continued)
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Internet takes too long to download Web sites.

Cause Solution

Modem is not set up properly. Verify that the modem is connected and communicating
properly.

Windows XP

1. Select Start > Control Panel.

2. Double-click System.

3. Click the Hardware tab.

4. In the Device Manager area, click the Device Manager
button.

5. Double-click Modems.

6. Double-click Agere Systems PCI-SV92PP Soft
Modem.

7. On the General tab, click Diagnostics.

8. Click Query Modem. A “Success” response indicates the
modem is connected and working properly.

Windows Vista

1. Select Start > Control Panel.

2. Click on System and Maintenance.

3. Click on System.

4. In the Tasks list, select Device Manager.

5. Double-click Modems.

6. Double-click Agere Systems PCI-SV92PP Soft
Modem.

7. On the General tab, click Diagnostics.

8. Click Query Modem. A “Success” response indicates the
modem is connected and working properly.

Table D-17  Solving Internet Access Problems (continued)
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Solving Software Problems
Most software problems occur as a result of the following:

● The application was not installed or configured correctly.

● There is insufficient memory available to run the application.

● There is a conflict between applications.

● Be sure that all the needed device drivers have been installed.

● If you have installed an operating system other than the factory-installed operating system, check
to be sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.

Table D-18  Solving Software Problems

Computer will not continue and no HP logo screen has appeared.

Cause Solution

POST error has occurred. Observe the beeps and LED lights on the front of the computer.
See Appendix A, POST Error Messages on page 185 to
determine possible causes.

See the Restore Kit or the Worldwide Limited Warranty for
terms and conditions.

Computer will not continue after HP logo screen has appeared.

Cause Solution

System files may be damaged. Press the F11 key at startup to boot into the recovery partition
and run a factory restore.

CAUTION: Restoring the system will erase all data on the
hard drive. Be sure to back up all data files before running the
restore process.

“Illegal Operation has Occurred” error message is displayed.

Cause Solution

Software being used is not Microsoft-certified for your version
of Windows.

Verify that the software is certified by Microsoft for your version
of Windows (see program packaging for this information).

Configuration files are corrupt. If possible, save all data, close all programs, and restart the
computer.
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Contacting Customer Support
For help and service, contact an authorized reseller or dealer. To locate a reseller or dealer near you,
visit http://www.hp.com.

NOTE: If you take the computer to an authorized reseller, dealer, or service provider for service,
remember to provide the setup and power-on passwords if they are set.

Refer to the number listed in the warranty or in the Support Telephone Numbers guide for technical
assistance.
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E Password Security and Resetting
CMOS

This computer supports security password features, which can be established through the Computer
Setup Utilities menu.

This computer supports two security password features that are established through the Computer
Setup Utilities menu: setup password and power-on password. When you establish only a setup
password, any user can access all the information on the computer except Computer Setup. When you
establish only a power-on password, the power-on password is required to access Computer Setup and
any other information on the computer. When you establish both passwords, only the setup password
will give you access to Computer Setup.

When both passwords are set, the setup password can also be used in place of the power-on password
as an override to log in to the computer. This is a useful feature for a network administrator.

If you forget the password for the computer, you can clear that password so you can gain access to the
information on the computer by resetting the password jumper.

CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important to
back up the computer CMOS settings before resetting them in case they are needed later. Back up is
easily done through Computer Setup. See the Computer Setup (F10) Utility Guide for information on
backing up the CMOS settings.
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Resetting the Password Jumper
To disable the power-on or setup password features, or to clear the power-on or setup passwords,
complete the following steps:

1. Shut down the operating system properly, then turn off the computer and any external devices,
and disconnect the power cord from the power outlet.

2. With the power cord disconnected, press the power button again to drain the system of any residual
power.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system components
to cool before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can result
in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Safety & Regulatory Information guide for more
information.

3. Remove the computer cover or access panel.

4. Locate the header and jumper.

NOTE: The password jumper is green so that it can be easily identified. For assistance locating
the password jumper and other system board components, see the Illustrated Parts & Service Map
(IPSM) for that particular system. The IPSM can be downloaded from http://www.hp.com/
support.

5. Remove the jumper from pins 1 and 2. Place the jumper on either pin 1 or 2, but not both, so that
it does not get lost.

6. Replace the computer cover or access panel.

7. Reconnect the external equipment.

8. Plug in the computer and turn on power. Allow the operating system to start. This clears the current
passwords and disables the password features.

9. To establish new passwords, repeat steps 1 through 4, replace the password jumper on pins 1 and
2, then repeat steps 6 through 8. Establish the new passwords in Computer Setup. Refer to the
Computer Setup (F10) Utility Guide for Computer Setup instructions.
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Clearing and Resetting the CMOS
The computer’s configuration memory (CMOS) stores information about the computer’s configuration.

The CMOS button resets CMOS but does not clear the power-on and setup passwords.

Clearing CMOS will clear the Active Management Technology (AMT) settings in the Management
Engine BIOS Extension (MEBx), including the password. The password will default to “admin” and will
need to be reset. The AMT settings will also need to be reset. To access the MEBx, press Ctrl+P during
POST.

1. Turn off the computer and any external devices, and disconnect the power cord from the power
outlet.

2. Disconnect the keyboard, monitor, and any other external equipment connected to the computer.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system components
to cool before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can result
in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Safety & Regulatory Information guide for more
information.

3. Remove the computer cover or access panel.

CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important
to back up the computer CMOS settings before resetting them in case they are needed later. Back
up is easily done through Computer Setup. See the Computer Setup (F10) Utility Guide for
information on backing up the CMOS settings.

Clearing and Resetting the CMOS 235



4. Locate, press, and hold the CMOS button in for five seconds.

NOTE: Make sure you have disconnected the AC power cord from the wall outlet. The CMOS
button will not clear CMOS if the power cord is connected.

Figure E-1  CMOS button

NOTE: For assistance locating the CMOS button and other system board components, see the
Illustrated Parts & Service Map (IPSM) for that particular system.

5. Replace the computer cover or access panel.

6. Reconnect the external devices.

7. Plug in the computer and turn on power.

NOTE: You will receive POST error messages after clearing CMOS and rebooting advising you
that configuration changes have occurred. Use Computer Setup to reset any special system setups
along with the date and time.

For instructions on Computer Setup, see the Computer Setup (F10) Utility Guide.
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F Specifications

This chapter provides specifications for the microtower and small form factor chassis.

Microtower Chassis
Table F-1  Specifications

Desktop Dimensions

Height

Width

Depth

14.85 in

6.95 in

16.85 in

37.72 cm

17.65 cm

42.80 cm

Approximate Weight 23.5 lb 10.66 kg

Temperature Range

Operating

Nonoperating

50° to 95°F

-22° to 140°F

10° to 35°C

-30° to 60°C

Relative Humidity (noncondensing)

Operating

Nonoperating (38.7°C max wet bulb)

10-90%

5-95%

10-90%

5-95%

Maximum Altitude (unpressurized)

Operating

Nonoperating

10,000 ft

30,000 ft

3048 m

9144 m

NOTE: Operating temperature is derated 1.0° C per 300 m (1000 ft) to 3000 m (10,000 ft) above sea level; no direct sustained
sunlight. Maximum rate of change is 10° C/Hr. The upper limit may be limited by the type and number of options installed.

Heat Dissipation

Max STD PS

Typical STD PS idle

Max EPA 87/89/85% @ 20/50/100% load PS

Typical EPA 87/89/85% @ 20/50/100% load PS idle

1410 BTU/hr

TBD BTU/hr

1255 BTU/hr

TBD BTU/hr

356 kg-cal/hr

TBD kg-cal/hr

316 kg-cal/hr

TBD kg-cal/hr
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Power Supply

Operating Voltage Range (STD PS)

Operating Voltage Range (EPA 87/89/85% @ 20/50/100% load PS)

Rated Voltage Range (STD PS)

Rated Voltage Range (EPA 87/89/85% @ 20/50/100% load PS)

Rated Line Frequency

115V

90-264 VAC

90-264 VAC

100-240 VAC

100-240 VAC

50-60 Hz

230V

90-264 VAC

90-264 VAC

100-240 VAC

100-240 VAC

50-60 Hz

Power Output 320W 320W

Rated Input Current (maximum)1

STD PS

EPA 87/89/85% @ 20/50/100% load PS

5.5A @ 115 VAC

5.5A @ 115 VAC

2.75A @ 230 VAC

2.75A @ 230 VAC

1 This system utilizes an active power factor corrected power supply. This allows the system to pass the CE mark requirements
for use in the countries of the European Union. The active power factor corrected power supply also has the added benefit of
not requiring an input voltage range select switch.

Table F-1  Specifications (continued)
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Small Form Factor Chassis
Table F-2  Specifications

Desktop Dimensions (in the desktop position)

Height

Width

Depth

3.95 in

13.3 in

14.9 in

10.0 cm

33.8 cm

37.8 cm

Approximate Weight 19 lb 8.6 kg

Weight Supported (maximum distributed load in desktop position) 77 lb 35 kg

Temperature Range

Operating

Nonoperating

50° to 95°F

-22° to 140°F

10° to 35°C

-30° to 60°C

NOTE: Operating temperature is derated 1.0° C per 300 m (1000 ft) to 3000 m (10,000 ft) above sea level; no direct sustained
sunlight. Maximum rate of change is 10° C/Hr. The upper limit may be limited by the type and number of options installed.

Relative Humidity (noncondensing)

Operating

Nonoperating (38.7°C max wet bulb)

10-90%

5-95%

10-90%

5-95%

Maximum Altitude (unpressurized)

Operating

Nonoperating

10,000 ft

30,000 ft

3048 m

9144 m

Heat Dissipation

Max STD PS

Typical STD PS idle

Max EPA 87/89/85% @ 20/50/100% load PS

Typical EPA 87/89/85% @ 20/50/100% load PS idle

1063 BTU/hr

TBD BTU/hr

941 BTU/hr

TBD BTU/hr

268 kg-cal/hr

TBD kg-cal/hr

237 kg-cal/hr

TBD kg-cal/hr

Power Supply

Operating Voltage Range (STD PS)

Operating Voltage Range (EPA 87/89/85% @ 20/50/100% load PS)

Rated Voltage Range (STD PS)

Rated Voltage Range (EPA 87/89/85% @ 20/50/100% load PS)

Rated Line Frequency

115V

90-264 VAC

90-264 VAC

100-240 VAC

100-240 VAC

50-60 Hz

230V

90-264 VAC

90-264 VAC

100-240 VAC

100-240 VAC

50-60 Hz

Power Output 240W 240W
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Rated Input Current (maximum)1

STD PS

EPA 87/89/85% @ 20/50/100% load PS

4A @ 100 VAC

4A @ 100 VAC

2A @ 230 VAC

2A @ 230 VAC

1 This system utilizes an active power factor corrected power supply. This allows the system to pass the CE mark requirements
for use in the countries of the European Union. The active power factor corrected power supply also has the added benefit of
not requiring an input voltage range select switch.

Table F-2  Specifications (continued)
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Index

Symbols/Numerics
4–pin power pin

assignments 178

A
access panel, locked 200
access to computer,

controlling 52
Altiris

Client Management Suite 41
asset tracking 52
audible codes 192
audio connectors 2,  4,  7,  9
audio problems 212

B
battery

disposal 74
SFF removal and

replacement 166
beep codes 192
BIOS

Boot Block Emergency
Recovery Mode 46

HPQFlash 45
Remote ROM Flash 37

Boot Block Emergency Recovery
Mode 46

bootable device
creating 48
USB flash media device 48

booting options
Full Boot 185
Quick Boot 185

C
cable connections

SFF 81,  136
cable lock provision 62

cable management
MT 80
SFF 135

cable pinouts
SATA data 65
SATA power 65

cautions
AC power 67
cables 74
cooling fan 73
electrostatic discharge 68
keyboard keys 72
protecting ROM 45

CD-ROM or DVD problems 225
change notification 44
changing operating systems,

important information 52
changing password 57
chassis

MT illustrated 68
SFF illustrated 67

chassis types, illustrated 67
cleaning

computer 71
mouse 73
safety precautions 71

clearing password 59
Client Management Interface 38
Client Manager from

Symantec 40
cloning tools, software 35
CMOS

backing up 186
clearing and resetting 235

computer
specifications 239

computer access panel
MT removal and

replacement 77
removing 123

computer cleaning 71
Computer Setup Utilities 47
configuring power button 51
connecting drive cables 90,  138
connections 81,  136
connector pin assignments 175
controlling access to

computer 52
country power cord set

requirements 184
cover lock 61
Customer Support 196,  232
customizing software 35

D
deleting password 58
delimiter characters, table 58
deployment tools, software 35
diagnostic tool for hard drives 62
diagnostics utility 30
DIMMs. See memory
disassembly preparation

MT 76
SFF 122

disk, cloning 35
DisplayPort pin assignments 182
Drive Protection System

(DPS) 28
drive, protecting 62
DriveLock 59
drives

connecting cables 90,  138
installing 90,  138
locations 137

dual-state power button 51
DVI pin assignments 181
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E
electrostatic discharge (ESD)

preventing damage 69
Emergency Recovery Mode, Boot

Block 46
entering

power-on password 57
setup password 57

error
codes 185,  192
messages 186

ethernet
RJ-45 pin assignments 176

expansion card
installing 130
removing 130
slot locations 130

expansion slot cover
removing 87,  131
replacing 89,  133

F
FailSafe Key, ordering 61
fan shroud

SFF removal and
replacement 157

fan, power supply 73
fan/air baffle

MT removal and
replacement 106

Fault Notification and
Recovery 62

fingerprint identification
technology 62

flash drive problems 227
flashing LEDs 192
front bezel

MT removal and
replacement 78

removing 124
removing blanks 79,  96,  125
security 120,  172

front fan
SFF removal and

replacement 158
front I/O device

SFF removal and
replacement 159

front panel components 2,  7
front panel problems 228

front USB panel
MT removal and

replacement 107

G
general problems 199
grounding methods 69
guide screws 90,  138

H
hard drive

installing 100,  149
installing secondary 147
proper handling 74
removing 99,  149
SATA characteristics 64

hard drive problems 204
hard drives, diagnostic tool 62
hardware installation

problems 198
headphone connector 2,  7
headphone pin assignments 177
heat sink

MT removal and
replacement 109

SFF removal and
replacement 162

helpful hints 197
HP

Client Automation Starter,
Standard, and Enterprise
Editions 40

Client Catalog for Microsoft
System Center & SMS
Products 41

Client Management
Interface 38

Client Manager from
Symantec 40

ProtectTools Security
Manager 39

System Software Manager 38
HP Client Automation Enterprise

Edition 40
HP Client Manager 36
HP Lifecycle solutions 35
HPQFlash 45

I
industry standards 52
initial configuration 35

installing
drive cables 90,  138
expansion card 130
guide screws 90,  138
hard drive 100,  149
media card reader 96,  147
memory 126
optical drive 96,  142
removable hard drive 101, 

153
internal temperature of

computer 63
Internet access problems 228
Internet addresses. See Web sites

K
keyboard

cleaning 72
connector 4,  9
pin assignments 175

keyboard delimiter characters,
national 58

keyboard problems 216

L
LEDs

blinking power 192
blinking PS/2 keyboard 192

line-in connector 4,  9
line-out connector 4,  9
line—in audio pin

assignments 177
line—out audio pin

assignments 177
locking Smart Cover Lock 61
locks

cable lock 118,  169
front bezel 120,  172
HP Business PC Security

Lock 119,  170
padlock 118,  170

M
media card reader

features 3,  8
installing 96,  147
removing 93,  145

Media Card Reader
problems 207

memory
installing 126
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MT removal and
replacement 82

populating sockets 85
memory problems 223
microphone connector 2,  7
microphone pin assignments 177
monitor

pin assignments 178
monitor connector

DisplayPort 4,  9
VGA 4,  9

monitor problems 208
mouse

pin assignments 175
mouse cleaning 73
mouse connector 4,  9
mouse problems 216
MT

access panel removal and
replacement 77

cable management 80
chassis, illustrated 68
disassembly preparation 76
external security 118
fan/air baffle removal and

replacement 106
front bezel removal and

replacement 78
front USB panel removal and

replacement 107
heat sink removal and

replacement 109
memory removal and

replacement 82
power supply removal and

replacement 113
power switch/LED assembly

removal and
replacement 108

preparation for
disassembly 76

processor removal and
replacement 110

rear chassis fan removal and
replacement 112

speaker removal and
replacement 111

system board removal and
replacement 114

N
national keyboard delimiter

characters 58
network connector 4,  9
network problems 220
notification of changes 44
numeric error codes 186

O
operating guidelines 71
operating systems, important

information about 52
optical drive

installing 96,  142
removing 93,  141

optical drive problems 225
ordering FailSafe Key 61
overheating, prevention 71

P
password

changing 57
clearing 59,  186
deleting 58
power-on 56,  57,  186
security 56
setup 56,  57,  186

PC deployment 35
PCI card 86,  88,  130,  132
PCI Express card 86,  88,  130, 

132
PCI Express pin

assignments 179
POST error messages 185
power button

configuring 51
dual-state 51

power cord set requirements
country specific 184

power problems 203
power supply

fan 73
MT removal and

replacement 113
SFF removal and

replacement 164
power supply, surge-tolerant 62
power switch/LED assembly

MT removal and
replacement 108

power-on password
changing 57
deleting 58
entering 57
setting 56

Preboot Execution Environment
(PXE) 37

preinstalled software image 35
printer problems 215
Proactive Change Notification

(PCN) 44
problems

audio 212
CD-ROM or DVD 225
flash drive 227
front panel 228
general 199
hard drive 204
hardware installation 198
Internet access 228
keyboard 216
Media Card Reader 207
memory 223
monitor 208
mouse 216
network 220
power 203
printer 215
processor 224
software 231

processor
MT removal and

replacement 110
SFF removal and

replacement 163
processor problems 224
product ID location 5,  10,  75
protecting hard drive 62
protecting ROM, caution 45
ProtectTools Security

Manager 39
PXE (Preboot Execution

Environment) 37

R
rear chassis fan

MT removal and
replacement 112

rear panel components 4,  9
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Recovery Mode, Boot Block
Emergency 46

recovery, software 35
Remote Management

Technology 42
Remote ROM Flash 37
remote setup 37
Remote System Installation 37
removable hard drive

replacing 101,  153
removal and replacement

MT access panel 77
MT fan/air baffle 106
MT front bezel 78
MT front USB panel 107
MT heat sink 109
MT memory 82
MT power supply 113
MT power switch/LED

assembly 108
MT processor 110
MT rear chassis fan 112
MT speaker 111
MT system board 114
SFF baffle 157
SFF battery 166
SFF front fan 158
SFF front I/O device 159
SFF heat sink 162
SFF power supply 164
SFF processor 163
SFF speaker 161
SFF system board 165

removing
bezel blanks 79,  125
computer access panel 123
expansion card 130
expansion slot cover 87,  131
front bezel 124
hard drive 99,  149
media card reader 93,  145
optical drive 93,  141
PCI card 88,  132
PCI Express card 88,  132

resetting
CMOS 186
password jumper 186

retired solutions 45
ROM

flash 45

S
safety and comfort 196
safety precautions

cleaning 71
SATA

connectors on system
board 64

data cable pinouts 65
hard drive characteristics 64
power cable pinouts 65

screws, correct size 73
security

cable lock 62,  118,  169
DriveLock 59
features, table 53
fingerprint identification

technology 62
front bezel 120,  172
HP Business PC Security

Lock 119,  170
MT 118
padlock 118,  170
password 56
ProtectTools Security

Manager 39
settings 52
SFF 169
Smart Cover Lock 61
Smart Cover Sensor 60

serial connector 4,  9
serial interface pin

assignments 176
serial number location 5,  10,  75
service considerations 73
setup

copying to multiple
computers 47

copying to single computer 47
initial 35
replicating 47

setup password
changing 57
deleting 58
entering 57
setting 56

SFF
baffle removal and

replacement 157
battery removal and

replacement 166

cable management 135
chassis, illustrated 67
disassembly preparation 122
external security 169
front fan removal and

replacement 158
front I/O device removal and

replacement 159
heat sink removal and

replacement 162
power supply removal and

replacement 164
preparation for

disassembly 122
processor removal and

replacement 163
speaker removal and

replacement 161
system board removal and

replacement 165
Smart Cover FailSafe Key,

ordering 61
Smart Cover Lock

FailSafe Key 61
locking 61
unlocking 61

Smart Cover Sensor
protection levels 60
setting 60

software
Altiris Client Management

Suite 41
asset tracking 52
backing up 34
Drive Protection System 62
HP Client Automation Starter,

Standard, and Enterprise
Editions 40

HP Client Catalog for Microsoft
System Center & SMS
Products 41

HP Client Management
Interface 38

HP Client Manager from
Symantec 40

HP ProtectTools Security
Manager 39

HP System Software
Manager 38

integration 35
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Proactive Change Notification
(PCN) 44

problems 231
recovery 35
Remote Management

Technology 42
Remote System

Installation 37
servicing computer 73
updating and management

tools 37
Verdiem Surveyor 44

spare part number
tamper-resistent wrench 73
Torx T-15 screwdriver 73

speaker
MT removal and

replacement 111
SFF removal and

replacement 161
specifications

computer 237,  239
MT memory 82

static electricity 68
Subscriber's Choice 44
surge-tolerant power supply 62
system board

MT removal and
replacement 114

SATA connectors 64
SFF removal and

replacement 165
system board drive

connections 92,  140
System Software Manager 38

T
tamper-proof screws

tool 73
temperature control 71
temperature, internal

computer 63
thermal sensor 63
tools, servicing 73
Torx T15 screwdriver 73
tower orientation 6

U
unlocking Smart Cover Lock 61
URLs (Web sites). See Web sites

USB flash media device,
bootable 48

USB pin assignments 176
USB ports

front panel 2,  7
rear panel 4,  9

V
ventilation, proper 71
Verdiem Surveyor 44
Vision Field Diagnostics 30

W
Wake-on-LAN feature 220
warnings

keyboard cleaning 72
Web sites

Altiris Client Management
Suite 41

BIOS download 45
HP Business PC Security 39
HP Client Automation

Agent 36
HP Client Automation

Center 40
HP Client Catalog for Microsoft

SMS 42
HP Client Management

Interface 38
HP Client Manager 37
HP Client Manager from

Symantec 41
HP Softpaq Download

Manager 38
HP Support 42
HP System Software

Manager 39
HPQFlash 45
Intel vPro technology 42
Proactive Change

Notification 44
Remote ROM Flash 45
ROM Flash 45
Software & Driver

Downloads 48
software support 52
Subscriber’s Choice 44
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